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Configurazione del sistema

Pacchetto 
microfono 
wireless  
UWP-D21 
UWP-D22 
UWP-D26

Ricevitore 
microfono 
wireless 
URX-P03D

Adattatore slitta  
Multi-interface 
SMAD-P3D

Adattatore slitta 
Multi-interface 
SMAD-P5

Adattatore per  
innesto A-mount 
LA-EA3 
LA-EA4

Obiettivo con 
innesto E-mount

Microfono 
ECM-VG1 
ECM-MS2

Unità telecomando 
RM-30BP

Mixer multi-camera 
per produzioni Live 
MCX-500

Impugnatura di telecomando 
(in dotazione)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

Kit adattatore 
XLR 
XLR-K2M 
XLR-K3M

Luce video 
HVL-LBPC

Schede di memoria  
CFexpress Type A

Schede di memoria  
SDXC

Caricabatterie 
BC-CU1  
(in dotazione)

Pacco batteria 
BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100

Adattatore CA 
(in dotazione)

Lettore di schede CFexpress Type A/  
lettore di schede SD

Caricabatterie  
BC-U1A, BC-U2A

1. Descrizione generale
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Posizione e funzione delle parti

Lato sinistro e lato anteriore

11
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1.	 Gancio per metro a nastro
Il gancio del metro a nastro si trova sullo 
stesso piano del sensore immagine. Per 
misurare con precisione la distanza tra il 
camcorder e il soggetto, utilizzare questo 
gancio come punto di riferimento. Fissare 
l’estremità di un metro a nastro a questo 
gancio per misurare la distanza del soggetto.

2.	 Connettore mirino (pagina 19)

3.	 Apertura di ventilazione

[Nota]
Non coprire l’apertura di ventilazione.

4.	 Selettore TC IN/OUT (pagina 35, 109)

5.	 Connettore impugnatura di telecomando 
(pagina 21)

6.	  (simbolo N-Mark) (pagina 57)
ˎˎ Toccando il camcorder con uno smartphone 
dotato della funzione NFC è possibile 
stabilire una connessione wireless.  
Alcuni smartphone che supportano sistemi 
di pagamento wireless potrebbero non 
supportare la funzione NFC. Per ulteriori 
informazioni, consultare il manuale per l’uso 
dello smartphone.
ˎˎ Il protocollo di comunicazione 
internazionale NFC (Near Field 
Communication) consente la comunicazione 
wireless tra dispositivi mentre si trovano a 
breve distanza l’uno dall’altro.

7.	 Attacco impugnatura di telecomando 
(pagina 21)

8.	 Pulsante di rilascio dell’impugnatura di 
telecomando (pagina 21)

9.	 Antenna Wi-Fi

10.	Spia di registrazione/tally (anteriore) 
(pagina 34)

Lampeggia quando la capacità rimanente del 
supporto di registrazione o della batteria è 
bassa.

11.	Selettore FOCUS (pagina 37)

12.	Sensore immagine

13.	Pulsante PUSH AUTO FOCUS 
(pagina 40)

14.	Contatti di segnale obiettivo

[Nota]
Non toccare direttamente con le mani.

15.	Pulsante WB SET (impostazione 
bilanciamento del bianco) (pagina 46)

16.	Pulsante di sblocco obiettivo 
(pagina 22)
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Lato destro (anteriore/superiore/inferiore)
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1.	 Pulsante Clip Flag (pagina 51, 66)

2.	 Selettore HOLD (pagina 94)

3.	 Pulsante START/STOP registrazione 
(pagina 34)

Premere il pulsante START/STOP registrazione 
per avviare la registrazione. Il LED è illuminato 
con luce rossa durante la registrazione.

4.	 Manopola ND VARIABLE (pagina 44)

5.	 Selettore ND PRESET/VARIABLE 
(pagina 44)

6.	 Pulsanti su/giù ND FILTER POSITION 
(pagina 44)

7.	 Indicatore ND CLEAR (pagina 44)

8.	 Pulsante ND VARIABLE AUTO 
(pagina 44)

Premere il pulsante ND VARIABLE AUTO 
per avviare la regolazione automatica della 
densità del filtro ND. Il LED è illuminato con 
luce verde quando è attivo.

9.	 Manopola multifunzione (pagina 49)
Premere durante la visualizzazione 
dell’immagine nel mirino per visualizzare ed 
interagire con il Direct Menu.
Durante la visualizzazione del menu nel 
mirino, ruotare la manopola per spostare il 
cursore verso l’alto o il basso e selezionare 
voci di menu o impostazioni. Premere per 
applicare la voce selezionata.
Quando non è visualizzato il menu, la 
manopola può essere utilizzata anche come 
manopola programmabile.

10.	Pulsante funzione IRIS (pagina 43)

11.	Pulsante CANCEL/BACK (pagina 65)

12.	Pulsante THUMBNAIL (pagina 64)

13.	Pulsante MENU (pagina 13, 69)
Premere il pulsante MENU per visualizzare 
la schermata di stato. Premere e mantenere 
premuto il pulsante MENU per visualizzare il 
menu completo. Premere il pulsante mentre 
è visualizzata la schermata di stato o la 
schermata del menu completo per tornare alla 
schermata precedente.

14.	Pulsante funzione ISO/GAIN 
(pagina 43)

15.	Selettore ISO/GAIN (selezione guadagno) 
(pagina 43)

16.	Pulsante funzione WHT BAL 
(bilanciamento del bianco) (pagina 46)

17.	Selettore WHT BAL (selezione memoria 
bilanciamento del bianco) (pagina 46)

18.	Pulsante funzione SHUTTER 
(pagina 44)

19.	Jack cuffie (pagina 34)

20.	Selettore POWER (pagina 34)

Lato destro (posteriore) 
(pagina 6)
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Lato posteriore destro e slot schede
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1.	 Antenna Wi-Fi

2.	 Manopola AUDIO LEVEL (CH1) 
(pagina 47)

3.	 Selettore CH1 (AUTO/MAN) (pagina 47)

4.	 Pulsanti programmabili ASSIGN da 1 a 3 
(pagina 49)

5.	 Microfono interno (pagina 47)
Microfono di narrazione per la registrazione 
dell’audio ambientale. 

[Informazione]
Questo microfono viene disattivato quando è montata la 
maniglia ed è attivo il microfono interno della maniglia 
(pagina 7).

6.	 Pulsante DISPLAY (pagina 11)

7.	 Altoparlante incorporato (pagina 34)

8.	 Indicatore POWER (pagina 34)

9.	 Pulsante SLOT SELECT (selezione dello slot 
per schede di memoria (A) o (B))
(pagina 34)

10.	Selettore CH2 (AUTO/MAN) (pagina 47)

11.	Manopola AUDIO LEVEL (CH2) 
(pagina 47)

12.	Indicatore di accesso A (pagina 26)

13.	Slot scheda CFexpress Type A/SD (A) 
(pagina 26)

14.	Slot scheda CFexpress Type A/SD (B) 
(pagina 26)

15.	Indicatore di accesso B (pagina 26)
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Sezione maniglia, lato posteriore e connettore
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1.	 Selettore HOLD della maniglia
Consente di disabilitare il funzionamento dei 
comandi della maniglia.

2.	 Pulsante START/STOP registrazione della 
maniglia

3.	 Microfono interno della maniglia

4.	 Slitta Multi-interface

Per informazioni dettagliate sulla gamma 
di accessori utilizzabili con la slitta Multi-
interface, rivolgersi al proprio rappresentante 
di vendita.

5.	 Manopola programmabile della maniglia 
(pagina 49)

6.	 Levetta dello zoom della maniglia 
(pagina 94)

7.	 Pulsanti programmabili ASSIGN 7 e 8 
(pagina 49)

8.	 Selettore multiplo (pulsante direzionale 
D-Pad a 8 posizioni e pulsante di 
conferma)

9.	 Slitta accessori (pagina 7)

10.	Fori filettati per il montaggio di accessori 
(1/4 di pollice)

Compatibili con viti UNC 1/4-20 (lunghezza 
max. 6 mm).

[Nota]
L’utilizzo di viti di lunghezza superiore a 6 mm potrebbe 
danneggiare la superficie esterna dell’apparecchio.

11.	Spia di registrazione/tally (posteriore) 
(pagina 34)

12.	Pulsante BATT RELEASE (pagina 17)

13.	Apertura ingresso aria

[Nota]
Non coprire l’apertura di ingresso dell’aria.

14.	Attacco pacco batteria (pagina 17)

15.	Connettore USB-C (pagina 61)

16.	Connettore INPUT2 (ingresso audio 2) 
(pagina 47)

17.	Connettore INPUT1 (ingresso audio 1) 
(pagina 47)

18.	Selettore INPUT2 (LINE/MIC/MIC+48V) 
(pagina 47)

19.	Selettore INPUT1 (LINE/MIC/MIC+48V) 
(pagina 47)

20.	Fori filettati per dispositivi esterni
Compatibili con viti M3 (lunghezza max. 
4 mm).

[Nota]
L’utilizzo di viti di lunghezza superiore a 4 mm potrebbe 
danneggiare la superficie esterna dell’apparecchio.

21.	Connettore HDMI OUT (pagina 108)

22.	Connettore SDI OUT (pagina 108)

23.	Connettore TC IN/TC OUT (entrata/uscita 
codice temporale) (pagina 109)

24.	Connettore REMOTE
Per il collegamento a un accessorio generico 
dotato di jack LANC.

25.	Connettore USB/Multi (pagina 110)

26.	Connettore DC-IN (jack c.c. standard) 
(pagina 18)

Montaggio della slitta accessori

1	 Sollevare il bordo anteriore della molla 
della slitta e tirare la molla nella direzione 
opposta a quella indicata dalla freccia 
incisa sulla slitta stessa.

Molla della slitta

Slitta accessori

1

2	 Posizionare la slitta accessori sulla sua 
sede di montaggio, allineando le 
sporgenze della slitta con il punti 
corrispondenti della sede di montaggio, 
quindi serrare le quattro viti.
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3	 Inserire la molla della slitta nella direzione 
della freccia in modo che la porzione a 
forma di U si inserisca in fondo alla slitta.

Molla della 
slitta

Slitta accessori

2 32 3

Rimozione della slitta accessori

Rimuovere la molla della slitta come descritto 
al passo 1 del paragrafo “Montaggio della slitta 
accessori”, svitare le quattro viti e rimuovere la 
slitta accessori.

Montaggio della maniglia

Posizionare la maniglia allineandone il 
connettore e le viti di fissaggio, quindi inserire 
la maniglia e ruotare in senso orario le viti di 
fissaggio per assicurare la maniglia al corpo 
del camcorder.
È possibile serrare le viti di fissaggio della 
maniglia anche ruotandole in senso orario con 
una chiave esagonale (4 mm).

[Nota]
Assicurarsi che le due viti di fissaggio della maniglia 
siano saldamente serrate prima di utilizzare la maniglia. 
Se le viti non sono saldamente serrate, la maniglia 
potrebbe staccarsi dal camcorder.

Rimozione della maniglia

Per la rimozione, ripetere la procedura di 
montaggio in senso inverso.

Montaggio del coperchietto di 
protezione del connettore della maniglia 
(in dotazione)

Quando si usa il camcorder senza la maniglia, 
proteggere il connettore con il coperchietto di 
protezione in dotazione.

[Informazione]
Al momento del montaggio della maniglia, riporre il 
coperchietto di protezione nell’apposita sede sul lato 
inferiore della maniglia stessa.

Protezione dei terminali del connettore

Montare il coperchietto sui connettori non 
utilizzati per proteggere i terminali del 
connettore.

Lato superiore

1

2 2

2

2

1.	 Connettore della maniglia

2.	 Fori filettati per il montaggio di accessori 
(1/4 di pollice)

Compatibili con viti UNC 1/4-20 (lunghezza 
max. 6 mm).

[Nota]
L’utilizzo di viti di lunghezza superiore a 6 mm potrebbe 
danneggiare le parti esterne dell’apparecchio.
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Lato inferiore

1 2
1.	 Fori filettati di montaggio del treppiede 

(1/4 poll., 3/8 poll.)
Compatibile con viti 1/4-20 UNC e 3/8-16 
UNC. Consente il montaggio di un treppiede 
(opzionale, vite di lunghezza max. 5,5 mm).

2.	 Apertura uscita aria

[Nota]
Non coprire l’apertura per l’uscita dell’aria.

Mirino

Per informazioni dettagliate sul montaggio del 
mirino (in dotazione), vedere pagina 19.

1
2
3

4 5

1.	 Pulsante PEAKING

2.	 Pulsante ZEBRA

3.	 Pulsante programmabile ASSIGN 9 
(pagina 49)

4.	 Touchscreen
È possibile disabilitare il funzionamento 
del touchscreen usando un pulsante 
programmabile o il menu (pagina 10).

5.	 Selettore MIRROR

Impugnatura di telecomando

Per informazioni dettagliate sul montaggio 
dell’impugnatura di telecomando (in 
dotazione), vedere pagina 21.

4

3
2

1

7
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6
5

1.	 Levetta dello zoom

2.	 Pulsante programmabile ASSIGN 4 
(pagina 49)

3.	 Manopola programmabile 
dell’impugnatura (pagina 49)

4.	 Pulsante programmabile ASSIGN 6 
(pagina 49)

5.	 Levetta di rotazione dell’impugnatura 
(pagina 21)

6.	 Pulsante START/STOP registrazione

7.	 Selettore multiplo (pulsante direzionale 
D-Pad a 8 posizioni e pulsante di 
conferma)

8.	 Pulsante programmabile ASSIGN 5 
(pagina 49)
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Utilizzo del touchscreen

Precauzioni per l’utilizzo del 
touchscreen

Il mirino dell’unità è un pannello touchscreen 
che può essere utilizzato semplicemente 
toccando le varie opzioni con un dito.
ˎˎ È sufficiente toccarlo leggermente con il 
dito. Non esercitare forte pressione sul 
pannello né toccarlo con oggetti taglienti o 
appuntiti (unghie, penne a sfera, spilli, ecc.).
ˎˎ Nelle circostanze descritte di seguito, il 
touchscreen potrebbe non rispondere 
correttamente al contatto. Si osservi inoltre 
che tali azioni potrebbero dar luogo a 
malfunzionamenti.
ˎˎ 	Se si tocca con la punta delle unghie 
delle dita
ˎˎ 	Se si tocca mentre altri oggetti sono in 
contatto con la sua superficie
ˎˎ 	Se si tocca mentre è applicata una 
pellicola adesiva di protezione o 
un’etichetta
ˎˎ 	Se si tocca mentre sono presenti gocce 
di condensazione o d’acqua sulla sua 
superficie
ˎˎ 	Se si tocca con dita bagnate o sudate

Gesti del touchscreen

Tocco
Toccare leggermente un elemento, ad 
esempio un’icona o una voce del menu, e 
sollevare immediatamente il dito.

Trascinamento
Toccare lo schermo e spostare il dito mentre 
rimane in contatto con lo schermo fino a 
raggiungere la posizione desiderata, quindi 
sollevare il dito.

Scorrimento rapido
Toccare lo schermo e trascinare il dito con un 
gesto rapido verso l’alto, il basso, a sinistra o 
a destra.

[Informazione]
Se i contenuti si estendono oltre i bordi dello schermo, 
è possibile scorrerli trascinandoli lentamente o con un 
gesto rapido.

Configurazione del touchscreen

Il funzionamento del touchscreen può essere 
attivato o disattivato tramite la voce Touch 
Operation (pagina 94) del menu Technical.
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Visualizzazione a schermo
Durante la ripresa (registrazione/standby) e la riproduzione, le informazioni sullo stato del 
camcorder e le sue impostazioni sono sovraimposte all’immagine visualizzata nel mirino.
È possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY. Se nascoste, 
verranno sempre visualizzate quando si eseguono operazioni con il Direct Menu (pagina 49).
È inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre 
(pagina 88).

Informazioni visualizzate sullo schermo durante le riprese

3 42
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9 1075

11
12

13
14

15
16
17

18 19 20 21 22 23 24 25 26 27 28

29

30
31
32
33
34
35
36

1

1.	 Indicatore di stato della rete (pagina 13)
Visualizza graficamente lo stato della 
connessione di rete.

2.	 Indicatore di upload/indicatore file 
rimanenti (pagina 62)

3.	 Indicatore della zona di messa a fuoco 
(pagina 37)

Visualizza la zona di messa a fuoco per la 
messa a fuoco automatica.

4.	 Indicatore modalità di registrazione, slot 
A/B, intervallo di registrazione Interval 
Rec (pagina 50)

Indicazione Significato

Rec Registrazione

Stby Standby registrazione

5.	 Indicatore di profondità di campo

6.	 Indicatore della modalità di scansione 
dell’imager (pagina 24)

In caso di mancata corrispondenza fra le 
dimensioni del cerchio immagine dell’obiettivo 
e l’impostazione delle dimensioni immagine 
effettive della modalità di scansione 
dell’immagine viene visualizzata l’indicazione .
Quando Imager Scan Mode è impostata su FF, 
verrà visualizzata l’indicazione “C” nelle modalità 
con un angolo di visuale più stretto (cropping).
Il cropping ha luogo nelle modalità indicate di 
seguito.
ˎˎ Quando il formato di registrazione è 
3840×2160 e la velocità fotogrammi di S&Q 
Motion è 100 fps o 120 fps

ˎˎ Quando Codec è impostato su RAW o 
RAW & XAVC-I e il formato di uscita RAW è 
3840×2160

7.	 Indicatore di stato dell’operazione di 
uscita RAW (pagina 56)

Indica lo stato di uscita del segnale RAW.

8.	 Indicatore di stato della serie UWP-D 
(pagina 13)

Quando è collegato alla slitta MI configurata 
per la trasmissione di audio digitale un 
dispositivo della serie UWP-D, visualizza 
l’intensità del segnale RF in forma grafica.

9.	 Indicatore della frequenza fotogrammi in 
modalità di ripresa Slow & Quick Motion 
(pagina 50)

10.	Indicatore carica residua della batteria/
tensione DC IN (pagina 17)

11.	 Indicatore della modalità di messa a 
fuoco (pagina 41)

Significato Indicazione

Modalità Focus Hold Focus Hold

Modalità MF MF

Modalità AF AF

AF con rilevamento di viso/occhi (AF/ /Only/
/ )

Icona rilevamento 
viso/occhi

Icona AF rilevamento 
viso/occhi

Only

Icona viso registrato  

Icona AF in pausa 
durante AF con 
rilevamento viso/occhi1)

1)	 Visualizzata solo quando non sono stati registrati visi 
e non è stato rilevato nessun viso, oppure quando 
è stato registrato un viso, ma il viso registrato non è 
stato rilevato.

12.	Indicazione della posizione di zoom 
(pagina 36)

Visualizza il valore di zoom nel campo da 0 
(grandangolo) a 99 (teleobiettivo) (se è montato 
un obiettivo che supporta questa funzione).
Questa indicazione può essere sostituita da 
un indicatore a barra o dall’indicatore della 
distanza di messa a fuoco (pagina 95).
Quando è abilitata la funzione Clear Image 
Zoom, vengono visualizzate sul display anche 
le indicazioni elencate di seguito.

Indicazione Significato

Clear Image Zoom abilitato

Valore di 
ingrandimento

Quando è utilizzata la 
funzione Clear Image Zoom

13.	Indicatore della modalità di 
stabilizzazione dell’immagine

14.	Indicatore dello stato di Rec Control 
sull’uscita SDI o HDMI (pagina 108)

Indica lo stato di uscita del segnale REC Control.

15.	Indicatore della messa a fuoco 
(pagina 41)

16.	Indicatore dello spazio rimanente sui 
supporti di memoria

17.	 Indicatore modalità bilanciamento del 
bianco

Indicazione Significato

Modalità auto

 Hold Modalità auto in pausa

W:P Modalità Preset

W:A Modalità memoria A

W:B Modalità memoria B

18.	Indicatore della sincronizzazione con 
codice temporale esterno o indicatore 
dati temporali (pagina 34)

Visualizza “EXT-LK” quando l’apparecchio 
è sincronizzato sul codice temporale di un 
dispositivo esterno.

19.	Indicatore filtro ND (pagina 44)
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20.	Indicatore file di scena (pagina 107)

21.	Indicatore valore di diaframma
Visualizza il valore di diaframma (valore F) se 
è montato un obiettivo che supporta questa 
funzione.

22.	Indicatore di avviso livello video

23.	Indicatore guadagno (pagina 43)
Visualizza il valore EI in modalità Cine EI 
(pagina 24).

Indicazione Significato

Modalità auto

H Modalità H di preset

M Modalità M di preset

L Modalità L di preset

Modalità di 
regolazione 
temporanea

24.	Visualizzazione nome clip (pagina 64)

25.	Indicatore otturatore (pagina 44)

26.	Indicatore modalità AE/livello AE 
(pagina 43)

27.	Indicatore di livellamento
Visualizza l’orizzontalità in incrementi di ±1° 
fino a un massimo di ±15°.

28.	Indicatore di livello audio
Indica il livello audio di CH1 e CH2.
CH3 e CH4 possono essere monitorati sulla 
schermata di stato.

29.	Monitor segnale video (pagina 51)
Visualizza forma d’onda, vettorscopio e 
istogramma.
La linea arancione indica il valore impostato 
del livello zebra.
In modalità Cine EI (pagina 24), visualizza il 
tipo di LUT del segnale monitorato.

30.	Indicatore Base Sensitivity/indicatore 
Base ISO (pagina 43)

Nella modalità Custom (pagina 24) 
visualizza la sensibilità di base impostata 
con ISO/Gain/EI nella schermata Main Status 
oppure con ISO/Gain/EI >Base Sensitivity nel 
menu Shooting del menu completo.
Nella modalità Cine EI (pagina 24) visualizza 
la sensibilità Base ISO impostata con ISO/
Gain/EI nella schermata Main Status oppure 
con ISO/Gain/EI >Base ISO nel menu Shooting 
del menu completo.

31.	Indicatore assistenza visualizzazione 
gamma/LUT monitor

Visualizza lo stato della funzione di assistenza 
per la visualizzazione gamma. La funzione di 
assistenza visualizzazione gamma può essere 
attivata o disattivata assegnando Gamma 
Display Assist a un pulsante programmabile 
(pagina 49).
In modalità Cine EI (pagina 24), visualizza  
l’impostazione della LUT monitor 
(pagina 77).

32.	Indicatore Base Look (pagina 53)
Visualizza l’impostazione del Look di base.
In modalità Cine EI (pagina 24) visualizza 
l’impostazione della LUT per la registrazione di 
video sulle schede di memoria (pagina 77).

33.	Indicatore stato proxy

34.	Indicatore formato di registrazione 
(codec) (pagina 78)

Visualizza il nome del formato di registrazione 
sulle schede di memoria.

35.	Indicatore formato di registrazione 
(frequenza fotogrammi e metodo di 
scansione)

36.	Indicatore formato di registrazione 
(dimensioni immagine) (pagina 78)

Visualizza le dimensioni immagine per la 
registrazione sulle schede di memoria.

Informazioni visualizzate sullo schermo durante la riproduzione

Le seguenti informazioni vengono sovraimposte sull’immagine riprodotta.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Indicatore di stato della rete

2.	 Indicatore di upload/indicatore file 
rimanenti

3.	 Numero del clip/numero totale di clip

4.	 Indicatore dello stato della riproduzione

5.	 Indicatore formato di riproduzione 
(frequenza fotogrammi e metodo di 
scansione)

6.	 Indicatore formato di riproduzione 
(dimensioni immagine)

7.	 Indicatore carica residua della batteria/
tensione DC IN

8.	 Indicatore formato di riproduzione 
(codec)

9.	 Indicatore supporto
Se la scheda di memoria è protetta da scrittura 
viene visualizzata l’icona .

10.	Visualizzazione dati temporali

11.	Visualizzazione nome clip

12.	Indicatore assistenza visualizzazione 
gamma

13.	Indicatore di livello audio
Visualizza il livello di riproduzione dell’audio.

14.	Indicatore Base Look
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Indicazioni grafiche (icone)

Icone di indicazione della connessione di rete

Modalità di rete Stato della connessione Icona

Modalità punto di accesso In operazione come punto di accesso

Errore nel funzionamento come punto 
di accesso

Modalità stazione Connessione Wi-Fi
L’icona cambia in base all’intensità del 
segnale (4 livelli)

   

Wi-Fi non connesso (anche mentre 
viene stabilita la connessione)

Errore di connessione Wi-Fi

Tethering USB Tethering USB connesso

Tethering USB non connesso

Errore nel tethering USB

Visualizzazione dell’icona della serie UWP-D

Stato del trasmettitore Stato della ricezione Icona

Dispositivo spento Nessuna ricezione

Stato di trasmissione normale Ricezione
 –   

(livello di ricezione (4 livelli))

Stato del muting Ricezione (muting attivo)

Avvertimento della capacità rimanente 
della batteria

Ricezione
 (icona lampeggiante)

Muting attivo e avvertimento della 
capacità rimanente della batteria

Ricezione
 (icona lampeggiante)

Schermata di stato

La schermata di stato consente di controllare 
le impostazioni e lo stato del camcorder. Le 
impostazioni delle voci contrassegnate con un 
asterisco (*) sono modificabili.
È possibile interagire con la schermata di stato 
toccando il touchscreen.

Per visualizzare la schermata di stato
ˎˎ Premere il pulsante MENU.

Per passare a un’altra schermata di stato
ˎˎ Ruotare la manopola multifunzione.
ˎˎ Spostare il selettore multiplo verso l’alto o 
verso il basso
ˎˎ Trascinare la schermata di stato verso l’alto 
o verso il basso.

Per chiudere la schermata di stato
ˎˎ Premere il pulsante MENU.

Per modificare un’impostazione
Mentre è visualizzata la schermata di stato, 
premere la manopola multifunzione o il 
selettore multiplo per consentire la selezione 
di una voce di impostazione contenuta in una 
pagina. Selezionare il numero della pagina 
desiderata e quindi premere per aprirla.
È possibile selezionare voci anche 
semplicemente toccandole sul touchscreen.

[Nota]
È possibile impedire la modifica delle voci della 
schermata di stato impostando su On la voce Menu 
Settings >User Menu Only (pagina 95) del menu 
Technical nel menu completo.

Schermata Main Status

Visualizza le funzioni principali del camcorder 
e lo spazio libero sul supporto di memoria.

Voce visualizzata Descrizione

S&Q Frame Rate Impostazione della 
frequenza fotogrammi per le 
riprese in modalità Slow & 
Quick Motion

Frequency/Scan* Impostazioni frequenza di 
sistema e metodo di 
scansione

Imager Scan* Modalità di scansione del 
sensore immagine

Media Remain 
(A)

Spazio libero rimanente sul 
supporto di memoria dello 
slot A

ND Filter Impostazione del filtro ND

ISO/Gain/EI Impostazione ISO/Gain/
Exposure Index

Base ISO/
Sensitivity*

Impostazione di Base ISO/
Base Sensitivity

Codec* Impostazione codec per la 
registrazione

Media Remain (B) Spazio libero rimanente sul 
supporto di memoria dello 
slot B

Scene File* File di scena utilizzato e 
relativa impostazione di File ID

Base Look/LUT* Impostazione della LUT 
monitor

Shutter Impostazione della velocità 
o dell’angolo dell’otturatore

Iris Impostazione del diaframma

Video Format* Dimensioni immagine per la 
registrazione sule schede di 
memoria

RAW Output 
Format*

Dimensioni di immagine 
dell’uscita RAW

White Balance Impostazione del 
bilanciamento del bianco
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Schermata Camera Status

Visualizza lo stato di varie preconfigurazioni 
del camcorder.

Voce visualizzata Descrizione

White Switch<B> Impostazione del 
bilanciamento del bianco 
della memoria B

White Switch<A> Impostazione del 
bilanciamento del bianco 
della memoria A

White Switch<P> Impostazione di Preset 
White

ND<Preset> Impostazione dei valori di 
Preset1, Preset2 e Preset3 
del filtro ND

ISO / Gain<L>* Impostazione ISO/Gain<L>

ISO / Gain<M>* Impostazione ISO/Gain<M>

ISO / Gain<H>* Impostazione ISO/Gain<H>

Base ISO/
Sensitivity*

Impostazione di Base ISO/
Base Sensitivity

Zebra1 Impostazione Zebra1 On/Off 
e livello

Zebra2 Impostazione Zebra2 On/Off 
e livello

VF Gamma/
Gamma

Categoria e curva di gamma

Scene File* File di scena utilizzato e 
relativa impostazione di File 
ID

Schermata Audio Status

Visualizza le impostazioni di ingresso, 
l’indicatore di livello audio e il volume di 
monitoraggio per ciascun canale.

Voce visualizzata Descrizione

CH1 Level 
Control

Stato On/Off della 
regolazione automatica

Level Meter Indicatore di livello audio

Source* Sorgente di ingresso

Ref./Sens.* Livello di riferimento di ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

CH2 Level 
Control

Stato On/Off della 
regolazione automatica

Level Meter Indicatore di livello audio

Source* Sorgente di ingresso

Ref./Sens.* Livello di riferimento di ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

CH3 Level 
Control*

Stato On/Off della 
regolazione automatica

Level Meter* Indicatore di livello audio

Source* Sorgente di ingresso

Ref./Sens.* Livello di riferimento di ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

CH4 Level 
Control*

Stato On/Off della 
regolazione automatica

Level Meter* Indicatore di livello audio

Source* Sorgente di ingresso

Ref./Sens.* Livello di riferimento di ingresso

Wind 
Filter*

Impostazione del valore di 
riduzione del filtro antivento 
del microfono

Audio Input 
Level*

Impostazione del livello di 
ingresso audio (volume 
master)

Voce visualizzata Descrizione

HDMI Output CH* Impostazione canale audio 
di uscita HDMI

Volume* Impostazione del volume 
dell’altoparlante incorporato 
o delle cuffie

Monitor CH* Impostazione di 
monitoraggio del canale

Schermata di stato Project

Visualizza le impostazioni di base relative al 
progetto di ripresa.

Voce visualizzata Descrizione

Frequency/Scan* Impostazioni frequenza di 
sistema e metodo di 
scansione

Codec* Impostazione codec per la 
registrazione

Rec Function Impostazioni e formato di 
registrazione speciale attivo

Simul Rec* Stato e impostazione On/Off 
della funzione di 
registrazione simultanea su 
2 slot

Title Prefix Porzione del titolo del nome 
del clip

Imager Scan* Modalità di scansione del 
sensore immagine

Video Format* Dimensioni immagine per la 
registrazione sule schede di 
memoria

Number Suffisso numerico del nome 
del clip

Shooting Mode* Impostazione modalità di 
ripresa

RAW Output 
Format*

Dimensioni di immagine 
dell’uscita RAW

Proxy Rec* Stato On/Off e impostazione 
della funzione di 
registrazione proxy

Schermata Monitoring Status

Visualizza le impostazioni di uscita SDI e HDMI.

Voce visualizzata Descrizione

SDI Signal* Dimensioni immagine di 
uscita

Info. 
Disp.*

Impostazione On/Off 
dell’emissione in uscita 
delle informazioni

Color 
Gamut*

Impostazione dello spazio 
colore/Stato della LUT 
monitor

HDMI Signal* Dimensioni immagine di 
uscita

Info. 
Disp.*

Impostazione On/Off 
dell’emissione in uscita 
delle informazioni

Color 
Gamut*

Impostazione dello spazio 
colore/Stato della LUT 
monitor

Stream Signal Dimensioni immagine di 
uscita

Info. 
Disp.

Emissione in uscita delle 
informazioni (Off (fisso))

Color 
Gamut*

Impostazione dello spazio 
colore/Stato della LUT 
monitor

VF Color 
Gamut*

Impostazione assistenza 
visualizzazione gamma/
Impostazione dello spazio 
colore/Stato della LUT 
monitor

Base Look/LUT* Impostazione Base Look/
LUT

Gamma Display 
Assist*

Impostazione On/Off della 
funzione di assistenza alla 
visualizzazione gamma



1. Descrizione generale: Visualizzazione a schermo15

Schermata Assignable Button Status

Visualizza le funzioni assegnate ai pulsanti 
programmabili.

Voce visualizzata Descrizione

1 Funzione assegnata al 
pulsante ASSIGN 1

2 Funzione assegnata al 
pulsante ASSIGN 2

3 Funzione assegnata al 
pulsante ASSIGN 3

4 Funzione assegnata al 
pulsante ASSIGN 4

5 Funzione assegnata al 
pulsante ASSIGN 5

6 Funzione assegnata al 
pulsante ASSIGN 6

7 Funzione assegnata al 
pulsante ASSIGN 7

8 Funzione assegnata al 
pulsante ASSIGN 8

9 Funzione assegnata al 
pulsante ASSIGN 9

Focus Hold 
Button

Funzione assegnata al 
pulsante Focus Hold 
dell’obiettivo

Multi Function 
Dial

Funzione assegnata alla 
manopola multifunzione

Grip Dial Funzione assegnata alla 
manopola programmabile 
dell’impugnatura

Handle Dial Funzione assegnata alla 
manopola programmabile 
della maniglia

Schermata Battery Status

Visualizza informazioni sulla batteria e 
la sorgente di alimentazione collegata al 
connettore DC IN.

Voce visualizzata Descrizione

Detected Battery Tipo di batteria

Remaining Capacità rimanente (%)

Charge Count Numero di ricariche

Capacity Capacità rimanente (Ah)

Voltage Tensione batteria (V)

Manufacture 
Date

Data di fabbricazione della 
batteria

Video Light 
Remaining

Visualizza la capacità 
rimanente della batteria 
della luce video.

Power Source Sorgente di alimentazione

Supplied Voltage Tensione fornita dalla 
sorgente di alimentazione

Schermata Media Status

Visualizza la capacità rimanente e il tempo 
di registrazione rimanente dei supporti di 
registrazione.

Voce visualizzata Descrizione

Informazioni 
scheda A

Visualizza l’icona della 
scheda quando è inserito un 
supporto di registrazione 
nello slot A.

Indicatore 
capacità 
rimanente 
scheda A

Visualizza la capacità 
rimanente del supporto di 
registrazione inserito nello 
slot A come percentuale su 
una barra.

Tempo di 
registrazione 
rimanente 
scheda A

Visualizza il tempo stimato 
di registrazione rimanente 
sul supporto di registrazione 
inserito nello slot A in minuti 
nelle condizioni di 
registrazione attuali.

Informazioni 
scheda B

Visualizza l’icona della 
scheda quando è inserito un 
supporto di registrazione 
nello slot B.

Indicatore 
capacità 
rimanente 
scheda B

Visualizza la capacità 
rimanente del supporto di 
registrazione inserito nello 
slot B come percentuale su 
una barra.

Tempo di 
registrazione 
rimanente 
scheda B

Visualizza il tempo stimato 
di registrazione rimanente 
sul supporto di registrazione 
inserito nello slot B in minuti 
nelle condizioni di 
registrazione attuali.

Schermata Network Status

Visualizza lo stato della connessione di rete.

Voce visualizzata Descrizione

Wireless LAN Impostazioni e stato della 
connessione wireless

Wired LAN Impostazioni e stato della 
connessione della LAN 
cablata

Modem Impostazioni della 
connessione wireless e stato 
della connessione tramite 
tethering USB

Schermata File Transfer Status

Visualizza informazioni sul trasferimento di file.

Voce visualizzata Descrizione

Auto Upload 
(Proxy)

Stato On/Off della funzione 
Auto Upload (Proxy)

Job Status 
(Remain / Total)

Numero dei processi 
rimanenti e numero totale 
dei processi

Total Transfer 
Progress

Avanzamento complessivo 
del trasferimento dei 
processi

Default Upload 
Server

Nome del server di 
destinazione di Auto Upload 
(Proxy)

Current File 
Transfer Progress

Avanzamento del 
trasferimento del file attuale

Current 
Transferring File 
Name

Nome del file in corso di 
trasferimento

Server Address Indirizzo del server di 
destinazione del 
trasferimento dei file

Destination 
Directory

Directory di destinazione sul 
server di destinazione del 
trasferimento dei file
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Utilizzo delle schermate di impostazione di tipo touchscreen

Elementi dello schermo

Voce

Simbolo indicante 
l’impostazione attuale

Pulsante Set (applica)

Cursore di selezione 
dell’impostazione 
(riquadro arancione)

Nome della voce

Opzioni selezionabili

Modalità di utilizzo

1	 Toccare una voce di impostazione.

Tocco

Vengono visualizzate le opzioni di 
selezione del valore.

2	 Trascinare o dare un colpetto con il dito 
per scorrere e selezionare il valore 
desiderato.

Scorrimento rapido

3	 Toccare il pulsante Set o il cursore di 
selezione del valore.
Il valore viene applicato e il display ritorna 
alla schermata precedente.

[Informazioni]
ˎˎ Premere il pulsante CANCEL/BACK per ritornare al 

valore precedente.
ˎˎ È possibile utilizzare anche la manopola 

multifunzione o il selettore multiplo.

ˎˎ Se si desidera, le operazioni touchscreen possono 
essere disabilitate (pagina 94).
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Alimentazione
È possibile utilizzare un pacco batteria o 
un’alimentazione CA da un adattatore CA.
Per sicurezza, utilizzare esclusivamente i 
seguenti pacchi batterie e adattatori CA Sony.

Pacchi batteria agli ioni di litio
BP-U35 (in dotazione)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Caricabatterie
BC-CU1 (in dotazione)
BC-U1A
BC-U2A

Adattatore CA (in dotazione)
[ATTENZIONE]

Non conservare i pacchi batteria in luoghi 
esposti alla luce solare diretta o a fiamme 
libere, oppure in cui siano presenti elevate 
temperature.

[Note]
ˎˎ Per l’alimentazione dalla rete elettrica, utilizzare 

l’adattatore CA fornito.
ˎˎ Spostare sempre il selettore POWER su Off prima 

di rimuovere o montare un pacco batteria o un 
adattatore CA. Se viene rimosso o montato con il 
selettore POWER su On, in alcuni casi il camcorder 
potrebbe non avviarsi. Se il camcorder non si avvia, 
spostare il selettore POWER su Off e disconnettere 
temporaneamente il pacco batteria o l’adattatore 
CA, quindi attendere 30 secondi circa e riconnettere 
il pacco batteria o l’adattatore CA. (Se il camcorder 
è alimentato dal pacco batteria, l’adattatore CA può 
essere connesso senza problemi anche se il selettore 
POWER si trova nella posizione On).

Utilizzo del pacco batteria

Per montare un pacco batteria, inserirlo fino 
in fondo nell’apposita sede (pagina 7), 
quindi spingerlo verso il basso per bloccarlo in 
posizione.

Per rimuovere un pacco batteria, farlo scorrere 
verso l’alto mantenendo premuto il pulsante 
BATT RELEASE (pagina 7), quindi estrarlo 
dalla sua sede.

Pulsante BATT 
RELEASE

[Note]
ˎˎ Prima di montare un pacco batteria, caricarlo con il 

caricabatterie specifico BC‑CU1, BC-U1A o BC‑U2A.
ˎˎ Il pacco batteria potrebbe non ricaricarsi 

completamente se si cerca di ricaricarlo mentre è 
caldo (ad esempio, subito dopo l’uso).

Controllo della capacità rimanente

Durante la ripresa o la riproduzione con 
un pacco batteria, la capacità rimanente 
della batteria viene visualizzata nel mirino 
(pagina 11).

Icona Significato

91%-100%

71%-90%

51%-70%

31%-50%

11%-30%

0%-10%

Il camcorder indica la capacità rimanente 
calcolando il tempo disponibile con il pacco 
batteria sulla base del consumo e delle 
condizioni d’uso attuali. 

Se il livello di carica del pacco batteria 
diventa insufficiente

Se il livello di carica rimanente del pacco 
batteria scende al di sotto di un determinato 
valore durante l’utilizzo (stato Low Battery), 
viene visualizzato il messaggio di batteria 
prossima all’esaurimento e la spia di 
registrazione/tally comincia a lampeggiare.
Se il livello di carica rimanente si abbassa 
ulteriormente fino a raggiungere un livello 
al quale è impossibile continuare l’utilizzo 
dell’apparecchio (stato Battery Empty), viene 
visualizzato il messaggio di batteria esaurita.
Sostituire il pacco batteria esaurito con uno 
carico.

Modifica dei livelli di avviso

Per impostazione predefinita di fabbrica, il 
livello Low Battery è impostato al 10% della 
carica completa della batteria, mentre il livello 

Battery Empty è impostato sul 3%. È possibile 
modificare i valori dei livelli di avviso con 
l’opzione Camera Battery Alarm (pagina 96) 
nel menu Technical del menu completo.

Carica di un pacco batteria con il 
caricabatterie in dotazione (BC‑CU1)

1	 Collegare l’adattatore CA (in dotazione) al 
caricabatterie, quindi collegare il cavo di 
alimentazione (in dotazione) alla sorgente 
di alimentazione di rete.

2	 Inserire la batteria spingendola nella 
direzione indicata dalla freccia.
La spia CHARGE si illumina con luce 
arancione e la carica ha inizio.

Spia CHARGE

Adattatore CA

Cavo di alimentazione
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Spia CHARGE (arancione)
Illuminata:�Carica in corso
Lampeggiante:�Errore nella ricarica o 

temperatura fuori da intervallo 
consentito. Carica interrotta.

ˎˎ Quando la batteria è completamente carica, 
la spia CHARGE del caricabatterie si spegne.
ˎˎ Utilizzare esclusivamente batterie originali 
Sony.

Tempo di ricarica
Tempo approssimativo necessario per 
la ricarica completa di un pacco batteria 
completamente scarico, in minuti.

Pacco batteria Tempo di carica 
completa

BP-U35 120 minuti

[Nota]
La batteria comincia a scaricarsi anche se viene lasciata 
connessa al caricabatterie mentre il caricabatterie non è 
connesso all’adattatore CA.

Alimentazione CA

Collegando il camcorder a una sorgente di 
alimentazione di rete, è possibile utilizzarlo 
senza doversi preoccupare di ricaricare il 
pacco batteria.

Connettore DC IN

Adattatore CA

Cavo di 
alimentazione

Collegare l’adattatore CA al connettore DC 
IN del camcorder, quindi collegare il cavo di 
alimentazione (in dotazione) alla sorgente di 
alimentazione di rete.

Se la tensione fornita dall’adattatore CA 
si abbassa

Se, durante l’utilizzo, la tensione fornita 
dall’adattatore CA scende al di sotto di un 
determinato valore (stato DC Low Voltage1), 
viene visualizzato un messaggio che segnala 
l’abbassamento della tensione dell’adattatore 
CA e la spia di registrazione/tally comincia a 
lampeggiare.
Se la tensione di uscita dell’adattatore CA 
scende al di sotto di un valore che impedisce 
il funzionamento corretto (stato DC Low 
Voltage2), viene visualizzato un messaggio 
che segnala che la tensione di uscita 
dell’adattatore CA è insufficiente.

In questo caso, l’adattatore CA può essere 
difettoso. Controllare l’adattatore CA secondo 
il caso.

Modifica delle tensioni di avviso

Per impostazione predefinita, il livello DC Low 
Voltage1 è impostato su 16,5 V e il livello DC 
Low Voltage2 è impostato su 15,5 V. È possibile 
modificare i valori dei livelli di avviso con 
l’opzione Camera DC IN Alarm (pagina 96) 
del menu Technical.

Adattatore CA

ˎˎ Non collegare né utilizzare un adattatore CA 
in uno spazio ristretto, ad esempio fra una 
parete e un mobile.
ˎˎ Collegare l’adattatore CA alla presa 
di corrente di rete più vicina. In caso 
di problemi durante l’uso, estrarre 
immediatamente la spina dalla presa di 
corrente.
ˎˎ Non cortocircuitare le parti metalliche dello 
spinotto dell’adattatore CA. Questo ne 
causerebbe il guasto.
ˎˎ La batteria non può essere ricaricata mentre 
è montata sul camcorder, anche se è 
connesso l’adattatore CA.
ˎˎ Per scollegare l’adattatore CA dall’unità, 
assicurarsi di afferrarne solo lo spinotto ed 
estrarlo senza ruotarlo. Non tirare il cavo per 
evitare possibili malfunzionamenti.
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Montaggio degli accessori

Montaggio di un microfono (in 
vendita separatamente)

1	 Inserire il microfono nel portamicrofono.

2	 Collegare il cavo del microfono al 
connettore INPUT1 o al connettore INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Microfono

Portamicrofono

INPUT1 INPUT2

3	 Collocare il cavo del microfono nel 
fermacavo come mostrato in figura.

Fermacavi

[Informazioni]
ˎˎ Se non è possibile assicurare saldamente il microfono 

nel portamicrofono, utilizzare il distanziale fornito con 
il microfono stesso.
ˎˎ Con certi obiettivi, è possibile che l’estremità anteriore 

del microfono risulti visibile nell’immagine ripresa dal 
camcorder. Regolare la posizione del microfono.

Montaggio del mirino

[Nota]
Montare e smontare il mirino solo mentre il camcorder 
è spento.

Montaggio del mirino sulla sezione 
anteriore della maniglia

1	 Inserire l’adattatore del morsetto di 
montaggio nell’attacco del mirino della 
maniglia (), quindi ruotare in senso 
orario la vite (in dotazione) per fissarlo in 
posizione ().
L’adattatore del morsetto di montaggio 
può essere montato in qualsiasi posizione 
in incrementi di 45°, ma si consiglia di 
montarlo nella posizione in cui si trova 
immediatamente sopra la vite.

Vite
Adattatore del morsetto 
di montaggio del mirino

2	 Montare il morsetto del mirino 
sull’adattatore del morsetto di montaggio 
del mirino (), quindi ruotare in senso 
orario la manopola di bloccaggio per 
fissarlo in posizione ().

[Nota]
Quando si utilizza un mirino, è importante che la 
manopola di bloccaggio sia saldamente serrata. Se la 
manopola di bloccaggio non è saldamente serrata, il 
mirino potrebbe cadere.

3	 Allineare l’indicatore  presente sul 
camcorder con il corrispondente 
indicatore  sul connettore del mirino, 
quindi inserire il cavetto.
Prima di inserire il connettore, controllare 
che l’indicatore  si trovi sul lato esterno.

4	 Collocare il cavo nel fermacavo come 
mostrato in figura.

Fermacavi
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Montaggio del mirino sulla sezione 
posteriore della maniglia

Per il montaggio del mirino, sono disponibili 
due punti di montaggio sulla sezione 
posteriore della maniglia () e due punti di 
montaggio sul lato posteriore del camcorder 
(). Montare il mirino come descritto nella 
sezione “Montaggio del mirino sulla sezione 
anteriore della maniglia”.

Regolazione della posizione del mirino

Inclinare il mirino verso l’alto, verso il basso, in 
avanti o indietro fino ad ottenere l’angolazione 
desiderata.
Usando il selettore MIRROR, è possibile 
invertire l’immagine quando questa viene 
osservata, ad esempio, dal lato anteriore del 
camcorder.

[Informazione]
Quando il camcorder non è utilizzato o durante 
il trasporto, è consigliabile proteggere il mirino 
spostandolo sulla posizione mostrata in figura.

Rimozione del mirino

Allentare la manopola di bloccaggio del mirino 
e ripetere la procedura di montaggio in senso 
inverso.

Montaggio del paraluce del mirino

1	 Aprire le clip metalliche del paraluce del 
mirino.

2	 Agganciare la clip metallica presente sulla 
parte superiore del paraluce al 
corrispondente gancio situato sul lato 
superiore del mirino, quindi agganciare la 
clip metallica della parte inferiore del 
paraluce al gancio sul lato inferiore del 
mirino.

Agganci

3	 Bloccare il paraluce del mirino in posizione 
spingendo in direzione della freccia la 
piastrina di bloccaggio situata nella parte 
inferiore del paraluce del mirino.

Piastrina di 
bloccaggio

Apertura del paraluce del mirino

Per aprire il paraluce del mirino sollevarlo 
tirandolo dal centro del lato inferiore.

[Nota]
Spostare il mirino afferrandone sempre solo il corpo. 
Non afferrare il paraluce del mirino.

Rimozione del paraluce del mirino

Sganciare il gancio del paraluce del mirino e 
rimuovere il paraluce dal mirino.
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Montaggio dell’impugnatura di 
telecomando

[Nota]
Montare e smontare l’impugnatura di telecomando solo 
mentre il camcorder è spento.

1	 Collegare il cavetto al connettore 
dell’impugnatura di telecomando.

2	 Allineando l’attacco di montaggio 
dell’impugnatura di telecomando del 
camcorder con l’indicatore di montaggio 
presente sull’impugnatura (), inserire 
l’impugnatura sul camcorder e ruotarla 
lentamente in senso antiorario ().
Al blocco in posizione si percepirà uno 
scatto.

Indicatore

[Nota]
Se il montaggio non riesce correttamente, riprovare a 
inserire l’impugnatura di telecomando senza forzare né 
l’impugnatura né il camcorder.

3	 Inserire il cavetto collegato al punto 2 
nell’apposita scanalatura di guida 
presente sull’impugnatura di 
telecomando, come illustrato in figura.

[Nota]
Se il cavetto non è inserito nella scanalatura, spostando 
l’angolazione dell’attacco dell’impugnatura si 
potrebbero esercitare sul cavetto tensioni eccessiva, 
oppure il cavetto potrebbe rimanere intrappolato nel 
meccanismo di rotazione.

Regolazione dell’angolazione 
dell’impugnatura di telecomando

L’angolazione dell’impugnatura di 
telecomando può essere regolata nella 
posizione più comoda per il proprio stile di 
ripresa.

Posizione normale

Ruotata verso l’obiettivo (massimo 90°).

Ruotata verso il retro (massimo 83°).

1	 Spostare la levetta di rotazione 
dell’impugnatura nella posizione mostrata 
in figura e ruotare l’impugnatura 
mantenendo premuta la levetta.

2	 Sollevare il dito dalla levetta di rotazione 
dell’impugnatura in prossimità della 
posizione desiderata.

3	 Continuare a spostare leggermente 
l’impugnatura fino a percepire lo scatto e 
il blocco in posizione.
Una volta bloccata l’impugnatura nella 
posizione desiderata, la levetta di 
rotazione dell’impugnatura torna nella 
sua posizione originale.

[Note]
ˎˎ Dopo averne cambiato la posizione, controllare 

sempre che l’impugnatura sia saldamente bloccata.
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ˎˎ Non è possibile regolare l’angolazione oltre le 
posizioni consentite. Non esercitare una forza 
eccessiva per lo spostamento dell’impugnatura.

Come afferrare l’impugnatura (metodo 
consigliato)

Non esiste una regola fissa che stabilisce come 
afferrare l’impugnatura. Il seguente esempio, 
tuttavia, mostra una posizione che consente il 
facile azionamento dei vari comandi.

Utilizzo del pulsante ASSIGN 5 o del selettore 
multiplo

A: Azionare la manopola programmabile 
dell’impugnatura con il dito indice.
B: Azionare il selettore multiplo e il pulsante 
ASSIGN 5 con il pollice.
C: Afferrare saldamente l’impugnatura con il 
dito medio, l’anulare e il mignolo.

Utilizzo dello zoom

A: Azionare la levetta dello zoom con l’indice 
e il medio.
B: Afferrare saldamente l’impugnatura con il 
pollice.
C: Afferrare saldamente l’impugnatura con 
l’anulare e il mignolo.

Rimozione dell’impugnatura

[Nota]
Per la rimozione dell’impugnatura, appoggiare sempre 
il camcorder su una superficie piana, ad esempio un 
tavolo.

1	 Scollegare il cavetto dal connettore 
dell’impugnatura di telecomando.

2	 Mantenendo premuto il pulsante di 
rilascio dell’impugnatura di telecomando, 
ruotare l’impugnatura in senso orario fino 
al distacco.

Pulsante di rilascio dell’impugnatura di 
telecomando

[Informazione]
Sia il punto di montaggio dell’impugnatura del 
camcorder che il corrispondente punto di montaggio 
sull’impugnatura consentono il montaggio di una 
rosetta.
Per informazioni dettagliate sull’acquisto di rosette, 
rivolgersi al proprio rivenditore Sony.
–– Lato camcorder: 4-546-932- (opzione)
–– Lato impugnatura: 4-547-089- (opzione)
–– Viti di fissaggio* 

Lato camcorder: 7-627-556- (opzione) 
Lato impugnatura: 7-627-556- (opzione)

*	 Ciascuna rosetta richiede quattro viti di fissaggio (i 
relativi fori sono indicati con cerchi nel diagramma 
seguente). L’utilizzo di viti diverse da quelle 
specificate potrebbe danneggiare la superficie 
esterna dell’apparecchio.

Lato 
camcorder

Lato 
impugnatura

Montaggio dell’obiettivo

[ATTENZIONE]

Non lasciare l’obiettivo rivolto verso il sole. 
La luce solare diretta condotta dalle ottiche 
dell’obiettivo può mettersi a fuoco all’interno 
del camcorder e causare incendi.

[Note]
ˎˎ Montare e smontare l’obiettivo solo mentre il 

camcorder è spento.
ˎˎ Gli obiettivi sono componenti di elevata precisione. 

Non appoggiare mai un obiettivo su una superficie 
con il suo innesto rivolto verso il basso. Montare 
sempre l’apposito coperchietto di protezione fornito.

[Informazione]
Per informazioni dettagliate sugli obiettivi supportati dal 
camcorder, contattare il rappresentante dell’assistenza 
tecnica Sony.

Montaggio di un obiettivo con innesto 
E-mount

1	 Rimuovere i coperchietti di protezione dal 
corpo del camcorder e dall’obiettivo.
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2	 Per montare l’obiettivo, allineare con il 
camcorder l’indicatore (bianco) 
sull’innesto dell’obiettivo, inserire con 
attenzione l’obiettivo nell’innesto, quindi 
ruotare l’obiettivo in senso orario.
Al blocco in posizione si percepirà uno 
scatto.

Indicatori di allineamento (bianco)

[Nota]
Non premere il pulsante di rilascio dell’obiettivo durante 
l’inserimento di un obiettivo.

Montaggio di un obiettivo con innesto 
A-mount

Per poter montare un obiettivo con innesto 
A-mount, è necessario montare prima 
l’apposito adattatore (opzionale).

[Nota]
Quando si utilizza un obiettivo con innesto A-mount, 
il diaframma è impostato manualmente e la messa a 
fuoco è impostata su MF.

Rimozione dell’obiettivo

Per rimuovere l’obiettivo, procedere come 
descritto di seguito.

1	 Mantenendo premuto il pulsante di 
rilascio dell’obiettivo, ruotare l’obiettivo in 
senso antiorario sostenendolo con la 
mano.

2	 Estrarre l’obiettivo dal corpo 
dell’apparecchio.

[Note]
ˎˎ Durante la rimozione, allineare l’indicatore di innesto 

sulla ghiera di blocco obiettivo con l’indicatore di 
innesto del camcorder.
ˎˎ Afferrare saldamente l’obiettivo con la mano per 

impedirne la caduta.
ˎˎ Se non viene montato un altro obiettivo 

immediatamente, montare sempre il coperchietto di 
protezione del corpo.

Regolazioni del diaframma con obiettivi 
con selettore Auto Iris

ˎˎ Quando il selettore Auto Iris dell’obiettivo 
è impostato su AUTO, il diaframma viene 
regolato automaticamente ma può 
essere anche regolato manualmente dal 
camcorder.
ˎˎ Quando il selettore Auto Iris dell’obiettivo 
è impostato su MANUAL, il diaframma 
può essere regolato solo usando la 
ghiera dell’obiettivo stesso. Le eventuali 

regolazioni del diaframma dal camcorder 
non hanno alcun effetto.

Regolazioni della messa a fuoco con 
obiettivi con selettore di messa a fuoco

ˎˎ Quando il selettore della messa a fuoco 
dell’obiettivo è impostato su AF/MF 
o AF, la messa a fuoco viene regolata 
automaticamente ma può essere anche 
regolata manualmente con un telecomando.
ˎˎ Quando il selettore della messa a fuoco 
dell’obiettivo è impostato su MF, la messa a 
fuoco può essere regolata sia mediante la 
ghiera dell’obiettivo che manualmente con 
un telecomando.

	 [Nota]
Quando si utilizza un obiettivo con innesto A-mount, 
potrebbe non essere possibile eseguire la regolazione 
manuale con un telecomando.

ˎˎ Quando il selettore della messa a fuoco 
dell’obiettivo è impostato su Full MF, la 
messa a fuoco può essere eseguita solo 
usando la ghiera dell’obiettivo. Le eventuali 
regolazioni della messa a fuoco dal 
camcorder non hanno alcun effetto.

Montaggio di un treppiede

Usare gli attacchi filettati di montaggio del 
treppiede sul camcorder quando si monta 
un treppiede. L’utilizzo dell’attacco treppiede 
sull’obiettivo potrebbe causare danni.
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Configurazione delle operazioni di base del camcorder
Quando il camcorder viene acceso per la prima 
volta o se la batteria di backup si è scaricata 
completamente, nel mirino viene visualizzata 
la schermata delle impostazioni iniziali.
Impostare la data e l’ora dell’orologio interno 
in questa schermata.

Time Zone
Time Zone imposta il fuso orario, ovvero la 
differenza con l’ora UTC (Coordinated Universal 
Time). Impostare questo valore secondo il caso.

Impostazione della data e dell’ora

Utilizzare il selettore multiplo (pagina 7) 
o la manopola multifunzione (pagina 5) 
per selezionare voci e impostazioni, quindi 
premere il pulsante di conferma del selettore 
multiplo per confermare le impostazioni e 
avviare l’orologio.
In seguito, dopo la chiusura della schermata di 
impostazione, è possibile modificare data, ora 
e fuso orario servendosi dell’opzione Clock Set 
(pagina 101) del menu Maintenance.

[Note]
ˎˎ Se le impostazioni di data e ora sono andate 

perse perché la batteria di backup si è scaricata 
completamente a seguito di un lungo periodo 
di tempo in cui il camcorder è rimasto senza 
alimentazione (senza pacco batteria o alimentazione 
DC IN), verrà nuovamente visualizzata la schermata 
delle impostazioni iniziali quando si riaccende 
nuovamente il camcorder.
ˎˎ Mentre è visualizzata la schermata delle impostazioni 

iniziali non è possibile eseguire alcuna operazione 
(ad eccezione dello spegnimento) fino a quando non 
si siano completate tutte le impostazioni di questa 
schermata.
ˎˎ Il camcorder è dotato di una batteria ricaricabile 

interna che consente la memorizzazione di data, ora e 
altre impostazioni anche quando è spento.

Prima di iniziare le riprese, è necessario 
configurare il funzionamento di base del 
camcorder secondo l’applicazione specifica 
nella schermata di stato Project.

4/12
Frequency/Scan

59.94P
Imager Scan

FF
Shooting Mode

Custom (709)
Codec

XAVC-I
Video Format

2160P3840
RAW Output Format

- - -
Rec Function

O�
Simul Rec

O�
Proxy Rec

O�
Title Prefix

000_
Number

0001

Project

Modalità di ripresa

Sono disponibili due modalità di ripresa: la 
modalità “Custom”, che consente la creazione 
dell’immagine in sito con la massima 
flessibilità, e la modalità “Cine EI”, in cui il 
camcorder viene utilizzato in maniera analoga 
a una macchina cinematografica a pellicola, 
sviluppando poi le riprese in sede di post 
produzione.
Impostare la modalità di ripresa con Shooting 
Mode (pagina 14) nella schermata di stato 
Project.

[Informazione]
La modalità di ripresa può essere impostata anche con 
Base Setting >Shooting Mode (pagina 78) nel menu 
Project del menu completo.

Modalità Custom

In modalità di ripresa Custom è possibile 
selezionare lo standard video utilizzato.
Lo standard video può essere impostato con 
Base Setting >Target Display (pagina 78) nel 
menu Project del menu completo.
ˎˎ SDR(BT.709): Ripresa con lo standard di 
broadcast HD

ˎˎ HDR(HLG): Ripresa con lo standard di 
broadcast 4K di prossima generazione

Per informazioni dettagliate, vedere pagina 
53.

Modalità Cine EI

Quando la modalità di ripresa è impostata su 
Cine EI, selezionare lo spazio colore di base 
per il segnale di registrazione e per il segnale 
di uscita. Lo spazio colore selezionato qui è lo 
spazio colore dell’uscita video quando MLUT è 
impostato su Off.
È possibile impostare lo spazio colore 
desiderato mediante Cine EI Setting >Color 
Gamut (pagina 79) nel menu Project del 
menu completo.
ˎˎ S-Gamut3.Cine/SLog3: Gamme di colore 
per il cinema digitale di facile regolazione 
(DCI-P3).
ˎˎ S-Gamut3/SLog3: Gamma di colore Sony 
molto ampia che copre lo spazio colore 
ITU-R BT.2020.

Per informazioni dettagliate, vedere pagina 
55.

[Note]
ˎˎ La modalità Cine EI presenta le seguenti limitazioni:

ˎˎ Funzioni che non possono essere regolate 
automaticamente (tracking)
–– Bilanciamento del bianco
–– Guadagno
–– Otturatore

ˎˎ Funzioni che non possono essere configurate
–– Sensibilità ISO/guadagno (impostata sulla 

sensibilità ISO di base (fissa))
–– Impostazioni menu Paint/Look (eccetto Base 

Look)
–– File di scena (disabilitato)

ˎˎ Le funzioni indicate di seguito sono disponibili solo in 
modalità Cine EI (pagina 55).

ˎˎ Exposure Index
ˎˎ Monitor LUT

Frequenza di sistema

Impostare la frequenza di sistema con 
Frequency/Scan (pagina 14) nella 
schermata di stato Project. Dopo la 
selezione, il camcorder potrebbe riavviarsi 
automaticamente, a seconda del valore 
selezionato.

[Informazione]
La frequenza di sistema può essere impostata anche con 
Rec Format >Frequency (pagina 78) nel menu Project 
del menu completo.

[Nota]
Non è possibile cambiare la frequenza di sistema 
durante la registrazione o la riproduzione.

Modalità di scansione imager

Le dimensioni di immagine effettive e la 
risoluzione del sensore immagini possono 
essere impostate secondo le proprie esigenze.
Impostare la modalità di scansione con Imager 
Scan (pagina 14) nella schermata di stato 
Project.
ˎˎ FF: Formato Full Frame.
ˎˎ S35: Formato Super 35mm.

[Informazione]
La modalità di scansione può essere impostata anche 
con Rec Format >Imager Scan Mode (pagina 78) nel 
menu Project del menu completo.

[Note]
ˎˎ Non è possibile cambiare la modalità di scansione 

dell’imager durante la registrazione o la riproduzione.
ˎˎ Se impostata su S35, il formato video è limitato a 

1920×1080.
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Codec

Impostare il codec con Codec (pagina 14) 
nella schermata di stato Project.

[Informazione]
Il codec può essere impostato anche con Rec Format 
>Codec (pagina 78) nel menu Project del menu 
completo.

[Nota]
Non è possibile cambiare il codec durante la 
registrazione o la riproduzione.

Formato video

È possibile scegliere il formato video per le 
registrazioni. Impostare il formato video con 
Video Format (pagina 14) nella schermata 
di stato Project.

[Informazione]
Il formato video può essere impostato anche con Rec 
Format >Video Format (pagina 78) nel menu Project 
del menu completo.

[Note]
ˎˎ Non è possibile cambiare il formato video durante la 

registrazione o la riproduzione.
ˎˎ In base alle impostazioni del formato video, 

potrebbero essere presenti limitazioni relative al 
segnale fornito dai connettori SDI OUT e HDMI OUT.
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Il camcorder registra audio e video su schede di memoria CFexpress Type A (disponibili 
separatamente) o schede di memoria SDXC (disponibili separatamente) inserite negli 
appositi slot. Le schede di memoria sono utilizzate anche per la registrazione proxy, per la 
memorizzazione e il caricamento di impostazioni, nonché per l’aggiornamento o upgrade del 
software.

Informazioni sulle schede di memoria CFexpress Type A

Utilizzare con il camcorder le schede di memoria Sony CFexpress Type A* indicate in “Supporti di 
memoria consigliati” (pagina 27).
Per informazioni dettagliate sull’utilizzo di supporti di memoria di altri fabbricanti, fare 
riferimento alle relative istruzioni per l’uso o consultare le informazioni del fabbricante.
* Indicate semplicemente come “schede CFexpress” nel presente documento.

Informazioni sulle schede di memoria SDXC

Utilizzare con il camcorder le schede di memoria SDXC* indicate in “Supporti di memoria 
consigliati” (pagina 27).
* Indicate semplicemente come “schede SD” nel presente documento.

Utilizzo di schede di memoria
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Supporti di memoria consigliati

Le condizioni operative garantite variano a seconda delle impostazioni di Rec Format e Recording.
Sì: Funzionamento supportato
No: il funzionamento corretto non è garantito

Formato di registrazione CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Modalità normale 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

24P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì

3840×2160
Class300

Modalità normale 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì

S&Q (max. 60fps) 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

23.98P Sì No No No No No No Sì

S&Q (100fps, 120fps) 59.94P Sì No No No No No No No

50P Sì No No No No No No No

29.97P Sì No No No No No No No

25P Sì No No No No No No No

23.98P Sì No No No No No No No



2. Operazioni preliminari: Utilizzo di schede di memoria28

Formato di registrazione CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Modalità normale 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

24P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì

S&Q (max. 60fps) 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

24P Sì No No No No No No Sì

23.98P Sì No No No No No No Sì

3840×2160
Class300 

Modalità normale 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì

S&Q (max. 60fps) 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

23.98P Sì No No No No No No Sì

S&Q (100fps, 120fps) 59.94P Sì No No No No No No No

50P Sì No No No No No No No

29.97P Sì No No No No No No No

25P Sì No No No No No No No

23.98P Sì No No No No No No No
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Formato di registrazione CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Modalità normale 59.94P Sì No No No No No Sì Sì

50P Sì No No No No No Sì Sì

29.97P Sì No No Sì No Sì Sì Sì

25P Sì No No Sì No Sì Sì Sì

23.98P Sì No No Sì No Sì Sì Sì

S&Q (max. 60fps) 59.94P Sì No No No No No Sì Sì

50P Sì No No No No No Sì Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì

S&Q (100fps, 120fps) 59.94P Sì No No No No No No Sì

50P Sì No No No No No No Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

23.98P Sì No No No No No No Sì

S&Q (150fps, 180fps) 59.94P Sì No No No No No No No

50P Sì No No No No No No No

29.97P Sì No No No No No No No

25P Sì No No No No No No No

23.98P Sì No No No No No No No

S&Q (200fps, 240fps) 59.94P Sì No No No No No No No

50P Sì No No No No No No No

29.97P Sì No No No No No No No

25P Sì No No No No No No No

23.98P Sì No No No No No No No
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Formato di registrazione CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Modalità normale 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No Sì No Sì Sì Sì

25P Sì No No Sì No Sì Sì Sì

23.98P Sì No No Sì No Sì Sì Sì

S&Q (max. 60fps) 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No No Sì

S&Q (100fps, 120fps) 59.94P Sì No No No No No Sì Sì

50P Sì No No No No No Sì Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

23.98P Sì No No No No No No No

1920×1080
HD50

Modalità normale 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No Sì No Sì Sì Sì

25P Sì No No Sì No Sì Sì Sì

23.98P Sì No No Sì No Sì Sì Sì

S&Q (max. 60fps) 59.94P Sì Sì Sì Sì Sì Sì Sì Sì

50P Sì Sì Sì Sì Sì Sì Sì Sì

29.97P Sì No No Sì No Sì Sì Sì

25P Sì No No Sì No Sì Sì Sì

23.98P Sì No No Sì No Sì Sì Sì

S&Q (100fps, 120fps) 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì
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Formato di registrazione CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Sì No No No No No Sì Sì

50P Sì No No No No No Sì Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

23.98P Sì No No No No No No Sì

S&Q (200fps, 240fps) 59.94P Sì No No No No No Sì Sì

50P Sì No No No No No Sì Sì

29.97P Sì No No No No No No Sì

25P Sì No No No No No No Sì

23.98P Sì No No No No No No Sì

1920×1080
HD35

Modalità normale 59.94P Sì Sì Sì Sì Sì Sì Sì Sì

50P Sì Sì Sì Sì Sì Sì Sì Sì

29.97P Sì Sì Sì Sì Sì Sì Sì Sì

25P Sì Sì Sì Sì Sì Sì Sì Sì

23.98P Sì Sì Sì Sì Sì Sì Sì Sì

S&Q (max. 60fps) 59.94P Sì Sì Sì Sì Sì Sì Sì Sì

50P Sì Sì Sì Sì Sì Sì Sì Sì

29.97P Sì No No Sì No Sì Sì Sì

25P Sì No No Sì No Sì Sì Sì

23.98P Sì No No Sì No Sì Sì Sì

S&Q (100fps, 120fps) 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No Sì No Sì Sì Sì

25P Sì No No Sì No Sì Sì Sì

23.98P Sì No No No No No Sì Sì

S&Q (150fps, 180fps) 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No Sì Sì

S&Q (200fps, 240fps) 59.94P Sì No No Sì No Sì Sì Sì

50P Sì No No Sì No Sì Sì Sì

29.97P Sì No No No No No Sì Sì

25P Sì No No No No No Sì Sì

23.98P Sì No No No No No No Sì
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Inserimento di una scheda di memoria

1	 Aprire il coperchietto della sezione slot 
schede.

2	 Inserire una scheda di memoria.
ˎˎ Per le schede CFexpress, l’etichetta è 
rivolta a sinistra.

Etichetta

ˎˎ Per le schede SD, l’etichetta è rivolta a 
destra con l’angolo tagliato in basso.

Angolo tagliato

L’indicatore di accesso (pagina 6) si 
illumina di rosso, quindi diventa verde se 
la scheda è utilizzabile.

[Nota]
Qualora l’indicatore di accesso lampeggi 
continuamente in rosso senza diventare verde, 
provare a spegnere momentaneamente il 
camcorder, quindi rimuovere e reinserire la scheda 
di memoria.

3	 Chiudere il coperchietto.

[Note]
ˎˎ La scheda di memoria, lo slot e i dati di immagine 

contenuti sulla scheda potrebbero subire danni se la 
scheda venisse forzata nello slot con l’orientamento 
errato.
ˎˎ Per la registrazione su schede CFexpress Type A o 

SD contenute nei due slot A e B, è necessario che 
entrambe le schede inserite siano di tipo adatto al 
formato della registrazione.

Espulsione di una scheda di memoria

Aprire il coperchietto della sezione slot schede 
ed esercitare una leggera pressione sulla 
scheda di memoria per espellerla.

[Note]
ˎˎ Se il camcorder viene spento o la scheda viene rimossa 

durante l’accesso alla scheda, non è possibile garantire 
l’integrità dei dati contenuti sulla scheda. Tutti i dati 
registrati sulla scheda potrebbero essere danneggiati. 
Assicurarsi sempre che l’indicatore di accesso sia 
illuminato in verde o spento prima di spegnere il 
camcorder o rimuovere la scheda di memoria.
ˎˎ Se si rimuove una scheda di memoria 

immediatamente dopo la registrazione, è possibile 
che sia calda. Questo tuttavia non indica un problema.

Formattazione (inizializzazione) di 
schede di memoria

Se viene inserita una scheda di memoria non 
formattata o formattata con altre specifiche, il 

mirino visualizza il messaggio “Media Needs 
to be Formatted”.
Formattare la scheda come descritto di 
seguito.

1	 Selezionare Format Media (pagina 87) 
nel menu TC/Media del menu completo.

2	 Selezionare Media(A) (slot A) o Media(B) 
(slot B), quindi selezionare il metodo di 
formattazione desiderato (Full Format o 
Quick Format).
Viene visualizzato un messaggio di 
conferma.
ˎˎ Full Format: Inizializza completamente 
il supporto di memoria, compresa 
la regione contenente i dati e le 
informazioni di gestione dei dati.
ˎˎ Quick Format: Inizializza solamente le 
informazioni di gestione dei dati del 
supporto di memoria.

3	 Selezionare Execute.
Durante la formattazione è visualizzato un 
messaggio e l’indicatore di accesso si 
illumina di rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare 
che l’operazione è stata completata. 
Premere la manopola multifunzione per 
chiudere il messaggio.

[Note]
ˎˎ La formattazione di una scheda di memoria elimina 

tutti i dati che contiene, comprese le registrazioni 
video e i file di setup.
ˎˎ A seconda della durata, potrebbero essere visualizzati 

messaggi anche durante il processo di formattazione.

Se la formattazione non riesce

Non è possibile formattare schede di memoria 
non supportate dal camcorder.
Viene visualizzato un messaggio di 
avvertimento. Seguire le istruzioni e sostituire 

la scheda con una scheda di memoria 
supportata.

Per utilizzare con un altro dispositivo 
una scheda SD formattata con questo 
camcorder

Eseguire il backup di tutti i dati registrati sulla 
scheda, quindi riformattare la scheda nel 
dispositivo in cui deve essere utilizzata.

Controllo del tempo di 
registrazione rimanente

Durante la ripresa (registrazione/standby), è 
possibile monitorare la capacità rimanente 
sulla scheda di memoria di ciascuno slot 
mediante gli indicatori di capacità rimanente 
degli slot A e B visualizzati nel mirino 
(pagina 11).
Il tempo di registrazione rimanente è calcolato 
sulla base della capacità rimanente della 
scheda di ciascuno slot e del formato video 
corrente (bit rate di registrazione) ed è indicato 
in minuti.

Tempi di sostituzione delle schede di 
memoria

ˎˎ Quando il tempo di registrazione rimanente 
totale sulle due schede di memoria scende 
al di sotto di 5 minuti, viene visualizzato 
il messaggio “Media Near Full”, la spia di 
registrazione/tally comincia a lampeggiare 
e viene emesso un segnale acustico di 
avvertimento sull’uscita cuffie.  
Sostituire con una scheda con spazio libero 
sufficiente.
ˎˎ Se si prosegue con la registrazione fino 
a esaurire completamente lo spazio 
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disponibile, appare il messaggio “Media 
Full” e la registrazione si arresta.

[Nota]
Una scheda di memoria consente la registrazione di un 
massimo di 600 clip circa.

Ripristino delle schede di 
memoria

Qualora si verifichi un errore su una scheda di 
memoria, la scheda dovrà essere ripristinata 
prima di poter essere nuovamente utilizzata.
Se si inserisce una scheda di memoria che 
deve essere ripristinata, lo schermo del 
mirino visualizza un messaggio che chiede di 
confermare il ripristino.

Ripristino di una scheda di memoria

Ruotare la manopola multifunzione 
(pagina 5) per selezionare Execute, quindi 
premere la manopola multifunzione.
Durante la formattazione lo schermo 
visualizza un messaggio e la percentuale (%) 
di avanzamento dell’operazione. L’indicatore 
di accesso è inoltre illuminato in rosso.
Al termine del ripristino viene visualizzato un 
messaggio di conferma.

Se il ripristino non riesce

ˎˎ Non è possibile ripristinare schede di 
memoria su cui sono presenti errori di 
memoria. Viene visualizzato un messaggio 
di avvertimento. Seguire le istruzioni e 
sostituire la scheda la scheda di memoria.
ˎˎ Le schede di memoria che contengono 
errori di memoria potrebbero diventare 
nuovamente utilizzabili se riformattate.

ˎˎ In alcuni casi, potranno essere ripristinati 
solo alcuni clip e non altri. I clip ripristinati 
possono essere riprodotti normalmente.

[Note]
ˎˎ Per il ripristino dei supporti, utilizzare sempre lo 

stesso camcorder utilizzato per registrarli.
ˎˎ Questo camcorder non consente di ripristinare 

supporti registrati con apparecchi diversi o con 
camcorder di versione diversa (anche se dello stesso 
modello).
ˎˎ I clip di durata inferiore a 2 secondi non possono 

essere ripristinati.
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Operazioni di base
Di seguito si descrive la procedura per 
eseguire una semplice ripresa di base.

1	 Montare i dispositivi necessari e 
controllare che l’alimentazione sia 
presente.

2	 Inserire almeno una scheda di memoria.

3	 Spostare il selettore POWER sulla 
posizione ON.
L’indicatore POWER si illumina e 
l’immagine proveniente dal camcorder 
appare sul mirino.

4	 Premere il pulsante START/STOP 
registrazione (pagina 5).
La spia di registrazione/tally si accende e 
la registrazione ha inizio.

5	 Per arrestare la registrazione, premere di 
nuovo il pulsante START/STOP 
registrazione.
La registrazione si arresta e il camcorder 
entra in modalità STBY (standby).

[Nota]
Se si preme il pulsante START/STOP registrazione nei 
primi secondi immediatamente dopo l’accensione 
del camcorder, la spia di registrazione/tally si illumina 
per indicare che il camcorder si trova in stato di 
registrazione. Ciononostante, a seconda del formato 
di registrazione selezionato, potrebbero essere 
necessari alcuni secondi prima dell’avvio effettivo della 
registrazione sul supporto.

Passaggio da una scheda di 
memoria all’altra

Quando sono inserite due schede di 
memoria, premere il pulsante SLOT SELECT 
(pagina 6) per passare da una scheda 
all’altra.
La registrazione passa automaticamente 
alla seconda scheda di memoria appena 
immediatamente prima dell’esaurimento 
completo dello spazio sulla prima scheda 
(registrazione relay). È possibile eseguire 
registrazioni continuate ininterrottamente 
sostituendo ogni volta la scheda di memoria 
piena con una nuova.

[Nota]
Non è possibile passare da una scheda all’altra durante 
la riproduzione. Non è inoltre possibile la riproduzione 
continuata di un clip che si estende su entrambe le 
schede di memoria dei due slot A e B.

Clip (dati registrati)
Quando si arresta la registrazione, il video, 
l’audio e i dati accessori dall’inizio alla fine 
della registrazione vengono salvati come un 
unico “clip” sulla scheda di memoria.

Nome dei clip
Il nome dei clip registrati dal camcorder viene 
assegnato automaticamente utilizzando il 
formato impostato tramite la voce Clip Name 
Format (pagina 87) nel menu TC/Media del 
menu completo.

Durata massima dei clip
Fino a 6 ore per clip.
La durata massima di una registrazione 
continua è identica alla durata massima di 
un clip. Se il tempo di registrazione del clip 
supera la lunghezza massima consentita, 
viene creato automaticamente un nuovo clip e 
la registrazione continua. Il nuovo clip apparirà 

sulla schermata delle miniature come un clip 
separato.

Nella funzione di registrazione relay, vengono 
registrati più clip in successione l’uno dopo 
l’altro. In questa modalità, la registrazione si 
arresta automaticamente dopo circo 24 ore.

[Note]
ˎˎ Non espellere una scheda di memoria mentre 

è in corso la registrazione su di essa. Durante la 
registrazione, sostituire schede di memoria solo negli 
slot il cui indicatore di accesso non è illuminato.
ˎˎ Quando la capacità rimanente sulla scheda di 

memoria su cui viene eseguita la registrazione 
diventa inferiore a un minuto ed è presente una 
scheda di memoria registrabile nell’altro slot, viene 
visualizzato il messaggio “Will Switch Slots Soon”. Il 
messaggio scompare dopo il passaggio all’altro slot.
ˎˎ La registrazione relay può non essere possibile se 

la registrazione viene avviata quando la capacità 
rimanente della scheda di memoria è inferiore a un 
minuto. Per consentire il funzionamento corretto 
della registrazione relay, controllare che la capacità 
rimanente sulla scheda di memoria sia superiore a un 
minuto prima di iniziare la registrazione.
ˎˎ I video creati con la funzione di registrazione relay 

del camcorder non possono essere riprodotti senza 
interruzione sul camcorder.
ˎˎ Per unire insieme video creato con la funzione di 

registrazione relay del camcorder, utilizzare il software 
“Catalyst Browse”.

Monitoraggio audio

L’audio registrato può essere monitorato 
tramite le cuffie.
Collegando delle cuffie al relativo jack 
(pagina 5) è possibile monitorare 
l’audio durante la registrazione. L’audio 
di riproduzione (pagina 65) può essere 
monitorato sia tramite l’altoparlante 
incorporato (pagina 6) che le cuffie.
Il volume dell’audio di monitoraggio 
può essere regolato mediante Volume 
(pagina 14) nella schermata Audio 

Status o mediante Audio Output >Volume 
(pagina 92) nel menu Audio del menu 
completo.
Il canale da monitorare può essere selezionato 
mediante Monitor CH (pagina 14) nella 
schermata Audio Status o mediante Audio 
Output >Monitor CH (pagina 92) nel menu 
Audio del menu completo. 

Specifica dei dati temporali

Impostazione del codice temporale

Impostare il codice temporale da registrare 
con la voce Timecode (pagina 86) del menu 
TC/Media del menu completo.

Impostazione dei bit utente

È possibile aggiungere all’immagine 
registrata un numero esadecimale a 8 cifre 
come bit utente. Il bit utente può essere 
anche impostato sull’ora corrente. Eseguire 
l’impostazione con Users Bit (pagina 86) nel 
menu TC/Media.

Visualizzazione dei dati temporali

Specificare il codice temporale da visualizzare 
mediante l’opzione TC Display (pagina 86) 
>Display Select del menu TC/Media.
Premendo un pulsante programmabile 
(pagina 49) a cui è assegnata la funzione 
DURATION/TC/U-BIT, è possibile visualizzare 
in sequenza il codice temporale, i bit utente e 
la durata.
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Commutazione entrata/uscita del codice 
temporale

Il selettore TC IN/OUT (pagina 4) consente 
di scegliere se il codice temporale deve essere 
ricevuto in entrata o emesso in uscita.
Per informazioni dettagliate, vedere pagina 
109.

Rivedere una registrazione (Rec 
Review)

È molto semplice rivedere sullo schermo 
l’ultimo clip registrato (revisione della 
registrazione).

[Nota]
La funzione Rec Review non è supportata se il formato 
video è stato modificato dopo la registrazione del clip.

Metodo di revisione della registrazione

Assegnare in anticipo la funzione Rec Review 
a uno dei pulsanti programmabili.
Mentre la registrazione è arrestata, premere 
il pulsante programmabile (pagina 49) a 
cui è assegnata la funzione Rec Review. La 
riproduzione dell’ultimo clip registrato si avvia.
Il clip viene riprodotto fino alla fine e il 
camcorder esce dalla funzione Rec Review e 
torna alla modalità di STBY (standby).

Per arrestare Rec Review

Premere il pulsante programmabile a cui è 
assegnata la funzione Rec Review oppure 
premere il pulsante CANCEL/BACK.

Impostazioni della revisione della 
registrazione

È possibile impostare la posizione di avvio 
della riproduzione su una delle seguenti 
opzioni tramite la voce Rec Review 
(pagina 94) del menu Technical.
ˎˎ Ultimi 3 secondi del clip
ˎˎ Ultimi 10 secondi del clip
ˎˎ Inizio del clip

[Informazione]
Per rivedere un determinato clip dopo aver registrato 
vari clip, premere il pulsante THUMBNAIL per visualizzare 
la schermata delle miniature, quindi selezionare il clip 
desiderato.
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Il camcorder consente di regolare lo zoom in 
base alle condizioni di ripresa.

Se è montato un obiettivo con zoom 
motorizzato, è possibile azionare lo 
zoom utilizzando la levetta dello zoom 
dell’impugnatura di telecomando o della 
maniglia. La velocità di zoom varia in base alla 
pressione applicata alla levetta.
Il camcorder è dotato di una funzione di zoom 
che utilizza una metodologia di elaborazione 
del segnale denominata Clear Image Zoom. 
Quando Clear Image Zoom è attivato, diventa 
possibile eseguire zoom anche con obiettivi a 
focale fissa. Questa funzione consente anche 
di estendere il campo di zoom oltre al campo 
ottico fisicamente disponibile su obiettivi con 
zoom motorizzato.
Il rapporto massimo di zoom offerto da Clear 
Image Zoom varia a seconda della risoluzione 
di registrazione.
ˎˎ Con risoluzione di registrazione QFHD/4K: 
1,5×
ˎˎ Con risoluzione di registrazione HD: 2×

Selezione del tipo di zoom

Selezionare il tipo di zoom mediante Zoom 
>Zoom Type (pagina 94) nel menu Technical 
del menu completo.
I tipi di zoom disponibili varieranno in base al 
tipo di obiettivo montato sul camcorder.

Obiettivo 
montato

Impostazione Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Obiettivo 
a focale 
fissa / 
zoom 
manuale

L’azionamento 
dello zoom 
tramite la levetta 
non è 
disponibile.

Clear Image 
Zoom è 
supportato.

Obiettivo 
montato

Impostazione Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Obiettivo  
con zoom 
motorizzato

Solo zoom ottico Sono disponibili 
sia zoom ottico 
che Clear Image 
Zoom.

[Note]
ˎˎ Clear Image Zoom non è disponibile nei casi descritti 

di seguito.
–– Quando S&Q Motion >Frame Rate (pagina 77) 

nel menu Shooting del menu completo ha un 
valore superiore a 60fps.

–– Quando Rec Format >Codec (pagina 78) nel 
menu Project del menu completo è impostato su 
RAW o su un’opzione che include RAW.

ˎˎ Se viene azionato il selettore SERVO/MANUAL 
dell’obiettivo, l’ingrandimento di Clear Image Zoom 
viene reimpostato su 1×. 
ˎˎ Mentre Clear Image Zoom è attivo, l’area di messa 

a fuoco è impostata su Wide e la messa a fuoco 
automatica con rilevamento del viso o degli occhi è 
disabilitata.

Impostazione dello zoom della 
maniglia

Lo zoom della maniglia può essere impostato 
mediante la voce Handle Zoom (pagina 94) 
nel menu Technical del menu completo.

Impostazione della direzione della 
ghiera dello zoom

Su alcuni obiettivi con innesto E-mount, è 
possibile invertire la direzione di rotazione 
della ghiera dello zoom.
La direzione di rotazione può essere 
selezionata mediante Lens >Zoom Ring 

Direction (pagina 95) nel menu Technical 
del menu completo.

Azionamento dello zoom
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Regolazione della messa a fuoco
Il camcorder consente di regolare la messa a 
fuoco automaticamente o manualmente in 
base alle condizioni di ripresa.

Regolazione manuale della messa 
a fuoco (Manual Focus)

Per regolare manualmente la messa a fuoco, 
spostare il selettore FOCUS (pagina 4) su 
“MAN”.
Questo consente di regolare la messa a fuoco 
manualmente secondo le condizioni di ripresa.
La messa a fuoco manuale è utile per le 
seguenti tipologie di soggetti:
ˎˎ Soggetti sull’altro lato di una finestra 
coperta di goccioline d’acqua
ˎˎ Soggetti con un basso contrasto rispetto 
allo sfondo
ˎˎ Soggetti più lontani in presenza di soggetti 
vicini

[Informazione]
Nei seguenti casi, è possibile utilizzare la funzione 
di messa a fuoco automatica anche se viene 
principalmente utilizzata la messa a fuoco manuale.
ˎˎ Quando la sensibilità al cambiamento del soggetto AF 

è impostata su 1(Locked)
ˎˎ Quando il selettore FOCUS si trova sulla posizione “AF”
ˎˎ Ruotando la ghiera della messa a fuoco (AF Assist, 

pagina 40)

Regolazione automatica della 
messa a fuoco (Auto Focus)

Il camcorder utilizza un sistema di messa a 
fuoco tramite rilevamento di fase per la messa 
a fuoco automatica ad alta velocità e tramite 
contrasto per la messa a fuoco di precisione.
La combinazione di questi due metodi di 
messa a fuoco automatica consente di 
ottenere contemporaneamente rapidità e 
precisione.
Per regolare automaticamente la messa a 
fuoco, spostare su “AUTO” il selettore FOCUS 
del camcorder (pagina 4). Se l’obiettivo 
è dotato di un selettore di messa a fuoco, 
spostarlo nella posizione “AF/MF” o “AF”. Se 
il selettore si trova nelle posizioni “Full MF” 
o “MF” non è possibile eseguire la messa a 
fuoco dal camcorder (pagina 23).

[Informazione]
Quando Focus >AF Assist (pagina 77) nel menu 
Shooting del menu completo è impostato su On, rimane 
possibile eseguire la regolazione della messa a fuoco 
tramite la ghiera di messa a fuoco dell’obiettivo anche 
durante la messa a fuoco automatica.

[Note]
ˎˎ È necessario che sia montato un obiettivo che 

supporta la funzione di messa a fuoco automatica.
ˎˎ In base alle condizioni di ripresa potrebbe non essere 

possibile ottenere la massima precisione.
ˎˎ Non è possibile regolare automaticamente la messa a 

fuoco su un obiettivo con innesto A-mount.

Impostazione della zona di messa a 
fuoco automatica e della sua posizione 
(Focus Area)

È possibile impostare la zona di rilevamento 
per la messa a fuoco automatica mediante 
la voce Focus >Focus Area (pagina 77) nel 
menu Shooting del menu completo.

Flexible Spot:
Mette a fuoco una posizione specificata 
dell’immagine.
Quando è selezionata questa opzione, 
specificare la posizione utilizzando il selettore 
multiplo (pagina 7).
Per tornare alla posizione centrale, premere e 
mantenere premuto il selettore multiplo.

Zone:
Cerca automaticamente una posizione 
di messa a fuoco all’interno della zona 
specificata.
Quando è selezionata questa opzione, 
specificare la posizione utilizzando il selettore 
multiplo (pagina 7).
Per tornare alla posizione centrale, premere e 
mantenere premuto il selettore multiplo.

Wide:
Cerca il soggetto su un ampio angolo 
dell’immagine durante la messa a fuoco. Non 
viene visualizzato nessun riquadro.

[Informazione]
La stessa operazione è eseguibile anche mediante un 
pulsante programmabile (pagina 49) a cui è stata 
assegnata la funzione Focus Area.
È possibile scegliere se visualizzare o meno il riquadro 
dell’area di messa a fuoco mediante l’opzione Display 
On/Off >Focus Area Indicator (pagina 88) nel menu 
Monitoring del menu completo.

[Note]
ˎˎ Il riquadro dell’area di messa a fuoco è sempre visibile 

quando si utilizza il pulsante DISPLAY.
ˎˎ L’area di messa a fuoco è impostata su Wide durante 

Clear Image Zoom.

Modifica rapida della zona di messa a 
fuoco (Focus Setting)

È possibile modificare rapidamente la 
posizione e le dimensioni della zona di 
messa a fuoco automatica durante le riprese 
assegnando Focus Setting a un pulsante 
programmabile (pagina 49).
L’operazione varia a seconda 
dell’impostazione della zona di messa a fuoco.

Quando Focus >Focus Area (pagina 77) nel 
menu Shooting del menu completo è 
impostata su Flexible Spot o Zone
Per spostare l’area di messa a fuoco, 
premere il pulsante programmabile a cui è 
stata assegnata la funzione Focus Setting 
e regolarne le dimensioni con il selettore 
multiplo (pagina 7).
Per riportare l’area di messa a fuoco sulla sua 
posizione centrale durante la regolazione della 
posizione, premere il selettore multiplo.
Per modificare le dimensioni della zona di 
messa a fuoco, premere e mantenere premuto 
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il pulsante programmabile a cui è stata 
assegnata la funzione Focus Setting.
Dopo averne impostato le dimensioni, 
spostare l’area di messa a fuoco sulla 
posizione desiderata premendo il selettore 
multiplo.
Al termine, premere il pulsante programmabile 
a cui è stata assegnata la funzione Focus 
Setting per tornare alla schermata iniziale.

Quando Focus >Focus Area (pagina 77) nel 
menu Shooting del menu completo è 
impostata su Wide
È possibile modificare solamente le 
dimensioni della zona di messa a fuoco 
premendo e mantenendo premuto il pulsante 
programmabile a cui è stata assegnata la 
funzione Focus Setting. Prima di poterne 
spostare la posizione, è necessario impostare 
il tipo su Flexible Spot o Zone.

[Informazioni]
ˎˎ Impostando Focus >Push AF Mode (pagina 77)

nel menu Shooting del menu completo su Single-
shot AF(AF-S) e spostando il selettore FOCUS 
(pagina 4) sulla posizione MF, è possibile 
cambiare la posizione dell’area di messa a fuoco 
Focus Area(AF-S) (pagina 77).
ˎˎ Durante l’uso della funzione Clear Image Zoom, 

l’impostazione delle dimensioni dell’area di messa 
a fuoco rimane disabilitata e la funzione di messa a 
fuoco automatica viene attivata con priorità al centro.
ˎˎ Quando è possibile spostare la posizione dell’area 

di messa a fuoco, il relativo riquadro è visualizzato in 
arancione.

Spostamento del riquadro dell’area di 
messa a fuoco tramite touchscreen (area 
di messa a fuoco Touch)

Per spostare la posizione dell’area di messa 
a fuoco, premere il pulsante programmabile 
(pagina 49) a cui è assegnato Focus Setting 
per visualizzarne il riquadro in arancione, 
quindi spostarla con il touchscreen.

Toccare lo schermo per spostare l’area di 
messa a fuoco, centrandola sul punto che 
è stato toccato. Trascinare l’area di messa a 
fuoco con il dito per spostarla nella posizione 
desiderata sullo schermo (pagina 10).

[Informazione]
È possibile abilitare e disabilitare l’uso del touchscreen 
per la messa a fuoco sulla schermata di ripresa 
utilizzando un pulsante programmabile a cui è 
assegnato Focus Setting.

Toccare un punto qualsiasi dello schermo

L’area di messa a fuoco si sposta 
centrandosi sulla posizione toccata.

Trascinare l’area di messa a fuoco con il dito 
per spostarla nella posizione desiderata sullo 
schermo.

[Note]
ˎˎ Se si tocca una posizione o si trascina l’area di messa 

a fuoco su una posizione al di fuori del campo 
disponibile impostato, l’area di messa a fuoco viene 
impostata sul bordo superiore, inferiore, sinistro o 
destro di tale campo.
ˎˎ Questa funzione non è disponibile nei casi descritti 

di seguito.
–– Quando Touch Operation (pagina 94) nel menu 

Technical del menu completo è impostata su Off
–– Quando l’area di messa a fuoco non è visualizzata 

oppure è visualizzata in grigio

Regolazione dell’azione di messa a 
fuoco automatica (Velocità di transizione 
AF, Sensibilità al cambiamento del 
soggetto AF)

Velocità di transizione AF
La voce Focus >AF Transition Speed 
(pagina 76) del menu Shooting del menu 
completo consente di impostare la velocità 
di azionamento del sistema di messa a 
fuoco automatica in caso di movimento del 
soggetto.
Se impostata su una velocità più bassa, 
quando il soggetto messo a fuoco si sposta, 
la messa a fuoco segue il soggetto in maniera 
più graduale, consentendo la ripresa di 
immagini di grande impatto.
Se impostata su una velocità più alta, la messa 
a fuoco seleziona il soggetto più rapidamente. 
Questa impostazione è ideale per la ripresa 
di documentari che richiedono una rapida 
messa a fuoco in quanto il soggetto viene 
immediatamente messo a fuoco non appena 
entra nel campo di ripresa.
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Durante il cambiamento:
1(Slow): Il cambiamento della 
messa a fuoco avviene 
lentamente
.
.
.
7(Fast): Il cambiamento della 
messa a fuoco avviene 
rapidamente

È a fuoco il soggetto più lontano

È a fuoco il soggetto più vicino

Sensibilità al cambiamento del soggetto AF
È possibile impostare la sensibilità al 
cambiamento del soggetto mediante la voce 
Focus >AF Subj. Shift Sens. (pagina 76) nel 
menu Shooting del menu completo.
Se impostata su una sensibilità più bassa, la 
messa a fuoco non cambia immediatamente 
anche se un altro soggetto si dovesse spostare 
di fronte al soggetto originariamente messo a 
fuoco. Se impostata su una sensibilità più alta, 
la messa a fuoco cambia immediatamente per 
dare la precedenza al soggetto che si sposta 
di fronte.

[Informazione]
Se AF Speed/Sens. è assegnata a un pulsante 
programmabile, le barre di livello per la regolazione dei 
valori vengono visualizzate nel seguente ordine ad ogni 
pressione del pulsante, consentendo di modificare le 
impostazioni di velocità di transizione AF e di sensibilità 
al cambiamento del soggetto AF:
Velocità di transizione AF  Sensibilità al cambiamento 
del soggetto AF  Nessuna indicazione …

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

La messa a fuoco del nuovo soggetto 
avviene lentamente

La messa a fuoco del nuovo soggetto 
avviene rapidamente
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Selezione manuale del soggetto 
della messa a fuoco (AF Assist)

Quando Focus >AF Assist (pagina 75) nel menu 
Shooting del menu completo è impostato su 
On, rimane possibile mettere manualmente 
a fuoco un soggetto ruotando la ghiera di 
messa a fuoco dell’obiettivo anche durante la 
messa a fuoco automatica. 
Dopo aver completato la messa a fuoco del 
soggetto con la ghiera di  messa a fuoco 
dell’obiettivo, la funzione di messa a fuoco 
automatica continua a mantenere a fuoco il 
soggetto messo a fuoco manualmente (messa 
a fuoco automatica assistita).
Lo spostamento della messa a fuoco su un 
soggetto diverso dopo l’azionamento della 
ghiera di messa a fuoco sarà leggermente più 
difficile, indipendentemente dall’impostazione 
di Focus >AF Subj. Shift Sens. (pagina 76) 
nel menu Shooting del menu completo.
La messa a fuoco automatica assistita (AF 
Assist) viene annullata nei seguenti casi:
ˎˎ Quando il soggetto messo a fuoco con la 
ghiera di messa a fuoco dell’obiettivo non è 
più visibile.
ˎˎ Quando si passa alla messa a fuoco 
manuale.
ˎˎ Quando viene registrato un viso.

[Informazioni]
ˎˎ È possibile annullare rapidamente la messa a fuoco 

automatica assistita anche premendo un pulsante 
programmabile (pagina 49) a cui sono assegnate le 
funzioni Push AF o Push MF.
ˎˎ L’azionamento della ghiera di messa a fuoco annulla 

la selezione del viso registrato.
ˎˎ In modalità Face/Eye Only AF, la messa a fuoco 

automatica mette a fuoco il viso più vicino alla 
posizione di messa a fuoco della ghiera di messa a 
fuoco.

Messa a fuoco manuale 
temporanea (Push Manual Focus)

Premere il pulsante PUSH AUTO FOCUS 
(pagina 4) mentre è attiva la modalità di 
messa a fuoco automatica per eseguire la 
messa a fuoco manuale.
La messa a fuoco ritorna alla modalità 
automatica non appena si rilascia il pulsante.
Questo consente di interrompere 
momentaneamente la messa a fuoco 
automatica ed eseguire la messa a fuoco 
manuale quando un elemento che non è il 
soggetto della ripresa attraversa il campo 
di visuale della ripresa davanti al soggetto 
desiderato.

[Informazione]
La stessa operazione è eseguibile anche mediante un 
pulsante programmabile (pagina 49) a cui è stata 
assegnata la funzione Push AF/Push MF.

Utilizzo della funzione di messa a 
fuoco automatica temporanea 
(Push Auto Focus)

Quando la voce Focus >Push AF Mode 
(pagina 77) del menu Shooting del menu 
completo è impostata su AF, premere il 
pulsante PUSH AUTO FOCUS (pagina 4) 
mentre è attiva la modalità di messa a fuoco 
manuale per eseguire la messa a fuoco 
automatica.
La messa a fuoco avviene nell’area di messa 
a fuoco impostata tramite Focus >Focus Area 
(pagina 77) nel menu Shooting del menu 
completo.
La messa a fuoco ritorna alla modalità 
manuale non appena si rilascia il pulsante.
Questa funzione è utile quando si desidera 
spostare lentamente la messa a fuoco da un 
soggetto a un altro durante la messa a fuoco 
automatica.

[Informazione]
La stessa operazione è eseguibile anche mediante un 
pulsante programmabile (pagina 49) a cui è stata 
assegnata la funzione Push AF/Push MF.

[Nota]
La funzione Push Auto Focus non è attiva se l’obiettivo è 
impostato per la messa a fuoco manuale.

Utilizzo della funzione Single-Shot 
Auto Focus (Push Auto Focus (AF-S))

Impostare Focus >Push AF Mode 
(pagina 77) nel menu Shooting del menu 
completo su Single-shot AF(AF-S), quindi 
impostare l’area di messa a fuoco con Focus 
>Focus Area(AF-S) (pagina 77) nel menu 
Shooting.
Premere il pulsante PUSH AUTO FOCUS mentre 
è attiva la modalità di messa a fuoco manuale 
per eseguire rapidamente la messa a fuoco 
automatica. La messa a fuoco si arresta al 
rilascio del pulsante.
Lo stato della messa a fuoco è segnalato 
dall’indicatore della messa a fuoco.
ˎˎ On: La messa a fuoco è fissa nella posizione 
di messa a fuoco.
ˎˎ Lampeggiante: Soggetto non a fuoco. Dato 
che la messa a fuoco non è automatica, 
cambiare la composizione e le impostazioni 
di messa a fuoco per mettere a fuoco il 
soggetto.

La messa a fuoco ritorna alla modalità 
manuale non appena si rilascia il pulsante.
Questa capacità è utile quando si desidera 
mettere a fuoco rapidamente il soggetto 
prima di avviare la ripresa.

[Informazioni]
ˎˎ La stessa operazione è eseguibile anche mediante un 

pulsante programmabile (pagina 49) a cui è stata 
assegnata la funzione Push AF/Push MF.
ˎˎ La modalità Push AF Mode può essere assegnata 

anche a un pulsante programmabile (pagina 49).
ˎˎ La funzione Focus Area(AF-S) può anche essere 

assegnata a un pulsante programmabile 
(pagina 49).
ˎˎ È possibile scegliere se visualizzare o meno il riquadro 

dell’area di messa a fuoco mediante l’opzione Display 
On/Off >Focus Area Ind.(AF-S) (pagina 88) del 
menu Monitoring del menu completo.
ˎˎ Durante l’ingrandimento della messa a fuoco, 

la messa a fuoco si adatta alla posizione di 
visualizzazione ingrandita.
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[Note]
ˎˎ La funzione Push Auto Focus non è attiva se 

l’obiettivo è impostato per la messa a fuoco manuale.
ˎˎ Il riquadro dell’area di messa a fuoco è sempre visibile 

quando si utilizza il pulsante DISPLAY.

Messa a fuoco con vista ingrandita 
(Focus Magnifier)

Per impostazione predefinita, la funzione 
Focus Magnifier ×3/×6 è assegnata al pulsante 
ASSIGN 4 dell’impugnatura di telecomando 
e al pulsante ASSIGN 7 della maniglia 
(pagina 49).
Premere il pulsante ASSIGN 4 oppure il 
pulsante ASSIGN 7 per attivare la funzione 
Focus Magnifier del mirino ed ingrandire 
il centro dell’immagine di tre volte circa. 
Premere nuovamente il pulsante per 
aumentare l’ingrandimento a sei volte circa. 
Questa funzione è utile per controllare la 
messa a fuoco.
Premere nuovamente il pulsante per tornare 
alla schermata normale.
Durante l’ingrandimento della messa a 
fuoco, è possibile spostare la zona ingrandita 
utilizzando il selettore multiplo (pagina 7). 
Premere il selettore multiplo per tornare al 
centro dell’immagine.
Se viene utilizzata la funzione Push Auto Focus 
(AF) durante l’ingrandimento della messa a 
fuoco, la messa a fuoco avviene all’interno 
dell’area di messa a fuoco impostata tramite 
Focus >Focus Area (pagina 77) nel menu 
Shooting del menu completo.
Se viene utilizzata la funzione Push Auto 
Focus (AF-S) durante l’ingrandimento della 
messa a fuoco, la messa a fuoco si adatta alla 
posizione di visualizzazione ingrandita.

[Note]
ˎˎ L’ingrandimento della messa a fuoco non ingrandisce 

l’immagine registrata né l’immagine fornita sull’uscita 
SDI/HDMI.
ˎˎ Durante l’ingrandimento della messa a fuoco, il 

pulsante MENU non è attivo e sono disabilitate anche 
altre funzionalità.
ˎˎ Allo spegnimento del camcorder, il riquadro 

ingrandito torna al centro dello schermo.

Messa a fuoco con la funzione di 
rilevamento del viso e degli occhi 
(Face/Eye Detection AF)

Il camcorder è in grado di individuare e 
mettere a fuoco automaticamente il viso e 
gli occhi dei soggetti all’interno dell’area di 
messa a fuoco.
Questa funzione è disponibile solo quando la 
regolazione della messa a fuoco è in modalità 
AF o durante Push Auto Focus.
Quando vengono rilevati visi, lo schermo 
mostra riquadri di rilevamento del viso e degli 
occhi di colore grigio. Se la messa a fuoco 
automatica è possibile, i riquadri diventano di 
colore bianco. Quando vengono rilevati occhi 
e viene eseguita la messa a fuoco, il riquadro 
di rilevamento di viso e occhi appare sugli 
occhi del soggetto. Se vengono rilevate più 
persone, il soggetto principale è determinato 
automaticamente.

[Informazioni]
ˎˎ Quando la zona di messa a fuoco è impostata su 

Zone o Flexible Spot e, nella zona di messa a fuoco 
specificata, si sovrappongono visi o occhi, i riquadri 
di rilevamento viso/occhi sono visualizzati in colore 
bianco e il camcorder mette a fuoco i visi e gli occhi 
contenuti in tali riquadri.
ˎˎ Quando viene utilizzato Push Auto Focus (AF-S), i 

riquadri di rilevamento viso/occhi dei visi e degli 
occhi messi a fuoco sono visualizzati in verde.

Impostare l’azione di messa a fuoco 
automatica con rilevamento viso o degli occhi 
desiderata tramite Focus >Face/Eye Detection 
AF (pagina 77) nel menu Shooting.

Face/Eye Only AF:
Il camcorder rileva il viso e gli occhi dei 
soggetti (persone) e mette a fuoco solo 
tale viso o occhi. Finché il camcorder non 
rileva un viso o degli occhi, la funzione AF 
viene temporaneamente sospesa (MF) e 
l’icona di pausa di messa a fuoco automatica 
modalità Face/Eye Only AF  (pagina 11) 
appare sullo schermo. Questa modalità 
è efficace quando si desidera mantenere 
automaticamente a fuoco solo il viso e gli 
occhi del soggetto.

Face/Eye Priority AF:
Il camcorder rileva il viso o gli occhi dei 
soggetti (persone) e dà priorità alla messa a 
fuoco del viso o degli occhi. Se non vengono 
rilevati visi o occhi, la messa a fuoco avviene in 
modalità AF (impostazione predefinita).

Off:
La funzione di AF con rilevamento del viso o 
degli occhi è disabilitata.

[Note]
ˎˎ Mentre è attiva la funzione di Push Auto Focus, viene 

sempre attivata Face/Eye Priority AF, anche mentre è 
selezionata Face/Eye Only AF.
ˎˎ Quando il selettore FOCUS si trova in posizione MAN, 

la funzione di AF con rilevamento del viso o degli 
occhi è disabilitata (eccetto durante Push Auto Focus).
ˎˎ Se si spegne il camcorder mentre è selezionata 

Face/Eye Only AF, alla successiva riaccensione verrà 
automaticamente ripristinata la modalità Face/Eye 
Priority AF.
ˎˎ La funzione di messa a fuoco automatica con 

rilevamento del viso o degli occhi non è supportata 
durante Clear Image Zoom. È attiva la normale messa 
a fuoco automatica.

Nascondere i riquadri di rilevamento del 
viso o degli occhi

È possibile scegliere se visualizzare o meno 
i riquadri di rilevamento del viso o degli 
occhi con la voce Display On/Off >Face/Eye 
Detection Frame (pagina 88) del menu 
Monitoring del menu completo.

[Nota]
I visi e gli occhi messi a fuoco con la funzione Push Auto 
Focus (AF-S) sono identificati mediante riquadri verdi, a 
meno che tali riquadri non siano stati disattivati con il 
pulsante DISPLAY oppure l’opzione Face/Eye Detection 
Frame sia impostata su Off.

Messa a fuoco su un viso registrato

Mentre è attiva la funzione AF con rilevamento 
del viso o degli occhi, è possibile registrare in 
memoria il viso di una persona specifica per 
mantenerlo a fuoco.
È possibile registrare un solo viso. La 
registrazione di un viso sovrascrive l’eventuale 
registrazione precedente.
Se è presente un viso registrato in memoria, il 
riquadro di rilevamento del viso o degli occhi 
appare con una doppia cornice (riquadro viso 
registrato) e viene visualizzata l’icona del viso 
registrato  (pagina 11).
Nella modalità AF con rilevamento del viso o 
degli occhi, avranno luogo le azioni descritte 
di seguito in base alla combinazione fra viso 
registrato in memoria e modalità operativa 
della funzione AF con rilevamento del viso o 
degli occhi.

In modalità Face/Eye Priority AF:
Se il camcorder rileva un viso registrato in 
memoria, lo mette a fuoco. Se non viene 
rilevato nessun viso registrato in memoria, la 
funzione di rilevamento del viso o degli occhi 
continua.
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In modalità Face/Eye Only AF:
Se il camcorder rileva solo il viso registrato 
in memoria, metterà a fuoco tale viso o i 
suoi occhi. Finché non viene rilevato il viso 
registrato in memoria, la funzione AF è 
temporaneamente sospesa (MF) ed appare 
sullo schermo l’icona di pausa della messa 
a fuoco automatica modalità Face/Eye 
Only AF  (pagina 11). Questa modalità 
è efficace quando si desidera mantenere 
automaticamente a fuoco solo la persona 
specifica registrata in memoria.

Impostazione del viso registrato
Spostare il cursore di selezione del viso 
(sottolineatura arancione) sul viso da registrare 
in memoria utilizzando il selettore multiplo 
(pagina 7), quindi premere il selettore 
multiplo.

Altri riquadri di rilevamento del viso 
o degli occhi (grigi)

Riquadro del 
viso registrato 
(doppia 
cornice 
bianca)

Cursore di selezione del viso (arancione)

Annullamento della registrazione del viso
Spostare il cursore di selezione del viso sul 
riquadro del viso registrato utilizzando il 
selettore multiplo (pagina 7), quindi 
premere il selettore multiplo.
Il viso registrato viene eliminato dalla 
memoria, la cornice di rilevamento viso/occhi 
scompare e viene sostituita da una cornice 
singola, mentre l’icona del viso registrato 
scompare.
Se, durante il rilevamento dei visi o degli occhi, 
appare il cursore arancione di selezione del 
viso, ma il riquadro di identificazione del viso 
registrato non è presente, è possibile annullare 

la registrazione del viso premendo due volte il 
selettore multiplo.
[Note]
ˎˎ La messa a fuoco automatica assistita (pagina 40) 

annulla la selezione del viso registrato.
ˎˎ Non è possibile utilizzare la funzione di messa a fuoco 

automatica con rilevamento del viso o degli occhi 
mentre è attivo Clear Image Zoom.
ˎˎ In certe condizioni dell’ambiente di registrazione, del 

soggetto o delle impostazioni, il rilevamento del viso 
o degli occhi potrebbe non essere possibile.
ˎˎ In certi ambienti di registrazione, potrebbe non 

essere possibile ottenere il risultato corretto, oppure 
potrebbero essere rilevati come visi oggetti diversi. In 
tal caso, impostare la funzione di rilevamento del viso 
o degli occhi AF su Off.
ˎˎ È consigliabile registrare il viso del soggetto 

desiderato prima dell’inizio della ripresa.
ˎˎ Alcune condizioni (acconciature, trucco) – o se il 

viso non è direttamente rivolto verso il camcorder 
– potrebbero impedire la corretta registrazione del 
viso. In tal caso, anche se la cornice di rilevamento del 
viso o degli occhi è doppia, l’icona del viso registrato 
in memoria non è visualizzata e il viso non viene 
registrato.
ˎˎ Se è già stato registrato un viso, è consigliabile 

annullare tale registrazione prima di procedere alla 
registrazione di un nuovo viso.

Selezione della modalità AF con 
rilevamento del viso o degli occhi 
tramite un pulsante programmabile

Assegnare Face/Eye Detection AF a un 
pulsante programmabile (pagina 49). 
Premendo ripetutamente tale pulsante, 
diventa possibile passare in sequenza da 
una modalità AF con rilevamento del viso o 
degli occhi all’altra, passando da Face/Eye 
Priority AF, a Face/Eye Only AF, a Off, quindi 
nuovamente a Face/Eye Priority AF, ecc.

Impostazione con Direct Menu

La modalità operativa AF con rilevamento 
del viso o degli occhi può essere selezionata 
anche con Direct Menu (pagina 49).
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Regolazione della luminosità

B

C
D
E

F
H

I

A

È possibile regolare la luminosità variando 
opportunamente i valori di diaframma, 
guadagno, velocità dell’otturatore, nonché 
regolando il livello di luce mediante i filtri ND. 
È anche possibile effettuare tali regolazioni 
automaticamente.
Il livello ottimale di regolazione automatica 
della luminosità può essere impostato 
mediante l’opzione Auto Exposure 
(pagina 74) >Level del menu Shooting del 
menu completo. La funzione Auto Exposure 
Level può essere assegnata anche a un 
pulsante o una manopola programmabile 
(pagina 49).

[Nota]
Il guadagno non è regolabile in modalità Cine EI. 
La sensibilità di base è fissa. Inoltre, non è possibile 
regolare automaticamente la luminosità mediante 
la velocità dell’otturatore. È supportata invece la 
regolazione automatica della luminosità tramite 
diaframma e filtro ND.

Selezione della sensibilità di base 
(Base Sensitivity)

Il camcorder utilizza due tipologie di 
sensibilità di base.
Nella modalità Custom, è possibile impostare 
la sensibilità di base su High o Low mediante 
Base ISO/Sensitivity nella schermata Main 
Status (pagina 13) o nella schermata 
Camera Status (pagina 14) oppure 
con la voce ISO/Gain/EI >Base Sensitivity 
(pagina 73) nel menu Shooting del menu 
completo. 
Nella modalità Cine EI, è possibile impostare 
il valore ISO di base su ISO 12800 o ISO 
800 mediante Base ISO/Sensitivity nella 
schermata Main Status (pagina 13) o nella 
schermata Camera Status (pagina 14) 
oppure mediante ISO/Gain/EI >Base ISO 
(pagina 73) nel menu Shooting del menu 
completo.
Si consiglia di selezionare Low o ISO 800 in 
condizioni di illuminazione normali oppure 
High o ISO 12800 in condizioni di scarsa 
illuminazione.

*	 Configurabile anche nella schermata di stato.

[Informazione]
Le funzioni Base ISO e Base Sensitivity possono 
essere assegnate anche a un pulsante programmabile 
(pagina 49).

Regolazione del diaframma

È possibile regolare la luminosità regolando il 
diaframma.

Regolazione automatica del diaframma

Questa funzione regola la luminosità in base 
al soggetto. È necessario che sia montato 

un obiettivo che supporta la funzione di 
regolazione automatica del diaframma.

1	 Se è montato un obiettivo con selettore 
Auto Iris, impostarlo su AUTO.

2	 Mantenere premuto il pulsante funzione 
IRIS (E) per visualizzare il Direct Menu 
(pagina 49), quindi selezionare Auto.

	 [Informazione]
La funzione Auto Iris può essere assegnata anche a 
un pulsante programmabile (pagina 49).

	 [Nota]
Il diaframma non può essere regolato 
automaticamente su un obiettivo con innesto 
A-mount.

Regolazione manuale del diaframma

1	 Mantenere premuto il pulsante funzione 
IRIS (E) per visualizzare il Direct Menu 
(pagina 49), quindi selezionare Manual.

2	 Premere il pulsante funzione IRIS (E) per 
visualizzare il valore del diaframma su uno 
sfondo bianco.

3	 Ruotare la manopola multifunzione per 
regolare il valore.

	 [Informazioni]
ˎˎ Se si desidera, è possibile utilizzare la 

manopola multifunzione come manopola IRIS 
di regolazione del diaframma (pagina 49) 
assegnando ad essa la funzione IRIS.
ˎˎ È possibile anche assegnare la funzione IRIS a 

una manopola programmabile (pagina 49).

Regolazione automatica temporanea

Premendo il pulsante programmabile 
(pagina 49) a cui è assegnata la funzione 
Push Auto Iris, il camcorder esegue la 
regolazione automatica del diaframma mentre 
il pulsante rimane premuto.

Il diaframma ritorna all’impostazione 
precedente non appena si rilascia il pulsante.

[Nota]
Se il selettore Auto Iris dell’obiettivo è impostato su 
MANUAL, le funzioni Auto Iris e Push Auto Iris del 
camcorder non hanno effetto. Non hanno effetto 
nemmeno le regolazioni manuali del diaframma sul 
camcorder.

Regolazione del guadagno

In modalità Custom è possibile regolare la 
luminosità regolando il guadagno.

Regolazione automatica del guadagno

Mantenere premuto il pulsante funzione 
ISO/GAIN (H) per visualizzare il Direct Menu 
(pagina 49), quindi selezionare Auto.

[Informazioni]
ˎˎ È possibile ottenere lo stesso risultato impostando 

Auto Exposure (pagina 74) >AGC nel menu 
Shooting su On.
ˎˎ La funzione AGC può essere assegnata anche a un 

pulsante programmabile (pagina 49).

Regolazione manuale del guadagno

La regolazione del guadagno è utile per 
regolare l’esposizione mentre si utilizza 
un valore di diaframma fisso oppure se si 
desidera evitare l’aumento del guadagno 
generato dalla funzione AGC.

1	 Mantenere premuto il pulsante funzione 
ISO/GAIN (H) per visualizzare il Direct 
Menu (pagina 49), quindi selezionare 
Manual.

2	 Spostare il selettore ISO/GAIN (I) su H, M o L.
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[Informazioni]
ˎˎ È possibile anche assegnare la funzione Push AGC 

a un pulsante programmabile per attivare AGC 
momentaneamente mantenendo premuto tale 
pulsante.
ˎˎ È possibile modificare il valore preimpostato 

delle varie posizioni del selettore mediante ISO / 
Gain<L>/<M>/<H> (pagina 14) nella schermata 
Camera Status o mediante ISO/Gain/EI >ISO/
Gain<H>/<M>/<L> (pagina 73) nel menu Shooting 
del menu completo.

Regolazione fine del guadagno

1	 Premere il pulsante funzione ISO/GAIN (H) 
per visualizzare il valore del guadagno su 
uno sfondo bianco.

2	 Ruotare la manopola multifunzione per 
regolare il valore.

[Informazione]
Impostare il valore di preset del guadagno in base alla 
posizione del selettore ISO/GAIN (I).

Regolazione temporanea fine del 
guadagno

Ruotare la manopola programmabile 
(pagina 49) a cui è assegnata la funzione 
ISO/Gain/EI per regolare il valore di guadagno 
impostato dal selettore ISO/GAIN (I).
Questa funzione è utile se si desidera 
correggere l’esposizione di un passo senza 
tuttavia modificare la profondità di campo.
Il valore di guadagno impostato viene 
annullato spostando di nuovo il selettore ISO/
GAIN (I), cambiando la sensibilità di base, 
impostando su On la funzione AGC oppure 
spegnendo il camcorder.

[Informazioni]
ˎˎ Questa funzione può essere assegnata anche alla 

manopola multifunzione (pagina 49).
ˎˎ È possibile anche assegnare la funzione Push AGC 

a un pulsante programmabile per attivare AGC 
momentaneamente mantenendo premuto tale 
pulsante.

Regolazione automatica 
dell’indice di esposizione 
(Exposure Index)

Nella modalità Cine EI, si presuppone il 
video in uscita con MLUT impostato su 
Off sia registrato come segnale principale. 
Modificando la luminosità dell’immagine 
con MLUT On in modo che corrisponda a un 
valore EI, è possibile controllare il risultato 
della regolazione della sensibilità in post 
produzione durante le riprese.
È possibile modificare il valore EI spostando il 
selettore ISO/GAIN (I) su H, M o L.

[Informazione]
È possibile modificare il valore EI delle varie posizioni 
del selettore mediante ISO/Gain/EI (pagina 14) nella 
schermata Camera Status o mediante ISO/Gain/EI 
>Exposure Index<H>/<M>/<L> (pagina 73) nel menu 
Shooting del menu completo.

Regolazione fine dell’indice di 
esposizione

1	 Premere il pulsante funzione ISO/GAIN (H) 
per visualizzare il valore EI su uno sfondo 
bianco.

2	 Ruotare la manopola multifunzione per 
regolare il valore.

[Informazione]
Impostare il valore EI di preset in base alla posizione del 
selettore ISO/GAIN (I).

Regolazione dell’otturatore

È possibile regolare la luminosità regolando 
l’otturatore.

Regolazione automatica dell’otturatore

Mantenere premuto il pulsante funzione 
SHUTTER (F) per visualizzare il Direct Menu 
(pagina 49), quindi selezionare Auto 
per regolare automaticamente la velocità 
o l’angolo dell’otturatore in risposta alla 
luminosità dell’immagine.

[Informazione]
È possibile ottenere lo stesso risultato impostando su On 
la voce Auto Exposure >Auto Shutter (pagina 75) del 
menu Shooting nel menu completo.

Regolazione manuale dell’otturatore

1	 Mantenere premuto il pulsante funzione 
SHUTTER (F) per visualizzare il Direct Menu 
(pagina 49), quindi selezionare Speed o 
Angle.

2	 Premere il pulsante funzione SHUTTER (F) 
per visualizzare il valore dell’otturatore su 
uno sfondo bianco.

3	 Ruotare la manopola multifunzione per 
regolare la velocità dell’otturatore.

[Informazioni]
ˎˎ Per regolare il tempo di esposizione in modo che 

corrisponda all’intervallo fotogrammi, selezionare Off 
al passo 1.
ˎˎ È anche possibile impostare l’angolazione e regolare 

la frequenza (pagina 73).

Regolazione del livello di luce 
(filtro ND)

In condizioni di illuminazione troppo intensa, 
è possibile ottenere la luminosità corretta 
utilizzando un filtro ND.
Il camcorder offre due modalità di filtro ND. 
Per passare da una modalità all’altra, utilizzare 
il selettore ND PRESET/VARIABLE.

Regolazione in modalità Preset

Spostare il selettore ND PRESET/VARIABLE 
(A) sulla posizione PRESET e quindi utilizzare 
i pulsanti su/giù ND FILTER POSITION (B) per 
configurare una delle impostazioni indicate di 
seguito.
Clear: Nessun filtro ND
1: Trasmittanza specificata da ND Filter 
>Preset1 (pagina 73) nel menu Shooting del 
menu completo.
2: Trasmittanza specificata da ND Filter 
>Preset2 (pagina 73) nel menu Shooting del 
menu completo.
3: Trasmittanza specificata da ND Filter 
>Preset3 (pagina 73) nel menu Shooting del 
menu completo.

Regolazione in modalità variabile

Spostare il selettore ND PRESET/VARIABLE (A) 
sulla posizione VARIABLE. Usando i pulsanti 
su/giù ND FILTER POSITION (B) passare da 
CLEAR a On.

Regolazione automatica del livello di luce
Attivando la funzione Auto ND Filter 
viene abilitata la regolazione automatica 
dell’esposizione mediante il filtro ND.

1	 Premere il pulsante [+] dei pulsanti su/giù 
ND FILTER POSITION (B) per attivare il filtro 
ND.
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2	 Mantenere premuto il pulsante ND 
VARIABLE AUTO (C) fino a selezionare 
Auto.

Regolazione manuale del livello di luce

1	 Premere il pulsante [+] dei pulsanti su/giù 
ND FILTER POSITION (B) per attivare il filtro 
ND.

2	 Mantenere premuto il pulsante ND 
VARIABLE AUTO (C) fino a selezionare 
Manual.

3	 Utilizzare la manopola ND VARIABLE (D) 
per regolare la trasmittanza del filtro.

[Informazione]
La funzione ND Filter può essere assegnata anche a una 
manopola programmabile (pagina 49).

Regolazione automatica temporanea
È possibile anche assegnare Push Auto ND a 
un pulsante programmabile (pagina 49) per 
attivare momentaneamente la funzione Auto 
ND Filter mantenendo premuto tale pulsante. 
Al rilascio del pulsante, la funzione Auto ND 
Filter viene nuovamente disattivata.
Premere il pulsante [+] dei pulsanti su/giù ND 
FILTER POSITION (B) per attivare il filtro ND.

[Nota]
Se il filtro ND entra o esce dalla posizione CLEAR durante 
la ripresa, il riquadro del filtro ND viene visualizzato 
sull’immagine e il suono generato dall’operazione viene 
catturato nell’audio.

[Informazioni]
ˎˎ È possibile impostare su CLEAR ruotando verso il 

basso la manopola ND VARIABLE (D) dalla posizione 
ND1/4. Ruotando verso l’alto la manopola dalla 
posizione CLEAR si imposta ND1/4. È possibile 
disabilitare questa azione mediante ND Dial >CLEAR 
with Dial (pagina 94) nel menu Technical del menu 
completo.
ˎˎ È possibile anche assegnare ND Filter Position a un 

pulsante programmabile (pagina 49) e premere 
tale pulsante invece di usare i pulsanti su/giù ND 
FILTER POSITION per modificare l’impostazione.  

Modalità Preset: Clear  Preset1  Preset2  
Preset3  Clear… 
Modalità Variable: Clear  On  Clear…
ˎˎ È possibile anche assegnare Auto ND Filter a un 

pulsante programmabile (pagina 49) per attivare e 
disattivare la funzione Auto ND Filter premendo tale 
pulsante.
ˎˎ Nella ripresa di soggetti fortemente illuminati, la 

chiusura eccessiva del diaframma può dar luogo a 
sfocature per diffrazione. Questo è un fenomeno 
tipico nelle videocamere. È possibile eliminare questo 
fenomeno ed ottenere risultati migliori utilizzando il 
filtro ND.
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È possibile selezionare la modalità di regolazione 
più adatta per le condizioni di ripresa.

Modalità ATW (bilanciamento 
automatico del bianco)

Questa funzione regola automaticamente il 
bilanciamento del bianco a un livello ottimale.
Il valore di bilanciamento del bianco viene 
automaticamente regolato quando cambia la 
temperatura di colore della sorgente luminosa.
Mantenere premuto il pulsante funzione 
WHT BAL (G) per visualizzare il Direct Menu 
(pagina 49), quindi selezionare ATW.
È possibile selezionare la velocità di 
regolazione (cinque livelli) con l’opzione White 
Setting >ATW Speed (pagina 76) del menu 
Shooting del menu completo.

[Informazione]
È possibile “congelare” il valore di bilanciamento del bianco 
corrente assegnando la funzione ATW Hold a un pulsante 
programmabile (pagina 49) e premendo tale pulsante 
per sospendere temporaneamente la modalità ATW.

[Note]
ˎˎ La funzione ATW non è utilizzabile in modalità Cine EI.
ˎˎ A seconda delle condizioni di illuminazione e del 

soggetto, la funzione ATW può non essere in grado di 
ottimizzare sempre il colore.  
Esempi:
–– Quando il soggetto è dominato da un unico colore, 

ad esempio cielo, mare, prati o fiori.
–– Quando la temperatura di colore è estremamente 

alta o bassa.
	 Se non è possibile ottenere l’effetto opportuno 

perché la velocità di regolazione automatica ATW è 
insufficiente o per altri motivi, eseguire la funzione di 
bilanciamento automatico del bianco.

Regolazione manuale del 
bilanciamento del bianco

1	 Quando il bilanciamento del bianco è 
impostato sulla modalità ATW, mantenere 
premuto il pulsante funzione WHT BAL (G) 
per visualizzare il Direct Menu 
(pagina 49) e quindi selezionare W:P, 
W:A o W:B.

2	 Selezionare B, A o PRESET con il selettore 
WHT BAL (J).
B: Modalità memoria B
A: Modalità memoria A
PRESET: Modalità preset

[Informazione]
Per abilitare ATW per la memoria B impostare su ATW 
l’opzione White Setting >White Switch<B> (pagina 76) 
nel menu Shooting del menu completo.

Modalità memoria A / memoria B
Questa modalità imposta il bilanciamento del 
bianco sul valore salvato rispettivamente nella 
memoria A o B.

Modalità Preset
Questa modalità regola la temperatura di 
colore su un valore preimpostato (valore 
predefinito: 3200K).

Modifica del valore di preset predefinito

In modalità Preset, è possibile impostare 
direttamente un valore di preset esistente.
Premere e mantenere premuto il pulsante 
WHT BAL (G) e selezionare una delle seguenti 
voci nel Direct Menu:
Modalità Custom:  3200K,  4300K, 

 5600K,  6300K
Modalità Cine EI:  3200K,  4300K,  

5500K

[Informazione]
È possibile anche assegnare Preset White Select a un 
pulsante programmabile (pagina 49) per modificare 
l’impostazione premendo tale pulsante.
Modalità Custom: 3200K  4300K  5600K  6300K  
 3200K…

Modalità Cine EI: 3200K  4300K  5500K  3200K…

Selezione della temperatura di colore

1	 Premere il pulsante funzione WHT BAL (G) 
per visualizzare il valore della temperatura 
di colore su sfondo bianco.

2	 Ruotare la manopola multifunzione per 
regolare il valore.

[Informazioni]
ˎˎ In modalità Preset è possibile impostare il valore in 

unità di 100K.
ˎˎ In modalità memoria è possibile impostare il valore 

in incrementi di 20K nel campo da 2000K a 5600K. 
Valori superiori a 5600K possono essere impostati a 
intervalli uguali alla quantità di variazione di colore (in 
mired) da 5580K a 5600K. È possibile anche regolare 
il tono di colore (Tint) mediante la voce White 
(pagina 75) >Tint nel menu Shooting del menu 
completo.

Esecuzione del bilanciamento 
automatico del bianco

Il bilanciamento del bianco da salvare nella 
modalità Memory A / Memory B viene 
configurato automaticamente.

1	 Selezionare la modalità Memory A o la 
modalità Memory B.

2	 Collocare un foglio o un altro oggetto 
bianco in una posizione con la stessa 
sorgente di luce e le stesse condizioni di 
illuminazione del soggetto, quindi 
zoomare sul foglio fino a riempire lo 
schermo di bianco.

3	 Regolare la luminosità.
Regolare il diaframma servendosi della 
procedura descritta in “Regolazione 
manuale del diaframma” (pagina 43).

4	 Premere il pulsante WB SET 
(pagina 4).
ˎˎ Se il bilanciamento automatico del 
bianco viene eseguito nella modalità di 
memoria, il valore di regolazione viene 
salvato nella memoria A o B selezionata 
al punto 1.
ˎˎ Se il bilanciamento automatico del 
bianco viene eseguito nella modalità 
ATW, la regolazione del bilanciamento 
del bianco torna alla modalità di 
bilanciamento del bianco ATW al 
termine della regolazione.

[Nota]
Se la regolazione non può essere eseguita 
correttamente, viene visualizzato un messaggio di errore 
sullo schermo per circa tre secondi. Se il messaggio 
di errore persiste anche dopo ripetuti tentativi di 
impostazione del bilanciamento del bianco, rivolgersi al 
servizio di assistenza tecnica Sony.

Come ottenere colori naturali (bilanciamento del bianco)
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È possibile specificare l’audio da registrare 
scegliendo opportunamente i connettori di 
ingresso e utilizzando i selettori e le manopole 
del camcorder.

Connettori e selettori di ingresso audio 
esterno

Connettore INPUT1 (pagina 7)
Connettore INPUT2 (pagina 7)
Slitta Multi-interface (pagina 7)
Selettore INPUT1 (LINE/MIC/MIC+48V) 
(pagina 7)
Selettore INPUT2 (LINE/MIC/MIC+48V) 
(pagina 7)

Selettori per l’impostazione del livello 
audio

Selettore CH1 (AUTO/MAN) (pagina 6)
Selettore CH2 (AUTO/MAN) (pagina 6)
Manopola AUDIO LEVEL (CH1) (pagina 6)
Manopola AUDIO LEVEL (CH2) (pagina 6)

Schermata Audio Status

Selezione del dispositivo di 
ingresso audio

1	 Impostare l’ingresso audio con CH1/CH2/
CH3/CH4 >Source (pagina 14) nella 
schermata Audio Status oppure con le 
opzioni da Audio Input >CH1 Input Select a 
Audio Input >CH4 Input Select 
(pagina 91) nel menu Audio del menu 
completo.
Se si utilizza un microfono con 
connessione a slitta, un adattatore XLR o 
un dispositivo UWP (microfono wireless 
UHF), specificare Shoe CH1 o Shoe CH2. 
Per informazioni dettagliate 
sull’adattatore XLR, vedere “Aggiunta di 
connettori di ingresso audio” 
(pagina 48).

	 [Note]
ˎˎ L’audio non viene registrato nelle modalità 

Interval Rec e Slow & Quick Motion.
ˎˎ Il camcorder è dotato di un microfono 

incorporato da narrazione per la registrazione 
dell’audio ambientale. Può essere utilizzato 
per la sincronizzazione dei tempi con altre 
apparecchiature. In tal caso, specificare Internal 
MIC.
ˎˎ Quando è montata la maniglia, viene attivato 

per la registrazione dell’audio solo il microfono 
interno (pagina 7) della maniglia. Se la 
maniglia non è montata, potrà essere utilizzato 
il microfono di narrazione (pagina 6) per la 
registrazione dell’audio ambientale.
ˎˎ Quando CH1 Input Select e CH2 Input Select sono 

impostati su Internal MIC, il livello di registrazione 
audio dei due canali CH1 e CH2 può essere 
regolato con la manopola AUDIO LEVEL(CH1) 
(pagina 6). Quando CH3 Input Select e CH4 
Input Select sono impostati su Internal MIC, il 
livello di registrazione audio dei due canali CH3 
e CH4 può essere regolato con la voce CH3 Input 
Level (pagina 91).

2	 Selezionare la sorgente di ingresso audio.
Impostare i selettori INPUT1/INPUT2 (LINE/
MIC/MIC+48V) in base ai dispositivi 
connessi rispettivamente ai connettori 
INPUT1/INPUT2.

Dispositivo collegato Posizione 
selettore

Sorgente audio esterna (ad 
es. mixer)

LINE

Microfono dinamico, 
microfono a batteria

MIC

Microfono con 
alimentazione phantom 
+48 V

MIC+48V

ˎˎ Se si seleziona MIC+48V, assicurarsi che 
il microfono connesso sia compatibile 
con una sorgente a +48V per evitare 
di danneggiarlo. Controllare questa 
impostazione prima di procedere con il 
collegamento.
ˎˎ Se è necessario limitare l’eventuale 
rumore sui connettori ai quali non è 
connesso nessun dispositivo, impostare 
su LINE i selettori INPUT1/INPUT2 (LINE/
MIC/MIC+48V) corrispondenti.

Regolazione automatica del livello 
di registrazione audio

Spostare su AUTO i selettori CH1/CH2 (AUTO/
MAN) dei canali da regolare automaticamente.
Per CH3 e CH4, impostare su Auto 
(pagina 91) il controllo di livello audio 
nella schermata Audio Status (pagina 14) 
o le voci Audio Input >CH3 Level Control e 
CH4 Level Control del menu Audio nel menu 
completo.

Regolazione manuale del livello di 
registrazione audio

La seguente procedura consente di regolare il 
livello di registrazione audio per i canali CH1/CH2.

1	 Spostare su MAN i selettori CH1/CH2 
(AUTO/MAN) dei canali da regolare 
manualmente.

2	 Durante la ripresa o lo standby, ruotare le 
manopole AUDIO LEVEL (CH1)/(CH2) per 
regolare il livello audio del canale 
corrispondente.
ˎˎ Per CH3/CH4, impostare su Manual il 
controllo di livello audio mediante CH3/
CH4 (pagina 14) nella schermata 
Audio Status oppure mediante la voce 
Audio Input >CH3 Level Control o CH4 
Level Control nel menu Audio del menu 
completo, quindi regolare il livello di 
registrazione audio utilizzando CH3 
Input Level o CH4 Input Level.
ˎˎ È possibile regolare i livelli dei canali 
da CH1 a CH4 collettivamente in 
gruppo. Il livello di registrazione può 
essere regolato con la manopola 
programmabile (pagina 49) 
assegnata alla funzione Audio Input 
Level, nella schermata Audio Status, 
oppure mediante Audio Input >Audio 
Input Level nel menu Audio del menu 
completo.

[Informazione]
La schermata Audio Status consente di controllare il 
livello di ingresso audio facilmente (pagina 14).

[Note]
ˎˎ Con determinate combinazioni di impostazioni 

del menu Audio, l’impostazione Audio Input Level 
potrebbe essere disabilitata. Per informazioni 
dettagliate, vedere il diagramma a pagina 128.
ˎˎ Il camcorder supporta combinazioni di varie 

impostazioni. Per informazioni dettagliate, vedere il 
diagramma a pagina 128.

Impostazione dell’audio da registrare
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Aggiunta di connettori di ingresso 
audio

È possibile collegare contemporaneamente al 
camcorder fino a quattro canali di dispositivi 
audio XLR utilizzando un adattatore XLR 
modello XLR-K2M o XLR-K3M (non in 
dotazione).
Montare l’adattatore XLR sulla slitta Multi-
interface e quindi, nella schermata Audio 
Status (pagina 14), impostare CH3 >Source 
su Shoe CH1 e CH4 >Source su Shoe CH2. In 
alternativa, impostare Audio Input >CH3 Input 
Select su Shoe CH1 e CH4 Input Select su Shoe 
CH2 nel menu Audio del menu completo.
Le funzioni del camcorder che si 
sovrappongono verranno disabilitate per i 
canali per i quali è selezionato come ingresso 
l’adattatore XLR. Eseguire le regolazioni 
necessarie servendosi dei pulsanti e delle 
manopole dell’adattatore XLR.

[Note]
ˎˎ Il camcorder supporta l’interfaccia audio digitale a 

due canali dell’adattatore XLR-K3M.
ˎˎ Se Audio Input >CH3 Level e CH4 Level nel menu 

Audio sono impostati su Audio Input Level, il valore 
di Audio Input Level del camcorder verrà moltiplicato 
per il valore di livello impostato sull’adattatore XLR.  
Audio Input Level viene abilitato anche quando il 
selettore dell’adattatore XLR è impostato su AUTO.  
Se è specificato “Through”, l’audio verrà registrato al 
livello impostato con l’adattatore XLR (pagina 129).
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Funzioni utili

Utilizzo del Direct Menu

Il camcorder consente di visualizzare e 
controllare sullo schermo del mirino lo 
stato e le sue impostazioni. Le impostazioni 
visualizzate possono essere selezionate e 
modificate direttamente.
Possono essere configurate le impostazioni 
elencate di seguito.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Premere la manopola multifunzione o un 
pulsante programmabile a cui è 
assegnata la funzione Direct Menu.
Le voci sullo schermo che possono essere 
configurate tramite Direct Menu sono 
selezionabili mediante un cursore di 
colore arancione.

2	 Ruotare la manopola multifunzione per 
spostare il cursore sulla voce di menu da 
impostare, quindi premere la manopola 
multifunzione.
Appare un menu, oppure la voce viene 
visualizzata su uno sfondo bianco.

3	 Ruotare la manopola multifunzione per 
selezionare l’impostazione desiderata 
quindi premere la manopola multifunzione.
Il menu o lo sfondo bianco scompaiono e 
il nuovo valore appare visualizzato con un 
cursore arancione.
Per uscire da Direct Menu, premere 
nuovamente il pulsante programmabile a 
cui è assegnata la funzione oppure 
attendere 3 secondi senza eseguire 
nessuna operazione.

	 [Informazioni]
ˎˎ È possibile configurare direttamente le 

impostazioni anche mantenendo premuto 
per alcuni istanti il relativo pulsante funzione 
(pagina 5).
ˎˎ Quando le voci sono visualizzate su uno sfondo 

bianco, la manopola multifunzione può essere 
utilizzata come una manopola programmabile.
ˎˎ La selezione può essere eseguita anche 

mediante il selettore multiplo (pagina 9).

Pulsanti e manopole programmabili

Il camcorder è dotato di nove pulsanti 
programmabili (pagina 6, 7, 9) a 
cui possono essere assegnate varie funzioni.
È possibile assegnare funzioni anche alla 
manopola multifunzione del camcorder 
(pagina 5), alla manopola programmabile 
della maniglia (pagina 7) e alla manopola 
programmabile dell’impugnatura di 
telecomando (pagina 9).

Modifica della funzione assegnata al 
pulsante

Utilizzare Assignable Button (pagina 80) nel 
menu Project del menu completo.
Le funzioni assegnate sono visualizzate 
nella schermata Assignable Button Status 
(pagina 15).

Funzioni predefinite assegnate ai vari pulsanti 
programmabili al momento dell’acquisto
Pulsante 1	 S&Q Motion
Pulsante 2	 AF Speed/Sens.
Pulsante 3	 Focus Setting
Pulsante 4	 Focus Magnifier x3/x6
Pulsante 5	 Direct Menu
Pulsante 6	 Off
Pulsante 7	 Focus Magnifier x3/x6
Pulsante 8	 Direct Menu
Pulsante 9	 Video Signal Monitor
Pulsante Focus Hold	 Focus Hold

Funzioni assegnabili
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot
ˎˎ Rec

ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Modifica della funzione assegnata alla 
manopola

Le funzioni assegnate alla manopola 
multifunzione del camcorder, alla manopola 
programmabile della maniglia e alla manopola 
programmabile dell’impugnatura possono 
essere scelte secondo le proprie esigenze.

Per la manopola multifunzione, utilizzare 
la voce Multi Function Dial (pagina 83) 
>Default Function del menu Project.
L’impostazione predefinita è Off.
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Funzioni assegnabili alla manopola 
multifunzione
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Nota]
L’impostazione è disabilitata mentre è visualizzato il 
menu.

Impostare la manopola programmabile 
mediante la voce Assignable Dial 
(pagina 82) del menu Project nel menu 
completo.
Per impostazione predefinita è assegnata la 
funzione IRIS.

[Informazione]
La manopola programmabile del telecomando RM-30BP 
(opzionale) segue l’impostazione di Grip/Remote Dial.

Funzioni assegnabili alla manopola 
programmabile della maniglia
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Funzioni assegnabili alla manopola 
programmabile dell’impugnatura
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

Le funzioni assegnate sono visualizzate 
nella schermata Assignable Button Status 
(pagina 15).

Slow & Quick Motion

Quando il formato di registrazione (pagina 78) è impostato su uno dei valori elencati 
di seguito, è possibile specificare valori diversi per le frequenze fotogrammi di ripresa e di 
riproduzione.

Formato di registrazione Frequenza 
fotogrammiFrequenza di 

sistema
Modalità di 
scansione imager

Codec Formato video

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60

RAW & XAVC-I 3840×2160P 1–60

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

È possibile attivare e disattivare la modalità 
Slow & Quick Motion premendo un pulsante 
programmabile (pagina 49) a cui è stata 
assegnata la funzione S&Q Motion.
Premere e mantenere premuto il pulsante per 
impostare la frequenza fotogrammi di ripresa.

[Note]
ˎˎ La funzione Slow & Quick Motion non può essere 

impostata durante la registrazione, la riproduzione o 
mentre è visualizzata la schermata delle miniature.
ˎˎ La modalità Slow & Quick Motion non consente la 

registrazione di audio.
ˎˎ Nella modalità Slow & Quick Motion, le funzioni di 

messa a fuoco automatica, diaframma automatico 
e otturatore automatico sono disabilitate. È tuttavia 
possibile utilizzare la funzione di messa a fuoco 
automatica quando la frequenza fotogrammi è 
impostata sui valori indicati di seguito.

Frequenza di sistema Frequenza fotogrammi

59.94/29.97/23.98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Per informazioni dettagliate sull’uso di output RAW, 
vedere pagina 56.

Registrazione di video a intervalli 
(Interval Rec)

Il camcorder è dotato della funzione Interval 
Rec che consente di catturare video in time-
lapse nella sua memoria interna. Questa 
funzione è efficace per riprendere soggetti che 
cambiano molto lentamente.
Quando si avvia la registrazione in 
questa modalità, il camcorder registra 
automaticamente un numero specificato di 
fotogrammi a intervalli specificati.

Intervallo di ripresa (Interval Time)

Numero di fotogrammi in ciascuna ripresa
(Number of Frames)

Quando è attiva la modalità Interval Rec, la 
luce video HVL-LBPC (opzionale) si accende 
automaticamente prima dell’avvio della 
registrazione per consentire la ripresa di 
immagini in stabili condizioni di illuminazione 
e di temperatura di colore (funzione di 
preilluminazione Pre-Lighting).

[Note]
ˎˎ È possibile utilizzare una sola funzione di 

registrazione speciale (ad esempio Interval Rec) alla 
volta.
ˎˎ Se durante l’utilizzo di Interval Rec viene attivata 

un’altra modalità di registrazione speciale, il 
camcorder esce dalla modalità Interval Rec.
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ˎˎ Il camcorder esce automaticamente dalla modalità 
Interval Rec se vengono modificate le impostazioni di 
sistema, ad esempio il formato video.
ˎˎ Le impostazioni della modalità Interval Rec non 

possono essere modificate durante la registrazione, 
la riproduzione o mentre è visualizzata la schermata 
delle miniature.

Impostazione di Interval Rec

Impostare Interval Rec (pagina 79) >Setting nel 
menu Project del menu completo su On, quindi 
impostare Number of Frames e Interval Time.
Se si utilizza la luce video HVL-LBPC 
(opzionale), l’opzione Interval Rec >Pre-
Lighting del menu Project consente di 
specificare secondo le proprie esigenze con 
che anticipo dovrà accendersi la luce video 
prima dell’avvio della registrazione.

[Note]
ˎˎ Se si desidera accendere la luce video prima dell’avvio 

della registrazione, spostare il selettore della luce 
video su AUTO. La luce video si accenderà e spegnerà 
automaticamente secondo l’impostazione dell’opzione 
Video Light Set (pagina 95) nel menu Technical.
ˎˎ Spostando su ON il selettore della luce video, la luce 

rimane sempre accesa (non si accende e spegne 
automaticamente).
ˎˎ La luce video non si spegne se è configurata per 

spegnersi per 5 secondi o meno.

Allo spegnimento, il camcorder esce dalla 
modalità Interval Rec, ma i valori impostati 
in Number of Frames, Interval Time e Pre-
Lighting sono mantenuti. Non è necessario 
impostarli nuovamente la volta successiva che 
si utilizza la funzione Interval Rec.

Ripresa in modalità Interval Rec

Premere il pulsante START/STOP registrazione 
per avviare la registrazione. Il mirino visualizza, 
alternativamente, le indicazioni “Int Rec” e 
“Int Stby”.
Se si utilizza la funzione di preilluminazione, la luce 
video si illumina prima dell’avvio della registrazione.

Arresto della ripresa

Arrestare la registrazione.
Al termine della ripresa, i dati video memorizzati 
fino a quel momento nella memoria vengono 
salvati sul supporto di registrazione.

Uscire dalla modalità Interval Rec

Eseguire una delle operazioni indicate di seguito.
ˎˎ Spostare il selettore POWER su Off.
ˎˎ In modalità standby di registrazione, 
impostare Interval Rec >Setting nel menu 
Project su Off.

Il camcorder esce automaticamente dalla modalità 
Interval Rec anche quando viene riavviato.

Limitazioni durante la registrazione

ˎˎ Non viene registrato audio.
ˎˎ Non è possibile rivedere la registrazione 
(Rec Review).

Se il camcorder viene spento durante la 
registrazione

ˎˎ Se il selettore POWER del camcorder si trova 
nella posizione Off, il camcorder accede per 
alcuni secondi al supporto di registrazione 
per salvare le immagini contenute in 
memoria fino al quel momento, quindi si 
spegne automaticamente.
ˎˎ Se l’alimentazione si interrompe perché è 
stata rimossa la batteria, è stato scollegato 
il cavo di alimentazione CC oppure è stata 
interrotta l’alimentazione all’adattatore CA, 
tutti i dati video ed audio registrati fino a 
quel momento andranno persi (max. 10 
secondi). Prestare attenzione durante la 
sostituzione la batteria. 

Registrazione simultanea sulle 
schede di memoria A e B (Simul 
Rec su 2 slot)

È possibile registrare simultaneamente sia 
sulla scheda di memoria A che sulla scheda 
di memoria B impostando su On la voce 
Simul Rec (pagina 14) nella schermata 
di stato Project, oppure Simul Rec >Setting 
(pagina 79) nel menu Project del menu 
completo.

Video Signal Monitor

La voce Display On/Off >Video Signal Monitor 
(pagina 89) del menu Monitoring consente 
di specificare se visualizzare il segnale video 
sullo schermo del mirino come forma d’onda, 
vettorscopio o istogramma.
La linea arancione indica il valore impostato 
del livello zebra.

Indicazione dell’oggetto del 
monitoraggio

In modalità Cine EI, l’angolo superiore destro 
del monitor del segnale video visualizza 
informazioni relative alle impostazioni dello 
spazio colore (pagina 24) o della LUT 
monitor (pagina 77) per indicare l’oggetto 
del monitoraggio.

 

Flag dei clip

Per aggiungere al clip un flag OK premere il 
pulsante Clip Flag (pagina 5) e selezionare 
Add OK.
Per eliminare un flag dal clip premere il 
pulsante due volte e selezionare Delete Clip 
Flag.

[Informazioni]
ˎˎ È possibile aggiungere flag ai clip anche mediante un 

pulsante programmabile a cui è assegnata la funzione 
di aggiunta di flag dei clip (pagina 49).
ˎˎ È possibile aggiungere flag ai clip anche mediante la 

voce Set Clip Flag (pagina 93) del menu Thumbnail 
nel menu completo (pagina 66).
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Registrazione proxy
Questa funzione consente di registrare 
contemporaneamente dati proxy a bassa 
risoluzione insieme ai dati video originali ad 
alta risoluzione.

Per informazioni dettagliate sulle schede di memoria 
supportate, sulla formattazione delle schede di memoria 
e sul controllo della capacità rimanente, fare riferimento a 
“Utilizzo di schede di memoria” (pagina 26).

Configurazione prima della ripresa

1	 Impostare su On la voce Proxy Rec 
(pagina 14) nella schermata di stato 
Project oppure la voce Proxy Rec >Setting 
(pagina 79) nel menu Project del menu 
completo.

2	 Inserire una scheda di memoria nello slot 
per schede CFexpress Type A/SD 
(pagina 6).
ˎˎ Per le schede CFexpress, l’etichetta è 
rivolta a sinistra.
ˎˎ Per le schede SD, l’etichetta è rivolta a 
destra con l’angolo tagliato in basso.

[Nota]
La modalità Proxy Rec non può essere impostata su 
On contemporaneamente a S&Q Motion o Interval 
Rec. Quando Proxy Rec è impostata su On, queste altre 
modalità di registrazione vengono automaticamente 
impostate su Off.

Registrazione di proxy

Premere il pulsante START/STOP registrazione 
per avviare la registrazione dopo aver 
completato le impostazioni necessarie per la 
ripresa.

[Note]
ˎˎ Se il camcorder viene spento o la scheda viene 

rimossa durante l’accesso alla scheda, non è 
possibile garantire l’integrità dei dati contenuti sulla 
scheda. Tutti i dati registrati sulla scheda di memoria 
potrebbero essere eliminati. Assicurarsi sempre che 
l’indicatore di accesso alla scheda di memoria sia 
spento prima di spegnere il camcorder o rimuovere la 
scheda di memoria stessa.
ˎˎ Assicurarsi che la scheda di memoria non salti 

fuori dallo slot al momento dell’inserimento o 
dell’estrazione.

Per uscire, arrestare la registrazione.

Impostazione del canale audio per 
la registrazione proxy

Selezionare Proxy Rec >Audio Channel 
(pagina 79) nel menu Project del menu 
completo e impostare il canale audio per la 
registrazione dei dati proxy.

Informazioni sul file registrato

L’estensione del nome del file è “.mp4”.
Anche il timecode viene registrato 
simultaneamente.

Destinazione di salvataggio del 
file registrato

Il file registrato viene salvato nella directory 
indicata di seguito.

Supporto di 
registrazione

Percorso cartella

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Informazioni sul nome dei file

Il nome del file consiste del nome del clip 
registrato sulla scheda di memoria seguito dal 
suffisso “S03”.
Per informazioni dettagliate sul nome dei 
clip, fare riferimento a Clip Name Format 
(pagina 87) nel menu TC/Media del menu 
completo.
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Ripresa con il Look desiderato
Impostando il camcorder nella modalità 
Custom, è possibile regolare i valori di nero, 
matrice ed altri parametri per creare “look” 
personalizzati basati sul look di base.

：

Look

Matrice

Nero

Look di base

Salvando diverse combinazioni di 
impostazioni in file di scena diventa quindi 
possibile selezionare rapidamente look diversi 
secondo le proprie esigenze.
Il camcorder è fornito con sei look 
preconfigurati.

Selezione di un look

1	 Mentre è visualizzata la schermata di 
ripresa, premere la manopola 
multifunzione.

2	 Selezionare l’icona SCN.

3	 Premere la manopola multifunzione.

4	 Selezionare il look desiderato nel menu e 
quindi premere la manopola 
multifunzione.

[Informazioni]
ˎˎ Nelle impostazioni predefinite sono preconfigurati i 

seguenti preset:

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

File di scena 1 S-Cinetone HLG Live

File di scena 2 Standard HLG Natural

File di scena 3 Still (Non 
registrato)

File di scena 4 ITU709 (Non 
registrato)

File di scena  
da 5 a 16

(Non 
registrato)

(Non 
registrato)

ˎˎ È possibile selezionare un look utilizzando la voce 
Scene File (pagina 13) nella schermata Main Status 
oppure la voce Scene File >Recall (pagina 84) 
nel menu Paint/Look del menu completo. Utilizzare 
Scene File >Preset Recall per richiamare un look 
preconfigurato.

Importazione del look di base 
desiderato

È possibile importare come look di base un 
file 3D LUT creato con un computer o un altro 
dispositivo. Possono essere importati fino a 
16 file.
ˎˎ Formato di File: File CUBE (*.cube) per una 
3D LUT a 17 o 33 punti creata con Catalyst 
Browse, RAW Viewer o DaVinci Resolve* (di 
Blackmagic Design Pty. Ltd.).
*	 Verificato con Resolve V9.0, V10.0 e V11.0.

ˎˎ Spazio colore di ingresso/gamma: 
S-Gamut3.Cine/S-Log3 o S-Gamut3/S-Log3

1	 Sul computer o altro dispositivo, salvare il 
file 3D LUT nella cartella specificata del 
supporto di registrazione.

Supporto di 
registrazione

Percorso cartella

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Type A

/SONY/PRO/LUT/

2	 Inserire la scheda di memoria su cui sono 
salvati i file 3D LUT nello slot per schede di 
memoria CFexpress Type A/SD (B).

3	 Selezionare Base Look >Import 
(pagina 84) nel menu Paint/Look del 
menu completo.

4	 Selezionare la destinazione di 
importazione.

5	 Selezionare il file 3D LUT da importare.
Seguire le istruzioni indicate a schermo. Il 
camcorder può gestire il file 3D LUT come 
look di base.

6	 Selezionare il file 3D LUT importato con la 
voce Base Look >Select (pagina 84) nel 
menu Paint/Look del menu completo.

7	 Configurare Base Look >Input e Output 
(pagina 84) nel menu Paint/Look del 
menu completo per riflettere gli attributi 
del file 3D LUT importato.

Gestione della sottoesposizione

Qualora si rilevi una tendenza alla 
sottoesposizione quando è selezionata 
l’esposizione automatica durante l’uso di un 
look di base importato, regolare secondo 
le esigenze Base Look >AE Level Offset 
(pagina 84) nel menu Paint/Look.

[Note]
ˎˎ La sola importazione di un file 3D LUT non ha alcun 

effetto sull’immagine. Caricare il file 3D LUT importato 
mediante Base Look >Select (pagina 84) nel menu 
Paint/Look del menu completo.
ˎˎ Se Input non è impostato correttamente, non sarà 

possibile ottenere il look desiderato.
ˎˎ Le impostazioni delle voci di menu Input, Output 

e AE Level Offset sono applicate al menu di base 
selezionato con Select. Se è stato importato più 
di un file 3D LUT, è necessario selezionare Select 
e configurare Input, Output e AE Level Offset 
individualmente per ciascuno di tali file 3D LUT.
ˎˎ Le impostazioni configurate di Input, Output e 

AE Level Offset sono salvate individualmente per 
ciascuno dei file 3D LUT.
ˎˎ Le opzioni di selezione del look di base e della LUT 

per i file 3D LUT importati sono comuni alle modalità 
SDR(BT.709), HDR(HLG) e Cine EI, ma la conversione di 
gamma e spazio colore non viene eseguita in base a 
tali modalità.
ˎˎ La selezione di All Reset >Reset nel menu 

Maintenance non elimina i file 3D LUT.
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Personalizzazione di un look

È possibile personalizzare il look partendo 
dal look di base utilizzando Matrix e altre voci 
di impostazione presenti nel menu Paint/
Look del menu completo. Per informazioni 
dettagliate sulle varie voci di impostazione, 
fare riferimento a pagina 84.
Collegare il camcorder a un televisore o a un 
monitor e regolare la qualità dell’immagine 
osservandola sullo schermo.

[Nota]
Quando si importa e si applica all’immagine un file 
3D LUT, non sarà possibile ottenere il look desiderato 
e definito in tale file se sono state modificate le 
impostazioni di Matrix e altre impostazioni diverse 
da quelle del look di base nel menu Paint/Look. È 
possibile resettare tutte le impostazioni personalizzate 
mediante Reset Paint Settings >Reset without Base Look 
(pagina 84) nel menu Paint/Look del menu completo.

Salvataggio di un look

Il look corrente può essere salvato come file 
di scena nella memoria interna del camcorder 
utilizzando la voce Scene File >Store 
(pagina 84) nel menu Paint/Look del menu 
completo.
È possibile eseguire rapidamente il 
salvataggio tramite le funzionalità del Direct 
Menu nella schermata di ripresa.

[Nota]
Se viene selezionato un altro look senza aver prima 
salvato il look corrente, il look corrente andrà perso.

[Informazione]
I file di scena preconfigurati possono essere sovrascritti.
Per ripristinare un file di scena preconfigurato, caricare il 
look da ripristinare mediante la voce Scene File >Preset 
Recall (pagina 84) nel menu Paint/Look del menu 
completo, quindi salvare il file di scena con Scene File 
>Store.

Eliminazione di un look salvato

È possibile eliminare file di scena salvati nella 
memoria interna del camcorder utilizzando 
la voce Scene File >Delete (pagina 84) nel 
menu Paint/Look del menu completo.

[Informazione]
I file di scena eliminati, non sono più visualizzati nel 
Direct Menu.

Eliminazione di un look di base

È possibile eliminare un file 3D LUT 
precedentemente importato utilizzando Base 
Look >Delete (pagina 84) nel menu Paint/
Look del menu completo.
È possibile eliminare tutti file 3D LUT 
precedentemente importati utilizzando Base 
Look >Delete All (pagina 84) nel menu 
Paint/Look del menu completo.

[Note]
ˎˎ Prima dell’eliminazione, controllare che il look di base 

non sia utilizzato in nessun file di scena. Se viene 
eliminato un look di base utilizzato in file di scena, 
il look dei file di scena che lo utilizzano non sarà 
corretto.
ˎˎ La selezione di All Reset >Reset (pagina 101) nel 

menu Maintenance del menu completo non elimina i 
file 3D LUT importati.
ˎˎ I look di base eliminati non possono essere utilizzati 

come LUT in modalità Cine EI (pagina 55).
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Ripresa con regolazione del look in post-produzione
Utilizzando il camcorder in modalità Cine EI 
e registrando con una gradazione uniforme 
dell’intero campo dalle ombre alle alte luci, 
sarà possibile effettuare regolazioni fini 
in sede di post produzione, ad esempio, 
ripristinando la gradazione delle alte luci e 
delle ombre solo localmente.
In questo caso, tuttavia, se visualizzate su un 
monitor convenzionale, le immagini registrate 
avranno un contrasto generale piuttosto 
basso, rendendo più difficoltoso il controllo 
della messa a fuoco e dell’esposizione.
È possibile applicare una LUT al monitor 
utilizzato con il camcorder per facilitare 
varie regolazioni durante le riprese. È 
possibile applicare una LUT anche al video di 
riproduzione per verificare il risultato finito.
Le LUT sono applicate dai sistemi indicati di 
seguito. Potrà essere applicata una sola LUT 
alla volta.
ˎˎ Uscita SDI e uscita HDMI
ˎˎ Mirino e immagini proxy, streaming
ˎˎ Video registrato su supporti di registrazione

Applicazione di una LUT 
all’immagine del mirino

1	 Premere il pulsante MENU per visualizzare 
la schermata Monitoring Status.

2	 Selezionare la colonna Gamut/Gamma 
nella riga VF.

3	 Selezionare On o Off.

[Note]
ˎˎ L’impostazione On o Off della LUT di VF viene 

applicata anche al file proxy e al video in streaming.
ˎˎ Mentre è attiva la funzione di ingrandimento della 

messa a fuoco è disponibile anche la funzione di 
assistenza alla visualizzazione gamma.

[Informazioni]
ˎˎ È possibile anche eseguire l’impostazione mediante 

LUT On/Off >VF/Proxy/Stream (pagina 77) nel 
menu Shooting del menu completo.
ˎˎ SDI e HDMI possono essere impostati in maniera 

analoga a VF.
ˎˎ Per il video registrato su supporti di registrazione, è 

possibile eseguire l’impostazione mediante LUT On/
Off >Internal Rec (pagina 77) nel menu Shooting 
del menu completo.

Modifica di una LUT

1	 Premere il pulsante MENU per visualizzare 
la schermata Monitoring Status.

2	 Selezionare il campo Base Look/LUT.

3	 Selezionare la LUT da applicare nell’elenco 
dei look di base.

[Informazioni]
ˎˎ È possibile anche importare ed applicare un file 3D 

LUT. Come look di base, possono essere selezionati 
s709, 709(800%) o S-Log3. Per informazioni 
dettagliate, vedere “Importazione del look di base 
desiderato” (pagina 53) e “Eliminazione di un look 
di base” (pagina 54).

ˎˎ Il look di base può essere impostato anche mediante 
Base Look >Select (pagina 84) nel menu Paint/Look 
del menu completo.

Modifica della distribuzione delle 
ombre e delle alte luci nel video 
registrato

La distribuzione delle ombre e delle alte luci 
può essere modificata secondo le proprie 
esigenze, ad esempio se si desidera dare una 
priorità alle tonalità delle ombre rispetto alle 
alte luci. Per farlo, impostare Exposure Index 
su un valore diverso dalla sensibilità di base.

1	 Applicare una LUT all’immagine del mirino 
(pagina 55).

2	 Premere il pulsante MENU per visualizzare 
la schermata Camera Status.

3	 Impostare i campi L/M/H di Exposure 
Index.
I valori impostati sono assegnati alle 
rispettive posizioni L/M/H del selettore 
ISO/GAIN (pagina 5).

4	 Selezionare il valore di Exposure Index da 
applicare mediante il selettore ISO/GAIN.

5	 Regolare l’esposizione dell’immagine del 
mirino secondo le proprie esigenze.

[Nota]
Mentre è attiva la funzione di ingrandimento della 
messa a fuoco è disponibile anche la funzione di 
assistenza alla visualizzazione gamma. L’impostazione 
di Exposure Index non viene applicata all’assistenza di 
visualizzazione gamma.

[Informazioni]
ˎˎ L’esposizione può essere regolata anche mediante 

ISO/Gain/EI >Exposure Index (pagina 73) nel menu 
Shooting del menu completo.
ˎˎ Il secondo valore numerico dell’impostazione indica 

quanti passi di informazioni di luminosità sono 
assegnati alle alte luci (aree con luminosità superiore 
al 18% di grigio). Le aree con luminosità superiore 
sono sovraesposte.  
Esempio: In “400EI/5.0E” sono assegnati alla 
luminosità 5,0 passi.
ˎˎ Questo può essere utilizzato come guida per 

controllare il tono delle ombre e delle alte luci 
durante la ripresa. Ad esempio, se la posizione M è 
la sensibilità di base, la posizione L è meno 2 passi 
e la posizione H è più 2 passi, è possibile eseguire il 
controllo spostando il selettore ISO/GAIN. Ricordarsi 
di tornare sempre sulla posizione M dopo il controllo 
dell’esposizione.
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Il segnale video RAW in uscita sul connettore 
SDI OUT del camcorder può essere registrato 
su un registratore esterno supportato.

1	 Collegare un registratore RAW esterno al 
connettore SDI OUT del camcorder.

2	 Impostare la modalità di ripresa su Cine EI 
utilizzando la schermata di stato Project 
(pagina 14) oppure Base Setting 
>Shooting Mode (pagina 78) nel menu 
Project del menu completo.

3	 Impostare la modalità di scansione (solo 
FF) utilizzando Imager Scan nella 
schermata di stato Project oppure Rec 
Format >Imager Scan Mode (pagina 78) 
nel menu Project del menu completo.

4	 Impostare il codec su un codec che 
includa RAW nella schermata di stato 
Project oppure utilizzando Rec Format 
>Codec (pagina 78) nel menu Project 
del menu completo.
Selezionando RAW & XAVC-I è possibile 
registrare contemporaneamente video 
sulle schede di memoria del camcorder e 
video RAW sul registratore RAW esterno.

5	 Impostare la risoluzione utilizzando la 
schermata di stato Project oppure Rec 
Format >RAW Output Format 
(pagina 78) nel menu Project del menu 
completo.

6	 Controllare che il registratore esterno sia 
acceso, quindi premere il pulsante START/
STOP registrazione del camcorder.

	 [Nota]
Se viene avviata la registrazione sul registratore 
esterno ma non viene premuto il pulsante START/
STOP registrazione del camcorder, i clip potrebbero 
non venire registrati correttamente.

I formati di uscita RAW supportati sono 
indicati di seguito.

Frequenza 
di sistema

Codec Formato di 
uscita RAW

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Indicatore dello stato della 
registrazione

Quando Display On/Off (pagina 88) >RAW 
Output Control Status nel menu Monitoring 
del menu completo è impostato su On, lo 
stato della registrazione RAW viene segnalato 
da un’icona visualizzata sullo schermo del 
mirino.

[Nota]
Il segnale di controllo della registrazione viene emesso 
sul connettore SDI OUT del camcorder. Non è però 
possibile ottenere lo stato del registratore esterno. 
Per questo motivo è possibile che il camcorder indichi 
che la registrazione video RAW sia in corso anche se il 
registratore esterno non sta effettivamente registrando. 
Controllare l’effettivo stato operativo servendosi sempre 
dell’indicatore del registratore esterno.

[Informazione]
Viene visualizzato anche il valore dell’impostazione RAW 
Output Format.

Registrazione Slow & Quick 
Motion

Se S&Q Motion >Setting del menu Shooting è 
impostata su On, il video RAW viene registrato 
in modalità Slow & Quick Motion.
Per informazioni dettagliate sulle frequenze 
fotogrammi supportate per le riprese, fare 
riferimento a pagina 50.

Registrazione di video RAW
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Connessione ad altri dispositivi tramite LAN
Il camcorder è in grado di collegarsi a 
smartphone, tablet e altri dispositivi tramite 
una connessione LAN.
Collegando il camcorder a un dispositivo 
tramite una rete LAN, è possibile utilizzare la 
applicazione “Content Browser Mobile” per 
eseguire le operazioni descritte di seguito.
ˎˎ Comando a distanza tramite LAN 
È possibile comandare a distanza il 
camcorder mediante uno smartphone, 
tablet o computer connesso tramite LAN.
ˎˎ Trasferimento di file tramite LAN 
Se si utilizza una LAN, è possibile trasferire a 
un server file proxy (bassa risoluzione) e/o 
file originali (alta risoluzione) registrati sulle 
schede di memoria del camcorder.
ˎˎ Monitoraggio video tramite LAN 
Durante la ripresa o la riproduzione, è 
possibile creare sul camcorder uno stream 
video (H.264) e monitorare tale video 
mediante l’applicazione “Content Browser 
Mobile” da un dispositivo connesso alla rete 
LAN.

Applicazione “Content Browser Mobile”

L’applicazione “Content Browser Mobile” 
consente di utilizzare lo schermo di un 
dispositivo per azionare il camcorder a 
distanza, monitorarne il video e configurarne 
impostazioni.

Per informazioni dettagliate sull’applicazione “Content 
Browser Mobile” rivolgersi al proprio rappresentante 
commerciale o di assistenza tecnica Sony.

Impostazione del nome utente e 
della password

Per poter utilizzare le funzionalità di rete è 
necessario impostare il nome utente e la 
password.

1	 Impostare Access Authentication >User 
Name (pagina 97) nel menu Network 
del menu completo.

2	 Impostare Access Authentication 
>Password (pagina 97) nel menu 
Network del menu completo.

Connessione tramite la modalità 
Punto di accesso LAN wireless

Il camcorder funziona come un punto di 
accesso e si connette a un dispositivo tramite 
LAN wireless.

Smartphone/tablet

Connessione a un dispositivo NFC 
compatibile con un’operazione One-touch

I dispositivi che supportano la funzione NFC 
possono essere collegati tramite tale funzione 
(connessione “One-Touch”).

1	 Aprire [Settings] sul dispositivo, 
selezionare [More] e contrassegnare con 
un segno di spunta la casella di controllo 
NFC.

2	 Accendere il camcorder.

3	 Attivare la funzione NFC.
Mantenere premuto per 3 secondi il 
pulsante programmabile a cui è stata 
assegnata la funzione NFC oppure 
selezionare Wireless LAN >NFC nel menu 
Network per attivare la modalità di 
connessione NFC.
La funzione NFC è disponibile solo 
quando sullo schermo è visualizzato .

4	 Toccare il camcorder con il dispositivo.
Il dispositivo si connette al camcorder ed 
avvia “Content Browser Mobile”.

	 [Note]
ˎˎ Disabilitare in anticipo le modalità sleep e di 

blocco schermo.
ˎˎ Toccare e mantenere fermo il dispositivo fino 

a quando non si avvia l’applicazione “Content 
Browser Mobile” (1 o 2 secondi).
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Connessione a un dispositivo WPS 
compatibile

È possibile utilizzare la funzione di 
collegamento WPS con i dispositivi che la 
supportano.

1	 Selezionare Wireless LAN >Setting >Access 
Point Mode nel menu Network del menu 
completo.

2	 Selezionare Wireless LAN >WPS >Execute 
nel menu Network del menu completo.

3	 Aprire le impostazioni di rete o Wi-Fi del 
dispositivo ed attivare Wi-Fi.

4	 Per eseguire il collegamento, selezionare 
il SSID del camcorder nell’elenco dei SSID 
in Wi-Fi Network sul dispositivo, quindi 
selezionare WPS Push Button in Option 
sul dispositivo.

	 [Note]
ˎˎ Il metodo di funzionamento dipende dal 

dispositivo.
ˎˎ Per informazioni su SSID e password del 

camcorder, vedere AP Mode Settings >Camera 
SSID & Password (pagina 97) nel menu 
Network del menu completo.

5	 Eseguire il collegamento tramite 
l’applicazione Content Browser Mobile.

Connessione mediante inserimento di 
SSID e password su un dispositivo

È possibile connettere il camcorder a un 
dispositivo immettendo sul dispositivo SSID e 
password corrispondenti.

1	 Selezionare Wireless LAN >Setting >Access 
Point Mode nel menu Network del menu 
completo.

2	 Aprire le impostazioni di rete o Wi-Fi del 
dispositivo ed attivare Wi-Fi.

3	 Collegare il dispositivo al camcorder 
selezionando il SSID del camcorder 
nell’elenco dei SSID in Wi-Fi Network e 
immettendo la password.
Per informazioni su SSID e password del 
camcorder, vedere AP Mode Settings 
>Camera SSID & Password (pagina 97) 
nel menu Network.

	 [Nota]
Il metodo di funzionamento dipende dal 
dispositivo.

4	 Eseguire il collegamento tramite 
l’applicazione Content Browser Mobile.

Connessione tramite la modalità 
Wireless LAN Station

Il camcorder si connette a un punto di accesso 
esistente nella LAN wireless come client. 
Il camcorder e il dispositivo si connettono 
attraverso il punto di accesso.
La cronologia mostra gli ultimi 10 punti di 
accesso a cui ci si è collegati.
La cronologia viene salvata nel file ALL, ma 
le password di accesso non vengono salvate. 
È sempre necessario immettere la password 
la prima volta che si esegue la connessione 
dopo aver caricato un file ALL.

Smartphone/
tablet

Punto di accesso

Computer

Connessione a un punto di accesso 
mediante WPS

Se il punto di accesso è compatibile con la 
funzione WPS, è possibile connettersi al punto 
di accesso con impostazioni semplificate.

1	 Accendere il punto di accesso.

2	 Accendere il camcorder.

3	 Selezionare Wireless LAN >Setting > 
Station Mode nel menu Network del menu 
completo.

4	 Selezionare ST Mode Settings >Camera 
Remote Control (pagina 97) >Enable 
nel menu Network del menu completo.

5	 Selezionare Wireless LAN >WPS >Execute 
nel menu Network del menu completo.

6	 Premere il pulsante WPS del punto di 
accesso.
Per informazioni dettagliate sull’uso del 
pulsante WPS, consultare le istruzioni per 
l’uso del punto di accesso.
Una volta realizzata correttamente la 
connessione, l’icona di indicazione dello 
stato della rete visualizzata sullo schermo 
del mirino indicherà un livello di intensità 
del segnale di almeno 1.

	 [Nota]
Se la connessione non riesce, ripetere la procedura 
dal punto 1.

7	 Connettere il dispositivo al punto di 
accesso.
Per informazioni dettagliate sulla 
connessione, consultare le istruzioni per 
l’uso del dispositivo.
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8	 Eseguire il collegamento tramite 
l’applicazione Content Browser Mobile.

Collegamento a un punto di accesso 
mediante la funzione di rilevamento 
automatico della rete o manualmente

È possibile configurare la connessione a 
un punto di accesso desiderato nel menu 
completo.
È possibile configurare la connessione a un 
punto di accesso desiderato utilizzando la 
funzione di rilevamento automatico della rete.

Connessione tramite la funzione di 
rilevamento automatico della rete

1	 Eseguire i passi da 1 a 3 descritti in 
“Connessione a un punto di accesso 
mediante WPS” (pagina 58).

2	 Selezionare ST Mode Settings >Scan 
Networks (pagina 98) >Execute nel 
menu Network del menu completo.
Il camcorder avvia la ricerca di 
destinazioni di connessione.
Le possibili destinazioni trovate vengono 
visualizzate in un elenco.

3	 Selezionare la destinazione desiderata 
nell’elenco.
Appare la schermata dei dettagli della 
rete (punto di accesso). La connessione 
selezionata è visualizzata in SSID.

4	 Selezionare Password, quindi impostare la 
password nella schermata di immissione 
della password.
La selezione di un SSID nella cronologia 
delle connessioni ne configura 
automaticamente le impostazioni, 
compresa la password.

Impostare la password per tornare alla 
schermata dei dettagli di rete (punto di 
accesso).

5	 Configurare le impostazioni di 
connessione indicate di seguito.
ˎˎ DHCP 
Configurare l’impostazione DHCP.  
Quando è impostato su On, l’indirizzo 
IP viene assegnato al camcorder 
automaticamente.  
Per assegnare manualmente l’indirizzo 
IP al camcorder, impostare su Off.
ˎˎ IP Address 
Immettere l’indirizzo IP dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ Subnet Mask 
Immettere la subnet mask dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ Gateway 
Immettere il gateway del punto di accesso.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ DNS Auto 
Specifica se acquisire l’indirizzo DNS 
automaticamente o meno.  
Quando impostato su On, l’indirizzo 
del server DNS viene acquisito 
automaticamente. Questa impostazione 
è disponibile solo quando DHCP è 
impostato su On.
ˎˎ Primary DNS Server 
Immettere l’indirizzo del server DNS 
primario del punto di accesso.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.
ˎˎ Secondary DNS Server 
Immettere l’indirizzo del server DNS 
secondario del punto di accesso.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

6	 Al termine, selezionare Connect per 
connettersi al punto di accesso.

Connessione manuale

1	 Eseguire i passi da 1 a 3 descritti in 
“Connessione a un punto di accesso 
mediante WPS” (pagina 58).

2	 Selezionare ST Mode Settings >Manual 
Register (pagina 98) >Execute nel 
menu Network del menu completo.
Appare momentaneamente la schermata 
dei dettagli della rete (punto di accesso).

3	 Configurare le impostazioni di 
connessione indicate di seguito.
ˎˎ SSID 
Immettere il SSID del punto di accesso 
della connessione.
ˎˎ Security 
Selezionare il metodo di crittografia.
ˎˎ Password 
Immettere la password del punto di 
accesso.
ˎˎ DHCP 
Configurare l’impostazione DHCP.  
Quando è impostato su On, l’indirizzo 
IP viene assegnato al camcorder 
automaticamente.  
Per assegnare manualmente l’indirizzo 
IP al camcorder, impostare su Off.
ˎˎ IP Address 
Immettere l’indirizzo IP dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ Subnet Mask 
Immettere la subnet mask dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ Gateway 
Immettere l’indirizzo del gateway.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.

ˎˎ DNS Auto 
Specifica se acquisire l’indirizzo DNS 
automaticamente o meno.  
Quando impostato su On, l’indirizzo 
del server DNS viene acquisito 
automaticamente. Questa impostazione 
è disponibile solo quando DHCP è 
impostato su On.
ˎˎ Primary DNS Server 
Immettere l’indirizzo del server DNS 
primario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.
ˎˎ Secondary DNS Server 
Immettere l’indirizzo del server DNS 
secondario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

4	 Al termine, selezionare Connect per 
connettersi al punto di accesso.
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Connessione a un dispositivo 
mediante un cavo LAN

È possibile collegare il camcorder a un altro 
dispositivo utilizzando un adattatore per LAN 
cablata (opzionale) collegato al connettore 
USB-C (pagina 7) del camcorder stesso, il 
cui connettore per LAN cablata è a sua volta 
collegato mediante un cavo LAN a un router 
Wi-Fi (opzionale).

Smartphone/tablet

Router Wi-Fi

Connessioni cavo LAN e impostazioni 
LAN cablata

1	 Collegare il connettore della LAN cablata 
dell’adattatore per LAN cablata a un 
router Wi-Fi tramite un cavo LAN.

2	 Accendere il camcorder.

3	 Impostare su On la voce Wired LAN 
>Setting (pagina 99) nel menu Network 
del menu completo.

4	 Configurare le impostazioni di 
connessione mediante la voce Wired LAN 
>Detail Settings (pagina 99) del menu 
Network.
ˎˎ DHCP 
Configurare l’impostazione DHCP.  
Quando è impostato su On, l’indirizzo 
IP viene assegnato al camcorder 
automaticamente.  
Per assegnare manualmente l’indirizzo 
IP al camcorder, impostare su Off.
ˎˎ IP Address 
Immettere l’indirizzo IP dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ Subnet Mask 
Immettere la subnet mask dell’unità.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ Gateway 
Immettere l’indirizzo del gateway.  
Questa impostazione è disponibile solo 
quando DHCP è impostato su Off.
ˎˎ DNS Auto 
Specifica se acquisire l’indirizzo DNS 
automaticamente o meno.  
Quando impostato su On, l’indirizzo 
del server DNS viene acquisito 
automaticamente. Questa impostazione 

è disponibile solo quando DHCP è 
impostato su On.
ˎˎ Primary DNS Server 
Immettere l’indirizzo del server DNS 
primario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.
ˎˎ Secondary DNS Server 
Immettere l’indirizzo del server DNS 
secondario.  
Questa impostazione è disponibile solo 
quando DNS Auto è impostato su Off.

5	 Al termine, selezionare Set per applicare 
le impostazioni.

[Note]
ˎˎ Selezionare sempre Set dopo aver modificato le 

impostazioni di connessione. Le impostazioni non 
sono applicate fino a quando non viene selezionato 
Set.
ˎˎ Utilizzare un adattatore per LAN cablata USB Type C. 

Si consiglia l’uso di un adattatore compatibile con 
Gigabit Ethernet. Non è tuttavia possibile garantire il 
funzionamento con tutti i dispositivi.
ˎˎ La funzione di comunicazione Wi-Fi incorporata del 

camcorder potrebbe essere influenzata dal tipo di 
adattatore per LAN cablata (opzionale) utilizzato.
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È possibile collegare il camcorder a Internet 
tramite tethering USB, una LAN cablata o una 
LAN wireless.

Collegamento tramite tethering USB

È possibile collegare l’unità a uno smartphone 
tramite un cavo USB e quindi connettersi a 
Internet tramite lo smartphone.

Configurazione della comunicazione 
tramite smartphone

Abilitare la funzione di tethering sullo 
smartphone.
Per ulteriori informazioni, consultare il 
manuale per l’uso dello smartphone.

Collegamento del smartphone al camcorder

Collegare un cavo USB al connettore USB-C 
(pagina 7) del camcorder, quindi collegare 
lo smartphone.

[Note]
ˎˎ Collegare o scollegare lo smartphone solo con il 

camcorder spento.
ˎˎ La funzione di tethering USB non può essere utilizzata 

se lo smartphone è connesso tramite un hub USB.
ˎˎ La funzione di tethering USB non è utilizzabile se 

un computer è collegato al connettore USB/Multi 
(pagina 7).

Connessione a una rete

1	 Accendere il camcorder.

2	 Impostare su On la voce Modem >Setting 
(pagina 99) nel menu Network del 
menu completo.

Abilitazione del comando tramite uno 
smartphone

Per azionare il camcorder a distanza utilizzando 
l’applicazione Content Browser Mobile su 
uno smartphone, impostare su Enable la voce 
Modem >Camera Remote Control (pagina 97) 
nel menu Network del menu completo.

Connessione tramite la modalità 
Wireless LAN Station

È possibile connettere il camcorder a Internet 
nella modalità Wi-Fi Station tramite un router 
Wi-Fi opzionale o tramite tethering con un 
dispositivo.

Smartphone/
tablet

Router Wi-Fi

Computer

Internet

Smartphone/
tablet

Internet

Eseguire il collegamento al router Wi-Fi o al 
dispositivo come descritto in “Connessione 
tramite la modalità Wireless LAN Station” 
(pagina 58).

Connessione con cavo LAN

È possibile collegare il camcorder a Internet 
utilizzando un adattatore per LAN cablata 
(opzionale) collegato al connettore USB-C 
(pagina 7) del camcorder stesso, il cui 
connettore per LAN cablata è a sua volta 
collegato mediante un cavo LAN a un router 
Wi-Fi (opzionale).

Smartphone/
tablet

Computer

Router Wi-Fi

Internet

Eseguire il collegamento al router Wi-Fi come 
descritto in “Connessione a un dispositivo 
mediante un cavo LAN” (pagina 60).

[Note]
ˎˎ Non è possibile utilizzare un adattatore USB per LAN 

cablata (opzionale) se un computer è collegato al 
connettore USB/Multi (pagina 7).
ˎˎ La funzione di comunicazione Wi-Fi incorporata del 

camcorder potrebbe essere influenzata dal tipo di 
adattatore per LAN cablata (opzionale) utilizzato.

Connessione a Internet
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Caricamento di file
I file proxy e i file originali registrati sul 
camcorder possono essere caricati su un server 
Internet o un server sulla rete locale tramite 
uno smartphone o un punto di accesso.

Operazioni di preparazione

Connessione a una rete

Collegare il camcorder a Internet o alla rete 
locale come descritto in “Connessione a 
Internet” (pagina 61) o “Connessione ad 
altri dispositivi tramite LAN” (pagina 57).

Registrazione di una destinazione di 
trasferimento file

Registrare anticipatamente il server per il 
caricamento.

1	 Selezionare File Transfer >Server Settings1 
(oppure Server Settings2, Server Settings3) 
nel menu Network del menu completo.
Appare la schermata di configurazione 
della destinazione di trasferimento.

2	 Impostare le varie opzioni nella schermata 
di configurazione della destinazione di 
trasferimento.
Display Name
Immettere il nome del server da 
visualizzare nell’elenco delle destinazioni 
di trasferimento.
Service
Visualizza il tipo di server.
“FTP”: server FTP
Host Name
Immettere l’indirizzo del server.
Port
Immettere il numero di porta del server a 
cui connettersi.

User Name
Immettere il nome utente.
Password
Immettere la password.
Passive Mode
Attivare o disattivare la modalità Passive.
Destination Directory
Immettere il nome della directory sul 
server di destinazione.

	 [Note]
ˎˎ Durante la modifica, “” indica caratteri che non 

possono essere cambiati. Non è possibile garantire 
il funzionamento corretto se si modificano nomi di 
directory che contengono tali caratteri.  
Se è necessario eseguire una modifica, eliminare 
tutti i caratteri ed immettere nuovamente il valore 
desiderato.
ˎˎ Se vengono immessi in Destination Directory 

caratteri non validi per il server di destinazione, 
i file saranno trasferiti alla directory Home 
dell’utente. I caratteri validi e non validi variano a 
seconda del server.

Using Secure Protocol
Specifica se utilizzare o meno il protocollo 
di upload Secure FTP.
Root Certificate
Caricamento o annullamento di un certificato.
ˎˎ Load 
Selezionare Set al passo 3 per importare 
un certificato CA.

*	 Il certificato da caricare deve essere in formato 
PEM e il suo file deve avere il nome “certification.
pem” ed essere contenuto nella directory 
principale della scheda di memoria inserita nello 
slot per schede CFexpress Type A/SD (B).

ˎˎ Clear 
Selezionare Set al passo 3 per annullare 
un certificato CA.
ˎˎ None 
Non carica né annulla nessun certificato.

	 [Note]
ˎˎ Impostare l’orologio del camcorder sull’ora 

corretta prima di importare un certificato CA.
ˎˎ Durante la registrazione in modalità XAVC-I 

4096×2160P/3840×2160P 59.94/50P, non è 
possibile selezionare Load.
ˎˎ In condizioni di bassa tensione, non è possibile 

selezionare Load o Clear per un certificato CA.

Root Certificate Status
Visualizza lo stato di caricamento del 
certificato.
Reset
Ripristina sui valori predefiniti le 
impostazioni di Server Settings.

3	 Al termine, selezionare Set per applicare 
le impostazioni.
Selezionare sempre Set dopo aver 
modificato le impostazioni. Le 
impostazioni non sono applicate fino a 
quando non viene selezionato Set.

Selezione di file e upload

È possibile selezionare e trasferire su un server i file 
proxy e i file originali registrati su schede di memoria.

Caricamento dalla schermata delle 
miniature di un file proxy contenuto in 
una scheda di memoria

1	 Collegare il camcorder al dispositivo tramite 
una connessione LAN (pagina 57).

2	 Selezionare Transfer Clip (Proxy) >Select Clip 
nel menu Thumbnail del menu completo.
Il display passa dal menu completo alla 
schermata delle miniature.
Il trasferimento dei clip può essere 
effettuato sia dalla schermata delle 
miniature che dalla schermata filtrata 
delle miniature dei clip.

3	 Selezionare il clip da trasferire, quindi 
premere il pulsante MENU.
Viene visualizzata una schermata di 
conferma del trasferimento.

4	 Selezionare Execute.
Il file proxy corrispondente al file selezionato 
viene registrato come operazione di 
trasferimento e l’upload ha inizio.
Non appena l’operazione di trasferimento 
viene registrata, appare la schermata dei 
risultati del trasferimento.

5	 Selezionare OK.

Upload di tutti i file
Per eseguire il trasferimento dei file proxy di 
tutti i file, selezionare All Clips invece di Select 
Clip al passo 2.

[Nota]
Possono essere trasferiti fino a 200 file.
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Caricamento dalla schermata delle 
miniature di un file originale contenuto 
in una scheda di memoria

1	 Collegare il camcorder al dispositivo 
tramite una connessione LAN 
(pagina 57).

2	 Selezionare Transfer Clip >Select Clip nel 
menu Thumbnail del menu completo.
Il display passa dal menu completo alla 
schermata delle miniature.
Il trasferimento dei clip può essere 
effettuato sia dalla schermata delle 
miniature che dalla schermata filtrata 
delle miniature dei clip.

3	 Selezionare il clip da trasferire, quindi 
premere il pulsante MENU.
Viene visualizzata una schermata di 
conferma del trasferimento.

4	 Selezionare Execute.
Il file selezionato viene registrato come 
operazione di trasferimento e l’upload ha 
inizio.
Non appena l’operazione di trasferimento 
viene registrata, appare la schermata dei 
risultati del trasferimento.

5	 Selezionare OK.

Upload di tutti i file
Per eseguire il trasferimento di tutti i file, 
selezionare All Clips invece di Select Clip al 
passo 2.

[Nota]
Possono essere trasferiti fino a 200 file.

Controllo del trasferimento del file

È possibile controllare lo stato del 
trasferimento dei file selezionando File 
Transfer >View Job List (pagina 99) nel 
menu Network del menu completo.
È possibile controllare lo stato del 
trasferimento dei file anche nella schermata 
dell’applicazione Content Browser Mobile.

[Informazione]
Se File Transfer >Auto Upload (Proxy) (pagina 99) 
nel menu Network del menu completo è impostato su 
On ed è presente una connessione di rete, i file proxy 
vengono automaticamente caricati sul server specificato 
in Default Upload Server (pagina 99) al termine della 
registrazione.

[Note]
ˎˎ Possono essere registrati fino a 200 trasferimenti.
ˎˎ L’elenco dei trasferimenti permane anche dopo lo 

spegnimento del camcorder, tuttavia potrebbero 
andare persi fino a 10 minuti di informazioni 
sull’avanzamento dell’operazione qualora venga 
rimosso il pacco batteria oppure venga interrotta 
l’alimentazione del camcorder senza aver prima 
spostato il selettore di alimentazione POWER su 
STANDBY.
ˎˎ I trasferimenti aggiunti dopo l’entrata in stato di bassa 

tensione non sono salvati nell’elenco delle operazioni.
ˎˎ Qualora si verificasse un errore durante il 

trasferimento di un file, il trasferimento di un clip con 
lo stesso nome di un clip trasferito potrebbe non 
venire ripreso, in base alle impostazioni e allo stato 
del server di destinazione del trasferimento. In tal 
caso, controllare le impostazioni e lo stato del server 
di destinazione del trasferimento.

Upload tramite Secure FTP

Per proteggere con crittografia l’upload di 
file, è possibile utilizzare il protocollo FTPS 
in modalità Explicit (FTPES) per realizzare la 
connessione con il file server di destinazione.

Configurazione del trasferimento in 
modalità Secure FTP

Per utilizzare il protocollo Secure FTP, 
impostare su ON l’opzione Using Secure 
Protocol sul file server di destinazione ed 
importare il relativo certificato.
Per informazioni dettagliate sulla 
configurazione, fare riferimento a 
“Registrazione di una destinazione di 
trasferimento file” (pagina 62).
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Schermata delle miniature
Quando si preme il pulsante THUMBNAIL (pagina 5), i clip registrati sulla scheda di memoria vengono visualizzati come miniature sullo schermo.
La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione. La riproduzione può essere visualizzata nel mirino e su un monitor esterno.
Premere di nuovo il pulsante THUMBNAIL per chiudere la schermata delle miniature e tornare all’immagine del camcorder.

[Nota]
La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un clip registrato che avrebbe dovuto essere presente non è visualizzato, controllare il formato di registrazione. Prestare 
attenzione a questo fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.

Elementi dello schermo

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui è posizionato il cursore.

4 5

6

3

1

2

Indicatore della scheda di memoria correntemente selezionata
(se la scheda è protetta, viene visualizzata l’icona del lucchetto).

Cursore (giallo)

Numero del clip/Numero totale di clip

1.	 Miniatura (immagine indice)
Visualizza l’immagine indice del clip. Quando 
si registra un clip, il primo fotogramma viene 
impostato automaticamente come immagine 
indice.
Sotto la miniatura vengono visualizzate 
informazioni sul clip e sul fotogramma. È 
possibile scegliere le informazioni visualizzate 
utilizzando la voce Customize View 

(pagina 93) >Thumbnail Caption nel menu 
Thumbnail del menu completo.

2.	 Nome del clip
Visualizza il nome del clip selezionato.

3.	 Formato di registrazione video
Visualizza il formato del file del clip 
selezionato.

4.	 Informazioni sulla registrazione speciale
Se il clip è stato registrato con una modalità di 
registrazione speciale, ne indica la modalità.
Se il clip è registrato in modalità Slow & 
Quick Motion, ne viene indicata la frequenza 
fotogrammi sulla destra.

5.	 Durata del clip

6.	 Data di creazione
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Riproduzione di clip

Riproduzione dei clip registrati

È possibile riprodurre i clip registrati mentre il 
camcorder si trova in modalità standby (Stby) 
di registrazione.

1	 Inserire la scheda di memoria da 
riprodurre.

2	 Premere il pulsante THUMBNAIL.

3	 Utilizzare il selettore multiplo 
(pagina 7) o la manopola 
multifunzione (pagina 5) per spostare 
il cursore sulla miniatura del clip da 
riprodurre.

4	 Premere il pulsante di conferma del 
selettore multiplo o la manopola 
multifunzione.
La riproduzione si avvia dall’inizio del clip 
selezionato.

È possibile comandare la riproduzione con i 
seguenti pulsanti:
Premere il pulsante di conferma del selettore 

multiplo o la manopola multifunzione: 
La riproduzione entra in pausa.  
Premere una seconda volta per tornare alla 
riproduzione normale.

Premere i pulsanti freccia sinistra o freccia 
destra del selettore multiplo: 
Salta rispettivamente all’inizio del clip 
corrente o all’inizio del clip successivo.

Premere e mantenere premuto il pulsante 
freccia sinistra o il pulsante freccia destra 
del selettore multiplo: 
Ritorno e avanzamento veloce.  
Torna alla riproduzione normale quando si 
rilascia il pulsante.

Pulsante CANCEL/BACK: 
Arresta la riproduzione e torna alla 
modalità standby di registrazione.

[Note]
ˎˎ Nel passaggio da un clip a un altro la visualizzazione 

dell’immagine potrebbe momentaneamente 
frazionarsi o arrestarsi. Durante questo periodo non è 
possibile azionare il camcorder.
ˎˎ Quando si seleziona un clip nella schermata delle 

miniature e ha inizio la riproduzione, potrebbero 
verificarsi temporanei frazionamenti dell’immagine 
all’inizio del clip. Per visualizzare l’inizio del clip senza 
frazionamenti, avviare la modalità di riproduzione, 
mettere in pausa, quindi utilizzare i pulsanti freccia 
sinistra o freccia destra del selettore multiplo 
per tornare all’inizio del clip, quindi riavviare la 
riproduzione.
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Nella schermata delle miniature è possibile 
eseguire operazioni di gestione dei clip e 
controllarne le proprietà tramite il menu 
Thumbnail del menu completo.
Per visualizzare il menu Thumbnail 
(pagina 93), mantenere premuto il pulsante 
MENU e selezionare Thumbnail.

Utilizzo del menu Thumbnail

Utilizzare il selettore multiplo (pagina 7) 
o la manopola multifunzione (pagina 5) 
per selezionare la funzione desiderata, quindi 
premere il pulsante di conferma del selettore 
multiplo o la manopola multifunzione.
Premere il pulsante CANCEL/BACK 
(pagina 5) per ritornare alla schermata 
precedente.

[Nota]
A seconda dello stato operativo del camcorder quando 
viene visualizzato il menu, alcune voci potrebbero non 
essere selezionabili.

Voci di menu per le operazioni sui 
clip

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Per informazioni dettagliate sulle voci di menu 
per le operazioni sui clip, fare riferimento al 
menu Thumbnail (pagina 93).

Displaying clip properties

Selezionare Display Clip Properties 
(pagina 93) nel menu Thumbnail per 
visualizzare la schermata delle proprietà dei 
clip.

Aggiunta di flag ai clip

È possibile aggiungere flag (ovvero 
contrassegni OK, NG o KP) ai clip per poterne 
in seguito filtrare la visualizzazione in base ad 
essi.
Selezionare la miniatura del clip a cui 
aggiungere il flag, quindi selezionare il tipo 
di flag desiderato mediante Set Clip Flag 
(pagina 93) nel menu Thumbnail del menu 
completo.

Impostazione Flag di clip aggiunto

Add OK OK

Add NG NG

Add KEEP KP

[Informazioni]
ˎˎ È possibile aggiungere flag ai clip anche mediante 

un pulsante programmabile a cui è assegnata la 
funzione di aggiunta di flag dei clip (pagina 49).
ˎˎ Per aggiungere un flag OK alla miniatura del clip 

selezionato (pagina 51) premere il pulsante Clip 
Flag (pagina 5).

Visualizzazione filtrata della schermata 
delle miniature dei clip

Selezionare Filter Clips (pagina 93) nel 
menu Thumbnail del menu completo, quindi 
selezionare il tipo di flag desiderato per 
visualizzare solo i clip che lo contengono.
Per visualizzare tutti i clip, selezionare All.

[Informazione]
È possibile passare da un filtro all’altro in sequenza 
anche premendo il pulsante DISPLAY.

Eliminazione di clip

I clip contenuti nelle schede di memoria 
possono essere eliminati secondo le proprie 
esigenze.
Selezionare Delete Clip >Select Clip o All Clips 
nel menu Thumbnail del menu completo.
Select Clip: 

Elimina il clip selezionato. È possibile 
selezionare più clip contemporaneamente.

All Clips: 
Elimina tutti i clip visualizzati.

Scelta delle informazioni visualizzate 
nella schermata delle miniature

È possibile scegliere le informazioni sui clip o 
sui fotogrammi visualizzate sotto la miniatura.
Selezionare Customize View >Thumbnail 
Caption nel menu Thumbnail del menu 
completo, quindi selezionare le informazioni 
da visualizzare.
Date Time: 

Visualizza la data e l’ora di creazione e 
dell’ultima modifica del clip.

Time Code: 
Visualizza il codice temporale.

Duration: 
Visualizza la durata del clip.

Sequential Number: 
Visualizza un numero sequenziale su ogni 
miniatura.

Operazioni con i clip
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Configurazione e struttura del menu completo
Premere e mantenere premuto il pulsante MENU 
per visualizzare nel mirino il menu completo che 
consente di specificare le opzioni necessarie 
per la ripresa, la registrazione e la riproduzione 
(il menu può essere visualizzato anche su un 
monitor esterno). Il menu completo comprende i 
menu indicati di seguito:

Configurazione dei menu

Menu User
Contiene voci di menu configurate 
dall’utente tramite la voce Edit User Menu.

Menu Edit User
Contiene comandi per la modifica del 
menu User.

Menu Shooting
Contiene opzioni relative alla ripresa.

Menu Project
Contiene le impostazioni di base del 
progetto.

Menu Paint/Look
Contiene opzioni relative alla qualità 
dell’immagine.

Menu TC/Media
Contiene impostazioni relative ai codici 
temporali e ai supporti di registrazione.

Menu Monitoring
Contiene impostazioni relative all’uscita 
video e alla visualizzazione sul mirino.

Menu Audio
Contiene opzioni relative all’audio.

Menu Thumbnail
Contiene opzioni relative alla 
visualizzazione delle miniature.

Menu Technical
Contiene le impostazioni relative agli 
elementi tecnici.

Menu Network
Contiene opzioni relative alle reti.

Menu Maintenance
Contiene le impostazioni del dispositivo 
stesso, ad esempio l’orologio e la lingua.

Struttura del menu completo

User 
(impostazioni di 
fabbrica)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

User Bits

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset
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Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Utilizzo del menu completo
Premere e mantenere premuto il pulsante 
MENU per visualizzare nel mirino il menu 
completo che consente di specificare nel 
dettaglio le varie impostazioni (il menu può 
essere visualizzato anche su un monitor 
esterno).

Comandi del menu

Pulsante MENU (pagina 5)
Premere e mantenere premuto per 
visualizzare il menu completo. Premere di 
nuovo mentre è visualizzato il menu 
completo per chiudere il menu.

Selettore multiplo (pulsante direzionale 
D-Pad a 8 posizioni e pulsante di conferma) 
(pagina 7)

Utilizzare i pulsanti direzionali D-Pad per 
spostare il cursore verso l’alto, il basso, 
sinistra o destra e selezionare voci o 
impostazioni del menu.
Premere il pulsante di conferma del 
selettore multiplo per applicare la voce 
selezionata.

Manopola multifunzione (pagina 5)
Ruotare la manopola multifunzione per 
spostare il cursore verso l’alto o il basso e 
selezionare voci o impostazioni del menu.
Premere la manopola multifunzione per 
applicare la voce selezionata.

Pulsante CANCEL/BACK (pagina 5)
Premere per tornare al menu precedente. 
Le modifiche non completate vengono 
annullate.

[Note]
ˎˎ Il menu completo non può essere utilizzato quando il 

camcorder si trova in modalità di ingrandimento della 
messa a fuoco (pagina 41).
ˎˎ A seconda dello stato operativo del camcorder 

quando viene visualizzato il menu, alcune voci 
potrebbero non essere selezionabili.

Impostazione delle voci dei menu

Premere i pulsanti direzionali D-pad o 
ruotare la manopola multifunzione per 
spostare il cursore sulla voce di menu da 
impostare, quindi premere il pulsante di 
conferma del selettore multiplo o la manopola 
multifunzione per selezionare la voce.
ˎˎ Nell’area di selezione delle voci del menu 
vengono visualizzate un massimo di otto 
righe. Se non possono essere visualizzate 
contemporaneamente tutte le opzioni 
disponibili per una determinata voce, 
scorrere le opzioni spostando il cursore 
verso l’alto o verso il basso.
ˎˎ Se la gamma di opzioni disponibili per una 
voce secondaria è molto ampia (ad esempio 
da –99 a + 99), l’area di selezione non viene 
visualizzata. Viene invece evidenziato il 
valore corrente per indicare che tale valore 
può essere modificato.
ˎˎ Per eseguire una funzione, selezionare 
[Execute].
ˎˎ Se si seleziona una voce che richiede 
conferma prima dell’esecuzione, il menu 
verrà momentaneamente nascosto e verrà 
visualizzato un messaggio di conferma. 
Controllare il messaggio e quindi scegliere 
se eseguire o annullare la funzione.

Immissione di una stringa di caratteri

Quando si seleziona una voce che richiede 
l’immissione di caratteri, viene visualizzata la 
schermata di inserimento caratteri.

1

2 3

1	 Premere i pulsanti direzionali D-pad o 
ruotare la manopola multifunzione per 
selezionare un tipo di caratteri, quindi 
applicare l’impostazione.
ABC: caratteri alfabetici maiuscoli
abc: caratteri alfabetici minuscoli
123: caratteri numerici
!#$: caratteri speciali

2	 Selezionare il carattere desiderato nel tipo 
di caratteri specificato, quindi applicare 
l’impostazione.
Il cursore si sposta sul campo successivo.

Space: inserisce uno spazio in 
corrispondenza della posizione del 
cursore.

/: sposta la posizione del cursore.
BS: elimina il carattere alla sinistra del 

cursore (backspace).

3	 Al termine, selezionare [Done] ed 
applicare l’impostazione.
La stringa di caratteri viene confermata e 
la schermata di inserimento dei caratteri si 
chiude.

Blocco e sblocco del menu

È possibile bloccare il menu completo in modo 
che venga visualizzato solo il menu User.
In questo stato, non è possibile modificare le 
impostazioni mediante le schermate di stato.

Blocco del menu

1	 Premere e mantenere premuta la 
manopola multifunzione, quindi premere 
e mantenere premuto il pulsante MENU.

2	 Selezionare Menu Settings >User Menu 
with Lock nel menu Technical.

	 [Nota]
Quando viene mantenuto premuto solo il pulsante 
MENU per visualizzare il normale menu completo, 
l’indicazione User Menu Only è visualizzata sotto 
Menu Settings nel menu Technical. Premere e 
mantenere premuta la manopola multifunzione e 
quindi premere e mantenere premuto il pulsante 
MENU per visualizzare User Menu with Lock.

3	 Impostare su On e premere il pulsante di 
conferma o la manopola multifunzione.
Lo schermo del mirino visualizza la 
schermata di immissione del numero di 
codice di accesso (PIN).

4	 Immettere un numero arbitrario.
Immettere un numero di 4 cifre compreso 
fra 0000 e 9999. Il valore predefinito è 0000.
Immettere un numero e premere il pulsante 
di conferma o la manopola multifunzione 
per spostare il cursore sulla cifra successiva.
Dopo aver immesso tutte le cifre, spostare 
il cursore su SET.

5	 Premere il pulsante di conferma o la 
manopola multifunzione.
Il valore immesso viene applicato.
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Viene visualizzato un messaggio di 
conferma e la schermata passa alla 
visualizzazione del menu User.

Sblocco del menu

1	 Premere e mantenere premuta la 
manopola multifunzione, quindi premere 
e mantenere premuto il pulsante MENU.

2	 Selezionare Menu Settings >User Menu 
with Lock nel menu User.

	 [Nota]
Quando viene mantenuto premuto solo il pulsante 
MENU per visualizzare il normale menu completo, 
l’indicazione User Menu Only è visualizzata sotto 
Menu Settings nel menu Technical. Premere e 
mantenere premuta la manopola multifunzione e 
quindi premere e mantenere premuto il pulsante 
MENU per visualizzare User Menu with Lock.

3	 Impostare su Off e premere il pulsante di 
conferma o la manopola multifunzione.
Lo schermo del mirino visualizza la 
schermata di immissione del numero di 
codice di accesso (PIN).

4	 Immettere il numero PIN usato per 
bloccare il menu.
Immettere un numero e premere il 
pulsante di conferma o la manopola 
multifunzione per spostare il cursore sulla 
cifra successiva.
Dopo aver immesso tutte le cifre, spostare 
il cursore su Set.

5	 Premere il pulsante di conferma o la 
manopola multifunzione.
Il valore immesso viene applicato.
Se il numero PIN immesso corrisponde al 
numero PIN utilizzato per bloccare il 
menu, il menu viene sbloccato e viene 
visualizzato.

[Note]
ˎˎ Se il numero PIN immesso non corrisponde al numero 

PIN utilizzato per bloccare il menu, il menu non verrà 
sbloccato.
ˎˎ Si consiglia di annotare il numero PIN per evitare di 

dimenticarlo. Se si dimentica il numero PIN, contattare 
il rappresentante dell’assistenza tecnica Sony.
ˎˎ Se il menu viene bloccato senza aver registrato le voci 

del menu completo elencate nelle seguenti tabelle 
del menu User, tali funzioni non potranno essere 
assegnate a pulsanti programmabili.
ˎˎ Se tali funzioni erano già assegnate a pulsanti 

programmabili, la loro assegnazione viene disabilitata 
automaticamente al momento del blocco del menu.

Voci del menu 
completo

Selezione per 
pulsanti 
programmabili

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Voci del menu 
completo

Selezione per 
pulsanti 
programmabili

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Voci del menu 
completo

Selezione per 
pulsanti 
programmabili

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Menu User
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.

User

Voce Descrizione

Base Setting Voce di menu Project >Base Setting

Focus Voce di menu Shooting >Focus

S&Q Motion Voce di menu Shooting >S&Q Motion

LUT On/Off Voce di menu Shooting >LUT On/Off

Simul Rec Voce di menu Project >Simul Rec

Proxy Rec Voce di menu Project >Proxy Rec

Interval Rec Voce di menu Project >Interval Rec

Assignable Button Voce di menu Project >Assignable Button

Assignable Dial Voce di menu Project >Assignable Dial

Multi Function Dial Voce di menu Project >Multi Function Dial

All File Voce di menu Project >All File

Clip Name Format Voce di menu TC/Media >Clip Name Format

Format Media Voce di menu TC/Media >Format Media

VF Setting Voce di menu Monitoring >VF Setting

Zebra Voce di menu Monitoring >Zebra

Zoom Voce di menu Technical >Zoom

Menu Settings Voce di menu Technical >Menu Settings

Edit User Menu Visualizza la schermata del menu Edit User.

[Nota]
Il menu Edit User consente di aggiungere o rimuovere voci del menu User. Possono essere configurate fino a 20 voci.



6. Menu visualizzati e impostazioni72

Menu Edit User
Selezionando Edit User Menu nel menu User, viene visualizzato il menu Edit User al livello più 
alto.

Edit User

Voce Impostazione della voce 
secondaria

Descrizione

Add Item
Aggiunge una voce al 
menu User

Aggiunge una voce al menu User.

Customize Reset
Ripristina le voci del 
menu User

Ripristina l’impostazione predefinita 
delle voci del menu User.

Voce di menu 
selezionata durante la 
modifica

Delete Rimuove dal menu User la voce di 
menu registrata.

Move Cambia l’ordine delle voci registrate 
del menu User.

Edit Sub Item Modifica (aggiunge o elimina) le voci 
secondarie registrate nel menu User.
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Menu Shooting
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Shooting >ISO/Gain/EI
Consente di specificare le impostazioni relative al guadagno.

Voce Impostazione della voce secondaria Descrizione

Mode ISO/dB Seleziona la modalità di impostazione del 
guadagno.

ISO/Gain<H> Per informazioni dettagliate su queste 
impostazioni, vedere “Impostazioni e valori 
predefiniti di ISO/Gain” (pagina 102).

Imposta il valore di preset del guadagno 
<H>.

ISO/Gain<M> Per informazioni dettagliate su queste 
impostazioni, vedere “Impostazioni e valori 
predefiniti di ISO/Gain” (pagina 102).

Imposta il valore di preset del guadagno 
<M>.

ISO/Gain<L> Per informazioni dettagliate su queste 
impostazioni, vedere “Impostazioni e valori 
predefiniti di ISO/Gain” (pagina 102).

Imposta il valore di preset del guadagno 
<L>.

Exposure 
Index<H>

Quando Base ISO è impostata su ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Quando Base ISO è impostata su ISO 
12800:

3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Imposta il valore dell’indice di 
esposizione <H>.
Disponibile solo in modalità Cine EI.

Shooting >ISO/Gain/EI
Consente di specificare le impostazioni relative al guadagno.

Voce Impostazione della voce secondaria Descrizione

Exposure 
Index<M>

(Stesse impostazioni di Exposure 
Index<H>)
Quando Base ISO è impostata su ISO 800:

1000EI / 6.3E
Quando Base ISO è impostata su ISO 12800:

16000EI / 6.3E

Imposta il valore dell’indice di 
esposizione <M>.

Exposure 
Index<L>

(Stesse impostazioni di Exposure 
Index<H>)
Quando Base ISO è impostata su ISO 800:

800EI / 6.0E
Quando Base ISO è impostata su ISO 12800:

12800EI / 6.0E

Imposta il valore dell’indice di 
esposizione <L>.

Shockless 
Gain

On / Off Attiva o disattiva la funzione di guadagno 
fluido.

Base 
Sensitivity

High / Low Imposta la sensibilità di base per le 
modalità SDR/HDR.

Base ISO ISO 12800 / ISO 800 Imposta la sensibilità ISO di base per la 
modalità Cine EI.

Shooting >ND Filter
Imposta i valori di preset del filtro ND.

Voce Impostazione della voce secondaria Descrizione

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Imposta il valore Preset 1 del filtro ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Imposta il valore Preset 2 del filtro ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Imposta il valore Preset 3 del filtro ND.

Shooting >Shutter
Consente di specificare le impostazioni relative alle condizioni di funzionamento dell’otturatore.

Voce Impostazione della voce secondaria Descrizione

Mode Speed / Angle Seleziona la modalità operativa 
dell’otturatore elettronico.
Consente di eseguire riprese nitide di 
soggetti in rapido movimento. Seleziona 
la modalità di impostazione della velocità 
dell’otturatore in secondi (Speed) o in 
gradi (Angle).

Shutter 
Speed  
On/Off

On / Off Specifica se il tempo di esposizione, 
quando è selezionata la modalità Speed, 
deve seguire il valore di Shutter Speed o 
deve essere impostato sulla massima 
esposizione.
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Shooting >Shutter
Consente di specificare le impostazioni relative alle condizioni di funzionamento dell’otturatore.

Voce Impostazione della voce secondaria Descrizione

Shutter 
Speed

Da 64F a 1/8000
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Imposta la velocità dell’otturatore 
quando Mode è impostato su Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Imposta l’angolo dell’otturatore quando 
Mode è impostato su Angle.

ECS On/Off On / Off Attiva o disattiva la funzione ECS 
(Extended Clear Scan).

Shooting >Shutter
Consente di specificare le impostazioni relative alle condizioni di funzionamento dell’otturatore.

Voce Impostazione della voce secondaria Descrizione

ECS 
Frequency

Da 23.99 a 8000
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
Di seguito si indicano i valori predefiniti.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Imposta la frequenza ECS quando Mode 
è impostato su ECS.

Shooting >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Voce Impostazione della voce secondaria Descrizione

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Imposta i livelli di luminosità per il valore 
di esposizione rilevato automaticamente.

Mode Backlight / Standard / Spotlight Specifica la modalità operativa della 
regolazione dell’esposizione automatica.
Backlight: 

Modalità controluce (i soggetti ripresi 
in controluce appaiono meno scuri)

Standard: 
Modalità standard

Spotlight: 
Modalità riflettore (limita il clipping 
dei bianchi quando il soggetto è 
illuminato da riflettori)

Speed Da –99 a +99 (±0) Imposta la velocità di regolazione della 
regolazione dell’esposizione automatica.

AGC On / Off Attiva o disattiva la funzione AGC 
(controllo del guadagno automatico).

AGC Limit Per informazioni dettagliate su queste 
impostazioni, vedere “Impostazioni e valori 
predefiniti di AGC Limit” (pagina 104).

Imposta il guadagno massimo della 
funzione AGC.

AGC Point F2.8 / F4 / F5.6 Imposta il valore di apertura (F-stop) del 
diaframma a cui ha inizio il 
funzionamento della funzione AGC 
quando la funzione AGC è On.
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Shooting >Auto Exposure
Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Voce Impostazione della voce secondaria Descrizione

Auto Shutter On / Off Attiva o disattiva la funzione di otturatore 
automatico.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Imposta la velocità massima della 
funzione di otturatore automatico.

A.SHT Point F5.6 / F8 / F11 / F16 Imposta il valore di apertura (F-stop) del 
diaframma a cui ha inizio il 
funzionamento della funzione di 
otturatore automatico.

Clip High 
light

On / Off Attiva o disattiva la funzione che ignora 
le zone più luminose per dare una 
risposta più piatta alle luminanze elevate.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Imposta il campo di misurazione della 
luce per la regolazione automatica della 
luce secondo la luminosità del soggetto. 
(Non disponibile quando l’esposizione 
viene regolata manualmente)

Detect Window 
Indication

On / Off Attiva o disattiva l’indicazione il campo di 
misurazione della luce.

Custom 
Width

Da 40 a 999 (500) Imposta la larghezza del campo di 
misurazione della luce.

Custom 
Height

Da 70 a 999 (500) Imposta l’altezza del campo di 
misurazione della luce.

Custom H 
Position

Da –479 a +479 (±0) Imposta la posizione orizzontale del 
campo di misurazione della luce.

Custom V 
Position

Da –464 a +464 (±0) Imposta la posizione verticale del campo 
di misurazione della luce.

Shooting >White
Specifica le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Preset White Da 2000K a 15000K (3200K) Imposta il valore di preset del 
bilanciamento del bianco.

Color Temp 
<A>

Da 2000K a 15000K (3200K) Imposta la temperatura di colore di 
bilanciamento del bianco salvata nella 
memoria A.

[Nota]
Poiché Color Temp è soggetto a clipping a 
2000K e 15000K mentre è attiva la funzione 
R/B Gain, potrebbe non essere visualizzato il 
valore di Color Temp corretto per il valore di 
R/B Gain.

Shooting >White
Specifica le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Tint<A> Da –99 a +99 (±0) Imposta il valore del tono di colore (Tint) 
salvato nella memoria del bianco A.

[Nota]
Poiché Tint è soggetto a clipping a ±99 mentre 
è attiva la funzione R/B Gain, potrebbe non 
essere visualizzato il valore di Tint corretto per 
il valore di R/B Gain.

R Gain <A> Da –99.0 a +99.0 (±0.0) Imposta il valore di guadagno R del 
bilanciamento del bianco salvato nella 
memoria A.

B Gain <A> Da –99.0 a +99.0 (±0.0) Imposta il valore di guadagno B del 
bilanciamento del bianco salvato nella 
memoria A.

Color Temp 
<B>

Da 2000K a 15000K (3200K) Imposta la temperatura di colore del 
bilanciamento del bianco salvata nella 
memoria B.

[Nota]
Poiché Color Temp è soggetto a clipping a 
2000K e 15000K mentre è attiva la funzione R/B 
Gain, potrebbe non essere visualizzato il valore 
di Color Temp corretto per il valore di R/B Gain.

Tint<B> Da –99 a +99 (±0) Imposta il valore del tono di colore (Tint) 
salvato nella memoria del bianco B.

[Nota]
Poiché Tint è soggetto a clipping a ±99 mentre 
è attiva la funzione R/B Gain, potrebbe non 
essere visualizzato il valore di Tint corretto per 
il valore di R/B Gain.

R Gain <B> Da –99.0 a +99.0 (±0.0) Imposta il valore del guadagno R del 
bilanciamento del bianco salvato nella 
memoria B.

B Gain <B> Da –99.0 a +99.0 (±0.0) Imposta il valore del guadagno B del 
bilanciamento del bianco salvato nella 
memoria B.
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Shooting >White Setting
Regola le impostazioni del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Shockless 
White

Off / 1 / 2 / 3 Imposta la velocità di risposta del 
bilanciamento del bianco quando si 
cambia la modalità di bilanciamento del 
bianco.
Off: Commutazione istantanea.
Da 1 a 3: Il passaggio avviene più 

lentamente (velocità minore con 
numero più alto).

ATW Speed 1 / 2 / 3 / 4 / 5 Imposta la velocità di risposta in modalità ATW.
1: Più alta velocità di risposta

White 
Switch<B>

Memory / ATW Seleziona la modalità di regolazione del 
bilanciamento del bianco che viene 
selezionata quando il selettore WHT BAL 
è impostato su B.

Filter White 
Memory

On / Off Attiva o disattiva la funzione che imposta 
l’area di memoria del bilanciamento del 
bianco per ciascun filtro ND.
On: Imposta una memoria del 

bilanciamento del bianco per ciascun 
filtro ND.

	 [Informazione]
In modalità Preset, sono disponibili 
quattro impostazioni (CLEAR / 1 / 2 / 3). 
In modalità variabile, sono disponibili due 
impostazioni (CLEAR / On).

Off: Imposta una memoria del 
bilanciamento del bianco comune a 
tutti i filtri ND.

Shooting >Offset White
Specifica le impostazioni di correzione (offset) del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Offset White 
<A>

On / Off Seleziona se aggiungere (On) o non 
aggiungere (Off) un valore di correzione 
al valore di bilanciamento del bianco 
della memoria A.

Offset Color 
Temp<A>

Da –99 a +99 (±0) Imposta la correzione della temperatura 
di colore da aggiungere al bilanciamento 
del bianco della memoria A quando 
Offset White <A> è impostato su On.

Shooting >Offset White
Specifica le impostazioni di correzione (offset) del bilanciamento del bianco.

Voce Impostazione della voce secondaria Descrizione

Offset 
Tint<A>

Da –99 a +99 (±0) Imposta la correzione del valore del tono di 
colore Tint da aggiungere al bilanciamento 
del bianco della memoria A quando Offset 
White <A> è impostato su On.

Offset White 
<B>

On / Off Seleziona se aggiungere (On) o non 
aggiungere (Off) un valore di correzione 
al valore di bilanciamento del bianco 
della memoria B.

Offset Color 
Temp<B>

Da –99 a +99 (±0) Imposta la correzione della temperatura 
di colore da aggiungere al bilanciamento 
del bianco della memoria B quando 
Offset White <B> è impostato su On.

Offset 
Tint<B>

Da –99 a +99 (±0) Imposta la correzione del valore del tono di 
colore Tint da aggiungere al bilanciamento 
del bianco della memoria B quando Offset 
White <B> è impostato su On.

Offset White 
<ATW>

On / Off Specifica se aggiungere (On) o non 
aggiungere (Off) un valore di correzione 
al bilanciamento del bianco ATW.

Offset Color 
Temp<ATW>

Da –99 a +99 (±0) Imposta la correzione della temperatura 
di colore da aggiungere al bilanciamento 
del bianco ATW quando Offset White 
<ATW> è impostato su On.

Offset 
Tint<ATW>

Da –99 a +99 (±0) Imposta la correzione del valore del tono 
di colore Tint da aggiungere al 
bilanciamento del bianco ATW quando 
Offset White <ATW> è impostato su On.

Shooting >Focus
Consente di specificare le impostazioni relative alla messa a fuoco.

Voce Impostazione della voce secondaria Descrizione

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Specifica la velocità dell’azionamento del 
sistema di messa a fuoco quando il 
soggetto cambia durante la messa a 
fuoco automatica.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Imposta la sensibilità al cambiamento del 
soggetto durante la messa a fuoco 
automatica.
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Shooting >Focus
Consente di specificare le impostazioni relative alla messa a fuoco.

Voce Impostazione della voce secondaria Descrizione

Focus Area Wide / Zone / Flexible Spot Specifica la zona di messa a fuoco per le 
funzioni di messa a fuoco automatica e 
Push Auto Focus (AF) (pagina 37).
Wide: 

Cerca il soggetto su un ampio angolo 
dell’immagine durante la messa a 
fuoco.

Zone: 
Cerca automaticamente una punto di 
messa a fuoco all’interno della zona 
specificata.

Flexible Spot: 
Mette a fuoco una posizione 
specificata dell’immagine.

Focus Area 
(AF-S)

Flexible Spot Specifica la zona di messa a fuoco per la 
funzione Push Auto Focus (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Abilita o disabilita la modalità AF con 
rilevamento del viso.

Push AF 
Mode

AF / Single-shot AF(AF-S) Imposta la modalità di messa a fuoco 
automatica Push.

AF Assist On / Off Quando è impostato su On, consente di 
ignorare momentaneamente la funzione 
di messa a fuoco automatica ed eseguire 
la messa a fuoco manualmente.

Shooting >S&Q Motion
Consente di specificare le impostazioni relative alla modalità Slow & Quick Motion (pagina 50).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità Slow & 
Quick Motion.
Quando è impostato su On, le seguenti 
funzioni sono disabilitate:

ˎˎ Auto Iris
ˎˎ Auto Focus

Frame Rate Da 1fps a 60fps / 100fps / 120fps / 150fps / 
180fps / 200fps / 240fps

Imposta la frequenza fotogrammi per le 
riprese in modalità Slow & Quick Motion.

[Nota]
I valori disponibili variano a seconda di 
frequenza di sistema, codec e formato video 
selezionati.

Shooting >LUT On/Off
Consente di specificare le impostazioni relative alla LUT.

Voce Impostazione della voce secondaria Descrizione

SDI/HDMI MLUT On / MLUT Off Seleziona se applicare la LUT monitor al 
video in uscita su SDI e HDMI.

VF/Proxy/
Stream

MLUT On / MLUT Off Seleziona se applicare la LUT monitor al 
video in uscita su mirino, proxy e in 
streaming.

Internal Rec MLUT On / MLUT Off Seleziona se applicare la LUT monitor al 
video in registrazione interna.

Shooting >Noise Suppression
Consente di specificare le impostazioni relative alla soppressione del rumore.

[Informazione]
Le impostazioni di Setting(Custom) e Level(Custom) sono riflesse nell’impostazione Target Display 
(pagina 106).

Voce Impostazione della voce secondaria Descrizione

Setting 
(Custom)

On / Off Attiva o disattiva la soppressione del 
rumore in modalità Custom.

Level 
(Custom)

Low / Mid / High Imposta il livello di soppressione del 
rumore in modalità Custom.

Setting 
(Cine EI)

On / Off Attiva o disattiva la soppressione del 
rumore in modalità Cine EI.

Level 
(Cine EI)

Low / Mid / High Imposta il livello di soppressione del 
rumore in modalità Cine EI.

Shooting >Flicker Reduce
Consente di specificare le impostazioni relative alla correzione dello sfarfallio.

Voce Impostazione della voce secondaria Descrizione

Mode Auto / On / Off Imposta la modalità di correzione dello 
sfarfallio.

Frequency 50Hz / 60Hz Consente di specificare la frequenza della 
sorgente di alimentazione del dispositivo 
di illuminazione che causa lo sfarfallio.

Shooting >SteadyShot
Consente di specificare le impostazioni relative alla stabilizzazione dell’immagine.

Voce Impostazione della voce secondaria Descrizione

Setting Active / Standard / Off Imposta la funzione di stabilizzazione 
dell’immagine.

[Nota]
Disponibile quando è montato un obiettivo 
compatibile.
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Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Project >Base Setting
Consente di specificare le impostazioni di base.

Voce Impostazione della voce secondaria Descrizione

Shooting 
Mode

Custom / Cine EI Imposta la modalità di ripresa 
(pagina 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Imposta lo spazio colore della 
registrazione o uscita in modalità Cine EI.

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce Impostazione della voce secondaria Descrizione

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Seleziona la frequenza di sistema.

Imager Scan 
Mode

FF / S35 Imposta la combinazione fra metodo di 
readout imager (tutti i pixel/binning 
pixel) e impostazione dimensioni imager.

Codec RAW / RAW & XAVC-I / XAVC-I / XAVC-L Imposta la modalità di registrazione/
riproduzione.

RAW Output 
Format

Le opzioni di impostazione disponibili 
variano a seconda delle impostazioni di 
Frequency e Codec.

Imposta il formato di registrazione per un 
registratore RAW esterno.

[Nota]
Quando Codec è impostato su RAW & XAVC-I, il 
valore di Video Format cambia in sincronia con 
l’impostazione di RAW Output Format.

Frequency Codec Opzioni 
selezionabili

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce Impostazione della voce secondaria Descrizione

Video Format Le opzioni di impostazione disponibili 
variano a seconda delle impostazioni di 
Frequency e Codec.

Imposta il formato di registrazione.

Frequency Codec Opzioni 
selezionabili

59.94 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

29.97 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Menu Project
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Project >Rec Format
Consente di specificare le impostazioni relative al formato di registrazione.

Voce Impostazione della voce secondaria Descrizione

Video Format 25 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

23.98 RAW –

RAW & 
XAVC-I

4096×2160P

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW –

RAW & 
XAVC-I

4096×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Specifica le impostazioni della modalità Cine EI.

Voce Impostazione della voce secondaria Descrizione

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Imposta lo spazio colore della modalità 
Cine EI.
S-Gamut3/SLog3: 

Imposta lo spazio colore della 
modalità Cine EI su S-Gamut3.

S-Gamut3.Cine/SLog3: 
Imposta lo spazio colore della 
modalità Cine EI su S-Gamut3.Cine.

Project >Simul Rec
Configura le impostazioni della modalità di registrazione simultanea (pagina 51).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di 
registrazione simultanea e specifica il 
supporto di destinazione della 
registrazione.

Project >Proxy Rec
Configura le impostazioni della modalità di registrazione proxy.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità di 
registrazione proxy.

Audio 
Channel

CH1/CH2 / CH3/CH4 Seleziona il canale audio da registrare sui 
dati proxy.

Project >Interval Rec
Configura le impostazioni della modalità di registrazione a intervalli (pagina 50).

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la modalità di 
registrazione a intervalli. (Attivando 
questa modalità, si disattivano tutte le 
altre modalità speciali).

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ore)

Imposta l’intervallo fra registrazioni nella 
modalità di registrazione Interval Rec 
(Interval Rec impostata su On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video 
selezionato.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Imposta il numero di fotogrammi per 
ciascuna ripresa nella modalità di 
registrazione Interval Rec (Interval Rec 
impostata su On).

Pre-Lighting Off / 2sec / 5sec / 10sec Specifica con che anticipo in secondi si 
deve accendere la luce video prima 
dell’avvio della registrazione in modalità 
Interval Rec.

[Informazione]
Disponibile solo se viene utilizzata la luce video 
HVL-LBPC (opzionale).
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Project >SDI/HDMI Rec Control
Consente di specificare le impostazioni relative alla registrazione SDI/HDMI.

Voce Impostazione della voce secondaria Descrizione

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Configura l’avvio e l’arresto della 
registrazione su un dispositivo esterno 
tramite i segnali di uscita SDI/HDMI.
Off: 

Comando a distanza disabilitato.
SDI/HDMI Remote I/F: 

Comando di avvio e arresto 
registrazione di un dispositivo 
esterno collegato, quando non è 
presente nessun supporto di 
memoria sul camcorder. Non 
sincronizzato con precisione di 
fotogramma con i supporti di 
memoria del camcorder.

Parallel Rec: 
Comando di avvio e arresto 
registrazione di un dispositivo 
esterno collegato, quando è presente 
un supporto di memoria sul 
camcorder. Sincronizzato con 
precisione di fotogramma con i 
supporti di memoria del camcorder.

[Nota]
Per il comando tramite il segnale di uscita 
HDMI, impostare HDMI TC Out >Setting 
(pagina 86) nel menu TC/Media del menu 
completo su On.

Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Auto Shutter / Auto Exposure Level / 
Backlight / Spotlight / Preset White 
Select / ATW / ATW Hold / AF Speed/
Sens. / Focus Setting / Focus Area / Focus 
Area(AF-S) / Face/Eye Detection AF / Push 
AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Rec Review / 
Clip Flag OK / Clip Flag NG / Clip Flag 
Keep / Color Bars / Tally [Front] / 
DURATION/TC/U-BIT / Display / Lens Info / 
Video Signal Monitor / Marker / VF 
Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Assegna funzioni ai pulsanti 
programmabili.
Base ISO/Sensitivity: 

Commuta la sensibilità di base del 
sensore immagine.

AGC: 
Attiva o disattiva la funzione AGC.

Push AGC: 
Attiva la funzione AGC mentre si 
tiene premuto il pulsante.

ND Filter Position: 
Consente di scegliere il filtro ND.

Auto ND Filter: 
Attiva o disattiva la funzione di filtro 
ND automatico.

Push Auto ND: 
Attiva la funzione di filtro ND 
automatico mentre si tiene premuto 
il pulsante.

Auto Iris: 
Attiva o disattiva la funzione diaframma.

Push Auto Iris: 
Abilita la funzione di diaframma 
automatico mentre si tiene premuto 
il pulsante.

Auto Shutter: 
Attiva o disattiva la funzione di 
otturatore automatico.

Auto Exposure Level: 
Apre o chiude il Direct Menu relativo 
al livello di esposizione automatica.

Backlight: 
Alterna fra Backlight e Standard.

Spotlight: 
Alterna fra Spotlight e Standard.

Preset White Select: 
Specifica il valore della modalità di 
preset del bilanciamento del bianco.

ATW: 
Attiva o disattiva la funzione ATW.

ATW Hold: 
Sospende la funzione ATW.
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Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a <9>, 
Focus Hold 
Button

AF Speed/Sens.: 
Selezione della velocità di transizione 
AF e della sensibilità al cambiamento 
del soggetto AF.

Focus Setting: 
Configura l’area di messa a fuoco. 

Focus Area: 
Configura l’area di messa a fuoco per 
AF e Push AF.

Focus Area(AF-S): 
Configura l’area di messa a fuoco per 
Push AF (AF-S).

Face/Eye Detection AF: 
Selezione delle impostazioni di 
messa a fuoco automatica con 
rilevamento del viso o degli occhi.

Push AF Mode: 
Selezione dell’impostazione della 
modalità Push AF.

Push AF/Push MF: 
In modalità messa a fuoco MF, attiva 
la modalità AF mentre il pulsante 
viene mantenuto premuto. 
In modalità messa a fuoco AF, attiva 
la modalità MF mentre il pulsante 
viene mantenuto premuto.

Focus Hold: 
In modalità messa a fuoco AF, fissa la 
messa a fuoco mentre il pulsante 
viene mantenuto premuto.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Attiva o disattiva la funzione di 
ingrandimento per la messa a fuoco.

S&Q Motion: 
Attiva o disattiva la modalità Slow & 
Quick Motion. 
Se mantenuto premuto, imposta la 
frequenza fotogrammi di ripresa.

SteadyShot: 
Consente di selezionare Active, 
Standard o Off. 

Rec: 
Avvia o arresta la registrazione.

Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a <9>, 
Focus Hold 
Button

Rec Review: 
Attiva o disattiva la funzione Rec Review.

Clip Flag OK: 
Esegue la funzione Add OK. 
Premere due volte per eseguire 
Delete Clip Flag.

Clip Flag NG: 
Esegue la funzione Add NG. 
Premere due volte per eseguire 
Delete Clip Flag.

Clip Flag Keep: 
Esegue la funzione Add Keep. 
Premere due volte per eseguire 
Delete Clip Flag.

Color Bars: 
Attiva o disattiva la visualizzazione 
della barra colori.

Tally [Front]: 
Attiva o disattiva l’illuminazione o il 
lampeggio della spia di 
registrazione/tally.

DURATION/TC/U-BIT: 
Alterna fra Time Code, Users Bit e 
Duration.

Display: 
Attiva o disattiva la visualizzazione 
degli indicatori a schermo.

Lens Info: 
Specifica la modalità dell’indicatore 
della profondità di campo.

Video Signal Monitor: 
Attiva una modalità di monitor del 
segnale video (ad esempio il monitor 
della forma d’onda).

Marker: 
Attiva o disattiva la funzione Marker.
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Project >Assignable Button
Assegna le funzioni desiderate ai pulsanti programmabili.

Voce Impostazione della voce secondaria Descrizione

Da <1> a <9>, 
Focus Hold 
Button

VF Adjust: 
Visualizza le barre di livello per la 
regolazione della luminosità dello 
schermo del mirino.

VF Mode: 
Consente di scegliere se visualizzare 
l’immagine del mirino a colori o in 
bianco e nero.

Gamma Display Assist: 
Commuta la funzione di assistenza 
per la visualizzazione gamma.

Peaking: 
Attiva o disattiva la funzione Peaking.

Zebra: 
Attiva o disattiva la funzione Zebra.

Volume: 
Regola il livello di uscita dell’audio di 
monitoraggio su jack cuffie e 
altoparlante incorporato.

Thumbnail: 
Apre o chiude la schermata delle 
miniature.

Touch Operation: 
Attiva o disattiva la funzionalità del 
touchscreen.

Handle Zoom: 
Specifica la modalità di funzionamento 
dello zoom della maniglia.

NFC: 
Esegue la funzione NFC.

Auto Upload (Proxy): 
Attiva o disattiva il trasferimento 
automatico dei file proxy.

Direct Menu: 
Visualizza o chiude il Direct Menu.

User Menu: 
Visualizza o chiude il menu User.

Menu: 
Visualizza o chiude il menu completo.

Project >Assignable Dial
Assegna le funzioni desiderate alla manopola programmabile e ne imposta la direzione di 
rotazione.

Voce Impostazione della voce secondaria Descrizione

Grip/Remote
Dial

Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level

Assegna funzioni alla manopola 
programmabile.
ISO/Gain/EI: 

Regola il guadagno o l’EI.
ND Filter: 

Regola il filtro ND.
IRIS: 

Regola il diaframma.
Auto Exposure Level: 

Regola il livello di esposizione 
automatica.

Audio Input Level: 
Regola il livello di registrazione audio.

Grip Dial 
Direction

Normal / Opposite Specifica la direzione di rotazione della 
manopola programmabile 
dell’impugnatura.
Normal: Ruota nella direzione normale.
Opposite: Ruota in senso inverso.

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Assegna funzioni alla manopola 
programmabile della maniglia.
ISO/Gain/EI: 

Regola il guadagno o l’EI.
ND Filter: 

Regola il filtro ND.
IRIS: 

Regola il diaframma.
Auto Exposure Level: 

Regola il livello di esposizione 
automatica.

Audio Input Level: 
Regola il livello di registrazione audio.

Multi Function Dial: 
Agisce come manopola 
multifunzione.

Handle Dial 
Direction

Normal / Opposite Specifica la direzione di rotazione della 
manopola programmabile della maniglia.
Normal: Ruota nella direzione normale.
Opposite: Ruota in senso inverso.
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Project >Multi Function Dial
Assegna funzioni alla manopola multifunzione.

Voce Impostazione della voce secondaria Descrizione

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Assegna la funzione di default alla 
manopola multifunzione.
IRIS: 

Regola il diaframma.
ISO/Gain/EI: 

Regola il guadagno o l’EI.
Auto Exposure Level: 

Regola il livello di esposizione 
automatica.

Audio Input Level: 
Regola il livello di registrazione audio.

Project >User File
Specifica impostazioni relative alla gestione dei file utente.

Voce Impostazione della voce secondaria Descrizione

Load 
Media(B)

Execute / Cancel Carica le impostazioni di file utente da 
una scheda di memoria inserita nello slot 
per schede CFexpress Type A/SD (B).
Execute: Esegue la funzione.

Save 
Media(B)

Execute / Cancel Salva le impostazioni di file utente su una 
scheda di memoria inserita nello slot per 
schede CFexpress Type A/SD (B).
Execute: Esegue la funzione.

File ID Visualizza una schermata che mostra e 
consente di modificare l’ID dei file utente.

Load 
Customize 
Data

On / Off Specifica se caricare le informazioni 
personalizzate del menu User quando 
viene eseguito Load Media(B).

Load White 
Data

On / Off Specifica se caricare le informazioni 
relative al bilanciamento del bianco 
quando viene eseguito Load Media(B).

Project >All File
Consente di specificare le impostazioni relative ai file ALL.

Voce Impostazione della voce secondaria Descrizione

Load 
Media(B)

Execute / Cancel Carica un file ALL
Execute: Esegue la funzione.

Save 
Media(B)

Execute / Cancel Salva un file ALL.
Execute: Esegue la funzione.

File ID Assegna un nome al file.

Project >All File
Consente di specificare le impostazioni relative ai file ALL.

Voce Impostazione della voce secondaria Descrizione

Load Network 
Data

On / Off Specifica se caricare le informazioni sulle 
impostazioni del menu Network quando 
viene eseguito Load Media(B).
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Menu Paint/Look
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Paint/Look >Scene File
Consente di specificare le impostazioni relative ai file di scena.

Voce Impostazione della voce secondaria Descrizione
Recall Carica un file di scena memorizzato nella 

memoria interna e ne applica le 
impostazioni come impostazioni attive 
per la qualità dell’immagine.

Store Salva in un file di scena nella memoria 
interna lo stato corrente delle 
impostazioni relative alla qualità 
dell’immagine.

Delete Elimina un file di scena memorizzato nella 
memoria interna.

Preset Recall Quando Shooting Mode è impostata su 
Custom e Target Display è impostato su 
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Quando Shooting Mode è impostata su 
Custom e Target Display è impostato su 
HDR(HLG):

HLG Live / HLG Natural

Applica valori preconfigurati delle 
impostazioni di qualità dell’immagine 
(non riscrivibili) alle impostazioni di 
qualità dell’immagine correnti.

Paint/Look >Base Look
Configura impostazioni relative al look di base.

Voce Impostazione della voce secondaria Descrizione
Select Quando Shooting Mode è impostata su 

Custom e Target Display è impostato su 
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
da User1 a User16

Quando Shooting Mode è impostata su 
Custom e Target Display è impostato su 
HDR(HLG):

HLG Live / HLG Natural / da User1 a 
User16

Quando Shooting Mode è impostata su 
Cine EI:

s709 / 709(800) / S-Log3 / da User1 a 
User16

Seleziona un look di base.

Delete Elimina il look di base selezionato.
Delete All Elimina tutti i look di base.
Import Carica un file di look di base da un 

supporto di registrazione.

Paint/Look >Base Look
Configura impostazioni relative al look di base.

Voce Impostazione della voce secondaria Descrizione
Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Imposta la gamma di ingresso del look di 

base selezionato.
Output BT.709 / HLG Imposta la gamma di colore di uscita del 

look di base selezionato.
AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Imposta il valore di riferimento per 
l’esposizione del look di base selezionato.

Paint/Look >Reset Paint Settings
Resetta le impostazioni del menu Paint/Look, con l’esclusione del look di base.

Voce Impostazione della voce secondaria Descrizione
Reset without 
Base Look

Execute / Cancel Resetta le impostazioni del menu Paint/
Look, con l’esclusione del look di base.
Execute: Esegue la funzione.

Paint/Look >Black
Consente di specificare le impostazioni relative al nero.

Voce Impostazione della voce secondaria Descrizione

Master Black Da –99.0 a +99.0 (±0.0) Imposta il livello del nero master.

R Black Da –99.0 a +99.0 (±0.0) Imposta il livello R del nero.

B Black Da –99.0 a +99.0 (±0.0) Imposta il livello B del nero.

Paint/Look >Knee
Consente di specificare le impostazioni relative alla correzione del knee.

Voce Impostazione della voce secondaria Descrizione

Setting Quando Target Display è impostato su 
SDR(BT.709):

On / Off / ---
Quando Target Display è impostato su 
HDR(HLG):

On / Off / ---

Attiva o disattiva la funzione di 
correzione del knee.

Auto Knee Quando Target Display è impostato su 
SDR(BT.709):

On / Off / ---
Quando Target Display è impostato su 
HDR(HLG):

On / Off / ---

Attiva o disattiva la funzione di 
correzione del knee automatica.

Point Da 75% a 109% (90%) Imposta il punto knee.

Slope Da –99 a +99 (±0) Imposta la pendenza del knee.
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Paint/Look >Detail
Specifica le impostazioni di regolazione del dettaglio.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di 
regolazione del dettaglio.

Level Da –7 a +7 (±0) Imposta il livello del dettaglio.

Manual 
Setting

On / Off / --- Attiva o disattiva la funzione di 
regolazione manuale del dettaglio.

V/H Balance Da –2 a +2 (±0) Imposta il bilanciamento tra verticale (V) 
e orizzontale (H) per la regolazione 
manuale del dettaglio.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Imposta il bilanciamento tra il dettaglio 
del nero (B) per le zone a bassa 
luminanza e il dettaglio del bianco (W) 
per le zone ad alta luminanza nella 
regolazione manuale del dettaglio.

Limit Da 0 a 7 Imposta il livello di limite del dettaglio 
per la regolazione manuale del dettaglio.

Crispening Da 0 a 7 Imposta il livello di miglioramento della 
nitidezza per la regolazione manuale del 
dettaglio.

High Light 
Detail

Da 0 a 4 Imposta il livello di dettaglio per le zone 
ad alta luminanza nella regolazione 
manuale del dettaglio.

Paint/Look >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce Impostazione della voce secondaria Descrizione

User Matrix On / Off Attiva o disattiva la funzione di matrice 
dell’utente.

User Matrix 
Level

Da –99 a +99 (±0) Regola la saturazione del colore 
dell’intera immagine.

User Matrix 
Phase

Da –99 a +99 (±0) Regola il tono di colore (la fase) 
dell’intera immagine.

User Matrix 
R-G

Da –99 a +99 (±0) Imposta una matrice R-G definita 
dall’utente.

User Matrix 
R-B

Da –99 a +99 (±0) Imposta una matrice R-B definita 
dall’utente.

User Matrix 
G-R

Da –99 a +99 (±0) Imposta una matrice G-R definita 
dall’utente.

User Matrix 
G-B

Da –99 a +99 (±0) Imposta una matrice G-B definita 
dall’utente.

Paint/Look >Matrix
Consente di specificare le impostazioni relative alla correzione della matrice.

Voce Impostazione della voce secondaria Descrizione

User Matrix 
B-R

Da –99 a +99 (±0) Imposta una matrice B-R definita 
dall’utente.

User Matrix 
B-G

Da –99 a +99 (±0) Imposta una matrice B-G definita 
dall’utente.

Paint/Look >Multi Matrix
Consente di specificare le impostazioni relative alla correzione multimatrice.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la correzione 
multimatrice.

Reset Execute / Cancel Ripristina i valori di default di tonalità 
(hue) e saturazione del colore di ciascun 
asse.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Seleziona l’asse.

Hue Da –99 a +99 (±0) Imposta la tonalità (hue) del colore per la 
correzione multimatrice.

Saturation Da –99 a +99 (±0) Imposta la saturazione del colore 
utilizzato per la correzione multimatrice.
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Menu TC/Media
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

TC/Media >Timecode
Consente di specificare le impostazioni relative al codice temporale.

Voce Impostazione della voce secondaria Descrizione

Mode Preset / Regen / Clock Imposta la modalità di avanzamento del 
codice temporale.
Preset: 

Si avvia da un valore preimpostato.
Regen: 

Prosegue dal codice temporale della 
fine del clip precedente.

Clock: 
Utilizza l’orologio interno come 
codice temporale.

Run Rec Run / Free Run Rec Run: Avanza solo durante la 
registrazione.

Free Run: Avanzamento costante, 
indipendentemente dall’accensione 
del camcorder.

Setting Imposta il codice temporale su un valore 
arbitrario.
SET: Imposta il valore.

Reset Execute / Cancel Azzera il codice temporale (00:00:00:00).
Execute: Esegue la funzione.

TC Format DF / NDF Imposta il formato del codice temporale.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Consente di specificare le impostazioni di visualizzazione dei dati temporali.

Voce Impostazione della voce secondaria Descrizione

Display Select Timecode / Users Bit / Duration Consente di scegliere quali dati temporali 
devono essere visualizzati.

TC/Media >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce Impostazione della voce secondaria Descrizione

Mode Fix / Time Imposta la modalità del bit utente.
Fix: Utilizza per i bit utente un valore fisso 

arbitrario.
Time: Utilizza l’ora corrente nei bit utente.

TC/Media >Users Bit
Consente di specificare le impostazioni relative ai bit utente.

Voce Impostazione della voce secondaria Descrizione

Setting Imposta i bit utente su un valore 
arbitrario.

TC/Media >HDMI TC Out
Consente di specificare le impostazioni relative all’uscita del codice temporale quando si utilizza 
HDMI.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Consente di selezionare se emettere il 
codice temporale ad altri dispositivi per 
altri scopi, tramite HDMI.
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TC/Media >Clip Name Format
Configura impostazioni relative al nome e all’eliminazione di clip.

Voce Impostazione della voce secondaria Descrizione

Title Prefix nnn_ (nnn = le ultime 3 cifre del numero di 
serie)
(sono visualizzati max. 7 caratteri)

Imposta la sezione del titolo (da 4 a 46 
caratteri) del nome del clip.
Apre una schermata per l’immissione di 
una stringa di caratteri.

Struttura della schermata di 
immissione delle stringhe di caratteri
Area di selezione del carattere (3 righe): 

Consente di selezionare i caratteri da 
inserire alla posizione del cursore 
nell’area Title Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Area di operatività del cursore (1 riga): 
Spazio: Inserisce uno spazio in 
corrispondenza della posizione del 
cursore.  
: Sposta il cursore a sinistra.  
: Sposta il cursore a destra.  
BS: Elimina il carattere alla sinistra del 
cursore.

Area Title Prefix (1 riga): 
Area per l’immissione del titolo.

Impostazione del titolo
1.	 Utilizzando il selettore multiplo 

(pagina 7), selezionare il carattere 
da immettere alla posizione del 
cursore nell’area Title Prefix 
scegliendolo nell’area di selezione 
caratteri, quindi premere il pulsante 
di conferma del selettore multiplo. (Il 
carattere selezionato viene inserito e 
il cursore si sposta verso destra).

2.	 Ripetere il punto 1 per impostare il 
titolo. (utilizzare BS secondo 
necessità).

3.	 Dopo aver impostato il titolo, 
selezionare Done per chiudere la 
schermata di immissione dei caratteri.

TC/Media >Clip Name Format
Configura impostazioni relative al nome e all’eliminazione di clip.

Voce Impostazione della voce secondaria Descrizione

Number Set Da 0001 a 9999 Imposta il suffisso di 4 cifre aggiunto al 
nome del clip.

TC/Media >Update Media
Aggiorna il file di gestione delle schede di memoria.

Voce Impostazione della voce secondaria Descrizione

Media(A) Execute / Cancel Aggiorna il file di gestione della scheda 
di memoria nello slot A.
Execute: Esegue la funzione.

Media(B) Execute / Cancel Aggiorna il file di gestione della scheda 
di memoria nello slot B.
Execute: Esegue la funzione.

TC/Media >Format Media
Inizializza le schede di memoria.

Voce Impostazione della voce secondaria Descrizione

Media(A) Full Format / Quick Format / Cancel Formatta la scheda di memoria nello slot A.

Media(B) Full Format / Quick Format / Cancel Formatta la scheda di memoria nello slot B.
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Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Monitoring >Output On/Off
Consente di specificare le impostazioni relative all’uscita video.

Voce Impostazione della voce secondaria Descrizione

SDI On / Off Attiva o disattiva l’uscita SDI.

HDMI On / Off Attiva o disattiva l’uscita HDMI.

Monitoring >Output Format
Consente di specificare le impostazioni relative al formato di uscita.

Voce Impostazione della voce secondaria Descrizione

SDI Per informazioni dettagliate su queste 
impostazioni, vedere “Formati di uscita e 
limitazioni” (pagina 113).

Imposta la risoluzione delle uscite SDI e 
HDMI.HDMI

Monitoring >Output Display
Consente di specificare le impostazioni relative al segnale di uscita.

Voce Impostazione della voce secondaria Descrizione

SDI On / Off Mostra se informazioni di stato e menu 
sono incorporate nel segnale di uscita 
SDI.

HDMI On / Off Mostra se informazioni di stato e menu 
sono incorporate nel segnale di uscita 
HDMI.

Monitoring >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce Impostazione della voce secondaria Descrizione

Network 
Status

On / Off Seleziona gli elementi da visualizzare nel 
mirino.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Menu Monitoring
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Monitoring >Display On/Off
Consente di specificare le impostazioni di visualizzazione delle indicazioni.

Voce Impostazione della voce secondaria Descrizione

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la visualizzazione di 
tutti gli indicatori.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Seleziona il colore del segnale 
dell’indicatore.

Center Maker 1 / 2 / 3 / 4 / Off Seleziona l’indicatore del centro 
immagine.

Safety Zone On / Off Attiva o disattiva la visualizzazione 
dell’indicatore della zona di sicurezza.

Safety Area 80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore 
della zona di sicurezza come percentuale 
delle dimensioni totali dello schermo.

Aspect 
Marker

Line / Mask / Off Seleziona il tipo di indicatore di aspetto.

Aspect Mask Da 0 a 15 (12) Imposta il livello del segnale video 
all’esterno dell’indicatore.

Aspect Safety 
Zone

On / Off Attiva o disattiva la visualizzazione della 
zona di sicurezza di aspetto.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Seleziona le dimensioni dell’indicatore 
della zona di sicurezza di aspetto come 
percentuale delle dimensioni totali dello 
schermo.

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Imposta la modalità di visualizzazione 
dell’indicatore di aspetto.

Custom 
Aspect Ratio

Consente di immettere un valore arbitrario 
(01.00:01.00)

Imposta il rapporto di aspetto su un 
valore arbitrario.

[Nota]
Questa impostazione è disponibile solo 
quando Aspect Select è impostato su Custom.

Guide Frame On / Off Attiva o disattiva la visualizzazione del 
riquadro di guida.

100% Marker On / Off Attiva o disattiva la visualizzazione 
dell’indicatore 100%.

User Box On / Off Attiva o disattiva la visualizzazione del 
riquadro utente.

User Box 
Width

Da 3 a 479 (240) Specifica la larghezza del riquadro utente 
(distanza dal centro ai bordi destro e 
sinistro).
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Monitoring >Marker
Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce Impostazione della voce secondaria Descrizione

User Box 
Height

Da 3 a 269 (135) Specifica l’altezza del riquadro utente 
(distanza dal centro ai bordi superiore e 
inferiore).

User Box H 
Position

Da –476 a +476 (0) Specifica la posizione orizzontale del 
centro del riquadro utente.

User Box V 
Position

Da –266 a +266 (0) Specifica la posizione verticale del centro 
del riquadro utente.

Monitoring >VF Setting
Consente di specificare le impostazioni relative al mirino.

Voce Impostazione della voce secondaria Descrizione

Brightness Da 1 a 15 (8) Regola la luminosità dell’immagine del 
mirino.

Color Mode Color / B&W Seleziona la modalità di visualizzazione 
del mirino in modalità di registrazione o 
E-E.

Monitoring >Gamma Display Assist
Configura le impostazioni di assistenza visualizzazione gamma.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione di 
assistenza alla visualizzazione gamma 
nella modalità Custom quando Target 
Display è impostato su HDR(HLG).

Monitoring >Peaking
Consente di specificare le impostazioni relative al peaking.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione Peaking.

Peaking Level High / Mid / Low Imposta il livello di segnale del peaking 
del colore.

Color B&W / Red / Yellow / Blue Seleziona il colore del segnale di peaking 
colore.

Monitoring >Zebra
Consente di specificare le impostazioni del motivo zebra.

Voce Impostazione della voce secondaria Descrizione

Setting Off / Zebra1 / Zebra2 Seleziona il tipo di motivo zebra (Off, 
Zebra 1, Zebra 2).

Monitoring >Zebra
Consente di specificare le impostazioni del motivo zebra.

Voce Impostazione della voce secondaria Descrizione

Zebra1 Level Da 0% a 109% (70%) Imposta il livello di visualizzazione del 
motivo Zebra 1.

Zebra1 
Aperture 
Level

Da 2% a 20% (10%) Imposta il livello di apertura del motivo 
Zebra 1.

Zebra2 Level Da 0% a 109% (100%) Imposta il livello di visualizzazione del 
motivo Zebra 2.
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Menu Audio
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).
Fare riferimento a “Diagrammi a blocchi” (pagina 128).

Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Seleziona la sorgente di ingresso per la 
registrazione sul canale 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Seleziona la sorgente di ingresso per la 
registrazione sul canale 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Seleziona la sorgente di ingresso per la 
registrazione sul canale 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Seleziona la sorgente di ingresso per la 
registrazione sul canale 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Imposta il livello di riferimento di 
registrazione dell’ingresso microfono XLR 
su INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Imposta il livello di riferimento di 
registrazione dell’ingresso microfono XLR 
su INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Seleziona il livello di riferimento di 
ingresso quando il selettore INPUT1/
INPUT2 è impostato su LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Seleziona il livello di registrazione del 
segnale di tono di riferimento a 1 kHz.

CH1 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 1.

CH2 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 2.

CH3 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 3.

CH4 Wind 
Filter

On / Off Abilita o disabilita il filtro di riduzione del 
rumore del vento per la registrazione del 
canale 4.

Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

CH3 Level 
Control

Auto / Manual Seleziona la regolazione del livello di 
ingresso audio automatica o manuale 
per la registrazione sul canale 3.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, CH4 viene 
impostato su automatico o manuale in accordo 
con questa impostazione.

CH4 Level 
Control

Auto / Manual Seleziona la regolazione del livello di 
ingresso audio automatica o manuale 
per la registrazione sul canale 4.

[Nota]
Se CH3 Input Select e CH4 Input Select sono 
entrambi impostati su Internal MIC, CH4 viene 
impostato su automatico o manuale in accordo 
l’impostazione di CH3 Level Control.

CH3 Input 
Level

Da 0 a 99 (49) Imposta il livello di ingresso per la 
registrazione sul canale 3.

CH4 Input 
Level

Da 0 a 99 (49) Imposta il livello di ingresso per la 
registrazione sul canale 4.

Audio Input 
Level

Da 0 a 99 Imposta il livello di ingresso audio.
Utilizzabile come volume master secondo 
le impostazioni delle opzioni CH Level da 
1 a 4.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Seleziona la caratteristica di limitazione 
per i segnali di ingresso di livello elevato 
quando il livello di ingresso audio viene 
regolato manualmente.

CH1&2 AGC 
Mode

Mono / Stereo Imposta la modalità di regolazione livello 
automatica per la registrazione sui canali 
1 e 2. Quando è selezionato Stereo, la 
regolazione AGC agisce 
contemporaneamente sui due canali.

CH3&4 AGC 
Mode

Mono / Stereo Imposta la modalità di regolazione livello 
automatica per la registrazione sui canali 
3 e 4. Quando è selezionato Stereo, la 
regolazione AGC agisce 
contemporaneamente sui due canali.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Seleziona la caratteristica AGC.
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Audio >Audio Input
Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della voce secondaria Descrizione

1kHz Tone on 
Color Bars

On / Off Attiva o disattiva l’emissione del segnale 
di tono di riferimento a 1 kHz durante la 
visualizzazione delle barre colore.

[Nota]
Se impostato su On, viene impostato il 
segnale di tono di riferimento a 1 kHz per la 
registrazione sui canali 3 e 4, anche se CH3 
Input Select e CH4 Input Select sono impostati 
su Off.

CH1 Level Ingresso senza adattatore XLR
Audio Input Level / Side / Level+Side

Ingresso con adattatore XLR (pagina 48)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 1.

[Nota]
“Side” indica la manopola AUDIO LEVEL (CH1) 
sul lato del camcorder. Se è selezionato 
Level+Side, il livello di registrazione audio è 
determinato dalla combinazione di Audio 
Input Level e la posizione della manopola 
(pagina 128).

CH2 Level Ingresso senza adattatore XLR
Audio Input Level / Side / Level+Side

Ingresso con adattatore XLR (pagina 48)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 2.

[Nota]
“Side” indica la manopola AUDIO LEVEL (CH2) 
sul lato del camcorder. Se è selezionato 
Level+Side, il livello di registrazione audio è 
determinato dalla combinazione di Audio 
Input Level e la posizione della manopola 
(pagina 128).

CH3 Level Ingresso senza adattatore XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Ingresso con adattatore XLR (pagina 48)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 3.

CH4 Level Ingresso senza adattatore XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Ingresso con adattatore XLR (pagina 48)
Audio Input Level / Through

Imposta la combinazione delle 
regolazioni del livello di ingresso audio 
abilitate per la registrazione del canale 4.

Audio >Audio Output
Consente di specificare le impostazioni relative all’uscita audio.

Voce Impostazione della voce secondaria Descrizione

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Seleziona l’uscita del canale audio sul 
jack cuffie e l’altoparlante incorporato.

[Nota]
Se l’audio è impostato per l’uscita simultanea 
su più di un canale, il livello di uscita di ciascun 
canale viene ridotto per evitare il clipping.

Volume Da 0 a 50 Regola il livello di uscita dell’audio di 
monitoraggio su jack cuffie e altoparlante 
incorporato.

Headphone 
Out

Mono / Stereo Specifica se l’uscita del jack cuffie deve 
essere mono o stereo.

Alarm Level Da 0 a 7 (4) Regola il volume dell’allarme.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Imposta la combinazione dei canali audio 
sull’uscita HDMI.



6. Menu visualizzati e impostazioni93

Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Thumbnail

Voce Impostazione della voce secondaria Descrizione

Display Clip 
Properties

Visualizza la schermata delle proprietà 
dei clip.

Thumbnail >Set Clip Flag
Consente di specificare le impostazioni relative ai flag dei clip.

Voce Impostazione della voce secondaria Descrizione

Add OK Aggiunge un flag OK.

Add NG Aggiunge un flag NG.

Add KEEP Aggiunge un flag Keep.

Delete Clip 
Flag

Elimina tutti i flag.

Thumbnail >Lock/Unlock Clip
Consente di specificare le impostazioni relative alla protezione dei clip.

Voce Impostazione della voce secondaria Descrizione

Select Clip Seleziona e blocca/sblocca un clip.

Lock All Clips Blocca tutti i clip.

Unlock All 
Clips

Sblocca tutti i clip.

Thumbnail >Delete Clip
Elimina clip.

Voce Impostazione della voce secondaria Descrizione

Select Clip Elimina il clip selezionato.

All Clips Elimina tutti i clip.

Thumbnail >Transfer Clip
Trasferisce clip.

[Nota]
Transfer Clip non è configurabile quando non è stata definita la voce Access Authentication >Password del 
menu Network.

Voce Impostazione della voce secondaria Descrizione

Select Clip Trasferisce i clip selezionati.

All Clips Trasferisce tutti i clip.

[Nota]
È possibile trasferire fino a 200 clip.

Thumbnail >Transfer Clip (Proxy)
Trasferisce clip proxy.

[Nota]
Transfer Clip (Proxy) non è configurabile quando non è stata definita la voce Access Authentication >Password 
del menu Network.

Voce Impostazione della voce secondaria Descrizione

Select Clip Trasferisce i clip proxy corrispondenti ai 
clip selezionati.

All Clips Trasferisce i clip proxy corrispondenti a 
tutti i clip.

[Nota]
È possibile trasferire fino a 200 clip.

Thumbnail >Filter Clips
Consente di specificare le impostazioni relative ai clip da visualizzare.

Voce Impostazione della voce secondaria Descrizione

OK Visualizza solo i clip che contengono un 
flag OK.

NG Visualizza solo i clip che contengono un 
flag NG.

KEEP Visualizza solo i clip che contengono un 
flag Keep.

None Visualizza solo i clip che non contengono 
nessun flag.

All Visualizza tutti i clip, indipendentemente 
dalla presenza o meno di flag.

Thumbnail >Customize View
Consente di scegliere la visualizzazione delle miniature.

Voce Impostazione della voce secondaria Descrizione

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Seleziona le informazioni visualizzate 
sotto le miniature.

Menu Thumbnail
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Menu Technical
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Technical >Color Bars
Consente di specificare le impostazioni della barra colori.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la barra colori.

Type ARIB / 100% / 75% / SMPTE Seleziona il tipo di barra colori.

Technical >ND Dial
Consente di specificare le impostazioni relative al funzionamento della manopola ND VARIABLE.

Voce Impostazione della voce secondaria Descrizione

CLEAR with 
Dial

On / Off Specifica se abilitare o meno l’attivazione 
del filtro ND (CLEAR  On) tramite la 
manopola ND VARIABLE.

Technical >Tally
Configura impostazioni per la spia di registrazione/tally.

Voce Impostazione della voce secondaria Descrizione

Front On / Off Accende o spegne la spia di 
registrazione/tally (anteriore).

Rear On / Off Accende o spegne la spia di 
registrazione/tally (posteriore).

Technical >HOLD Switch Setting
Consente di specificare le impostazioni relative al selettore HOLD.

Voce Impostazione della voce secondaria Descrizione

with Rec 
Button

On / Off Consente di scegliere se bloccare il 
funzionamento del pulsante START/STOP 
registrazione.

with Hand 
Grip Remote

On / Off Consente di scegliere se bloccare il 
funzionamento dell’impugnatura di 
telecomando.

Technical >Touch Operation
Configura impostazioni relative al funzionamento del touchscreen.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzionalità del 
touchscreen.

Technical >Rec Review
Consente di specificare impostazioni relative alla revisione della registrazione.

Voce Impostazione della voce secondaria Descrizione

Setting 3sec / 10sec / Clip Seleziona la durata della riproduzione dei 
clip appena registrati per la loro revisione.

Technical >Zoom
Consente di specificare impostazioni relative allo zoom.

Voce Impostazione della voce secondaria Descrizione

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Imposta il tipo di zoom.
Optical Zoom Only: 

Lo zoom ottico viene regolato 
azionando l’obiettivo.

On(Clear Image Zoom): 
Zoom elettronico con scarso o 
nessun deterioramento della qualità 
dell’immagine.

Technical >Handle Zoom
Consente di specificare le impostazioni relative allo zoom della maniglia.

Voce Impostazione della voce secondaria Descrizione

Setting Off / Low / High / Variable Imposta la velocità dello zoom della 
maniglia.

High Da 1 a 8 (8) Imposta la velocità dello zoom della 
maniglia quando è selezionata la velocità 
High.

Low Da 1 a 8 (3) Imposta la velocità dello zoom della 
maniglia quando è selezionata la velocità 
Low.

[Nota]
Valori molto bassi di velocità dello zoom 
potrebbero influire negativamente 
sull’uniformità dell’azione di zoom.
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Technical >Menu Settings
Consente di specificare impostazioni relative alle voci del menu.

Voce Impostazione della voce secondaria Descrizione

User Menu 
Only

On / Off Specifica se visualizzare solo il menu User 
(On) o l’elenco dei menu (Off) quando il 
camcorder visualizza il menu.

User Menu 
with Lock

On / Off Specifica se bloccare o meno la 
visualizzazione del menu, mostrando 
solo il menu User.

[Nota]
Nella visualizzazione normale del menu, questa 
voce non è visualizzata. Per informazioni 
dettagliate sulla visualizzazione dei menu, 
vedere pagina 69.

Technical >Fan Control
Consente di specificare le impostazioni di comando della ventola.

Voce Impostazione della voce secondaria Descrizione

Setting Auto / Minimum / Off in Rec Imposta la modalità di controllo della 
ventola del camcorder.

[Nota]
Anche se è selezionata l’opzione Off in 
Rec, il ventilatore si attiva ugualmente se la 
temperatura interna del camcorder raggiunge 
un determinato valore.

Technical >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Voce Impostazione della voce secondaria Descrizione

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Imposta la direzione della ghiera dello 
zoom.

[Nota]
Abilitato solo quando si utilizza un obiettivo 
con innesto E-mount che consente la scelta 
della direzione di azionamento della ghiera 
dello zoom.

Shading 
Compensation

Auto / Off Attiva o disattiva la funzione di 
compensazione dello shading.

Chroma 
Aberration 
Comp.

Auto / Off Attiva o disattiva la funzione di 
compensazione automatica 
dell’aberrazione cromatica.

Distortion 
Comp.

Auto / Off Attiva o disattiva la funzione di 
correzione automatica della distorsione.

Technical >Lens
Consente di specificare le impostazioni relative agli obiettivi.

Voce Impostazione della voce secondaria Descrizione

Distance 
Display

Meter / Feet Specifica le unità di misura visualizzate 
per informazioni sull’obiettivo e sulla 
posizione di messa a fuoco.

Zoom 
Position 
Display

Focal Length / Number / Bar Specifica il formato di visualizzazione 
della posizione dello zoom.

Technical >Video Light Set
Specifica il metodo di illuminazione della luce video. Disponibile solo se viene utilizzata la luce 
video HVL-LBPC (opzionale).

Voce Impostazione della voce secondaria Descrizione

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Imposta il metodo di controllo 
dell’illuminazione per la luce video 
montata sulla slitta Multi-interface.
Power Link: 

Accende e spegne la luce video in 
sincronia con l’accensione o 
spegnimento del camcorder.

Rec Link: 
Accende e spegne la luce video in 
sincronia con l’avvio e l’arresto della 
registrazione.

Rec Link + Stby: 
Accende e mette in standby la luce 
video in sincronia con l’avvio e 
l’arresto della registrazione.

Technical >APR
Esegue la funzione APR.

Voce Impostazione della voce secondaria Descrizione

APR Execute / Cancel Esegue la funzione APR di ricostruzione 
automatica pixel per la regolazione 
automatica del sensore di immagine.
Execute: Esegue la funzione.

[Nota]
Montare sempre il coperchietto dell’obiettivo 
prima di eseguire la funzione APR.
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Technical >Camera Battery Alarm
Consente di specificare le impostazioni relative all’allarme per bassa tensione batteria.

Voce Impostazione della voce secondaria Descrizione

Low Battery 5% / 10% / 15% / … / 45% / 50% Imposta il livello di carica rimanente della 
batteria per la visualizzazione 
dell’allarme di bassa tensione batteria (in 
incrementi del 5%).

Battery 
Empty

Da 3% a 7% Imposta il livello di carica rimanente della 
batteria per la visualizzazione 
dell’allarme batteria scarica.

Technical >Camera DC IN Alarm
Consente di specificare le impostazioni relative all’allarme della tensione di ingresso.

Voce Impostazione della voce secondaria Descrizione

DC Low 
Voltage1

Da 16.0V a 19.0V (16.5V) Imposta la tensione alla quale 
visualizzare l’allarme di bassa tensione su 
ingresso DC IN.

DC Low 
Voltage2

Da 15.5V a 18.5V Imposta la tensione alla quale 
visualizzare l’allarme di tensione su 
ingresso DC IN insufficiente.
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Menu Network
Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Network >Access Authentication
Consente di specificare le impostazioni relative all’autenticazione.

Voce Impostazione della voce secondaria Descrizione

User Name Specifica il nome utente per 
l’autenticazione di accesso.

Password Specifica la password per l’autenticazione 
di accesso.

Network >Wireless LAN
Consente di specificare le impostazioni relative alle connessioni su LAN wireless.

Voce Impostazione della voce secondaria Descrizione

Setting Access Point Mode / Station Mode / Off Seleziona la modalità di funzionamento 
della connessione LAN wireless.

WPS Execute / Cancel Stabilisce una connessione tramite WPS 
(Wi-Fi Protected Setup).
Execute: Esegue la funzione.

NFC Execute / Cancel Stabilisce una connessione tramite NFC 
(Near Field Communication).
Execute: Esegue la funzione.

MAC Address Visualizza l’indirizzo MAC dell’interfaccia 
LAN wireless del camcorder.

Network >AP Mode Settings
Consente di specificare le impostazioni relative alle connessioni in modalità punto di accesso.

Voce Impostazione della voce secondaria Descrizione

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Imposta il canale della LAN wireless.
L’opzione Auto(5GHz) è disponibile solo 
sul modello ILME‑FX6V/VK.

Camera SSID 
& Password

Visualizza SSID e password del 
camcorder.

Regenerate 
Password

Execute / Cancel Crea una nuova password.
Execute: Esegue la funzione.

IP Address Visualizza l’indirizzo IP del camcorder in 
modalità punto di accesso.

Subnet Mask Visualizza la subnet mask del camcorder 
in modalità punto di accesso.

Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce Impostazione della voce secondaria Descrizione

Camera 
Remote 
Control

Enable / Disable Specifica se abilitare o meno il comando 
a distanza da un dispositivo connesso al 
camcorder tramite LAN wireless in 
modalità Station.

Connected 
Network

Visualizza la rete LAN wireless collegata 
(punto di accesso).

SSID Visualizza il SSID del punto di accesso a 
cui connettersi.

Security Visualizza il tipo di protezione della 
connessione al punto di accesso.

Password Visualizza la password della connessione 
al punto di accesso.
Quando Security è impostata su WEP o 

WPA: *******
Quando Security è impostata su None: 

(vuoto)

DHCP Indica se DHCP è attivo o no.

IP Address Visualizza l’indirizzo IP del camcorder 
quando DHCP è impostato su Off.

Subnet Mask Visualizza la subnet mask del camcorder 
quando DHCP è impostato su Off.

Gateway Visualizza il default gateway del 
camcorder quando DHCP è impostato su 
Off.

DNS Auto Indica se l’acquisizione del DNS è attiva o 
no.

Primary DNS Server Visualizza il server DNS primario del 
camcorder quando DNS Auto è impostata 
su Off.

Secondary DNS Server Visualizza il server DNS secondario del 
camcorder quando DNS Auto è impostata 
su Off.
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Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce Impostazione della voce secondaria Descrizione

Scan 
Networks

Rileva e visualizza un elenco delle reti 
LAN wireless (punto di accesso).
Seleziona nell’elenco la destinazione del 
collegamento.

SSID Visualizza il SSID del punto di accesso a 
cui connettersi.

Security Visualizza il tipo di protezione della 
connessione al punto di accesso.

Password Immettere la password per la 
connessione al punto di accesso.

DHCP 
On / Off

Attiva o disattiva DHCP.

IP Address Consente di immettere l’indirizzo IP del 
camcorder quando DHCP è impostato su 
Off.

Subnet Mask Consente di immettere la subnet mask 
del camcorder quando DHCP è impostato 
su Off.

Gateway Consente di immettere il default gateway 
del camcorder quando DHCP è impostato 
su Off.

DNS Auto 
On / Off

Attiva o disattiva la funzione di 
acquisizione automatica del DNS.

Primary DNS Server Consente di immettere il server DNS 
primario del camcorder quando DNS 
Auto è impostata su Off.

Secondary DNS Server Consente di immettere il server DNS 
secondario del camcorder quando DNS 
Auto è impostata su Off.

Network >ST Mode Settings
Consente di specificare impostazioni relative alle connessioni in modalità stazione.

Voce Impostazione della voce secondaria Descrizione

Manual 
Register

Registra le impostazioni per la 
connessione manuale a un punto di 
accesso.

SSID Consente di immettere il SSID del punto 
di accesso a cui connettersi.

Security 
None / WEP / WPA

Consente di scegliere il tipo di protezione 
della connessione al punto di accesso. 
Selezionare WPA se il tipo di protezione 
del punto di accesso di destinazione è 
WPA o WPA2.

Password Immettere la password per la 
connessione al punto di accesso.

DHCP 
On / Off

Attiva o disattiva DHCP.

IP Address Consente di immettere l’indirizzo IP del 
camcorder quando DHCP è impostato su 
Off.

Subnet Mask Consente di immettere la subnet mask 
del camcorder quando DHCP è impostato 
su Off.

Gateway Consente di immettere il default gateway 
del camcorder quando DHCP è impostato 
su Off.

DNS Auto 
On / Off

Attiva o disattiva la funzione di 
acquisizione automatica del DNS.

Primary DNS Server Consente di immettere il server DNS 
primario quando DNS Auto è impostata 
su Off.

Secondary DNS Server Consente di immettere il server DNS 
secondario quando DNS Auto è 
impostata su Off.



6. Menu visualizzati e impostazioni: Menu Network99

Network >Wired LAN
Consente di specificare le impostazioni relative alle connessioni su LAN cablata.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la funzione LAN cablata.

Camera 
Remote 
Control

Enable / Disable Specifica se abilitare o meno il comando 
a distanza da un dispositivo connesso al 
camcorder tramite LAN cablata.

Detail 
Settings

Configura le proprietà della connessione 
LAN cablata.

DHCP 
On / Off

Attiva o disattiva DHCP.

IP Address Consente di immettere l’indirizzo IP del 
camcorder quando DHCP è impostato su 
Off.

Subnet Mask Consente di immettere la subnet mask 
del camcorder quando DHCP è impostato 
su Off.

Gateway Consente di immettere il default gateway 
del camcorder quando DHCP è impostato 
su Off.

DNS Auto 
On / Off

Attiva o disattiva la funzione di 
acquisizione automatica del DNS.

Primary DNS Server Consente di immettere il server DNS 
primario quando DNS Auto è impostata 
su Off.

Secondary DNS Server Consente di immettere il server DNS 
secondario quando DNS Auto è 
impostata su Off.

Network >Modem
Consente di specificare impostazioni relative al tethering USB.

Voce Impostazione della voce secondaria Descrizione

Setting On / Off Attiva o disattiva la connessione tramite 
smartphone.

Camera 
Remote 
Control

Enable / Disable Specifica se consentire la connessione 
per l’accesso da Content Browser Mobile 
mediante uno smartphone.

Device Name Visualizza il nome di dispositivo dello 
smartphone.

IP Address Visualizza l’indirizzo IP dello smartphone.

Subnet Mask Visualizza la subnet mask dello 
smartphone.

Network >File Transfer
Consente di specificare impostazioni relative al trasferimento di file.

Voce Impostazione della voce secondaria Descrizione

Auto Upload 
(Proxy)

On / Off Attiva o disattiva il trasferimento 
automatico dei file proxy.

Default 
Upload 
Server

Seleziona il server per l’upload dei file. Il 
server selezionato qui diventa la 
destinazione per il caricamento dei file 
dalla schermata delle miniature e il 
caricamento automatico dei file proxy.
Mostra il nome di visualizzazione 
configurato in Server Settings da 1 a 3.

Clear 
Completed 
Jobs

Execute / Cancel Rimuove dall’elenco i trasferimenti 
completati.
Execute: Esegue la funzione.

Clear All Jobs Execute / Cancel Rimuove tutti i trasferimenti dall’elenco.
Execute: Esegue la funzione.

View Job List Visualizza l’elenco dei file da trasferire.
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Network >File Transfer
Consente di specificare impostazioni relative al trasferimento di file.

Voce Impostazione della voce secondaria Descrizione

Server 
Settings1

Display Name Imposta il nome di visualizzazione 
mostrato nel menu di configurazione 
della destinazione di trasferimento.

Service 
FTP

Visualizza il tipo di server.

Host Name Imposta il nome host del server di 
destinazione del trasferimento.

Port (da 1 a 65535 (21)) Imposta il numero della porta del server 
di destinazione del trasferimento.

User Name Imposta il nome utente per 
l’autenticazione della connessione con il 
server di destinazione del trasferimento.

Password Imposta la password per l’autenticazione 
della connessione con il server di 
destinazione del trasferimento.

Passive Mode 
On / Off

Attiva o disattiva la modalità PASV.

Destination Directory Immettere il nome della directory di 
destinazione del trasferimento.

Using Secure Protocol 
On / Off

Specifica se utilizzare (On) o non 
utilizzare (Off) la modalità di 
trasferimento Secure FTP (FTPS Explicit 
Mode: FTPES).

Root Certificate 
Load / Clear / None

Carica un certificato radice per il 
trasferimento in modalità Secure FTP ed 
annulla le impostazioni.

Root Certificate Status 
Loaded / No Certificate

Visualizza lo stato del caricamento del 
certificato radice per il trasferimento in 
modalità Secure FTP.

Reset 
Execute / Cancel

Ripristina sui valori predefiniti le 
impostazioni di Server Settings.
Execute: Esegue la funzione.

Server 
Settings2

Come Server Settings1.

Server 
Settings3

Come Server Settings1.

Network >Network Reset
Ripristina le impostazioni di rete.

Voce Impostazione della voce secondaria Descrizione

Reset Execute / Cancel Ripristina le impostazioni di rete.
Execute: Esegue la funzione.
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Questa sezione descrive le funzioni e le impostazioni di ciascuna voce di menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB).

Maintenance >Language
Imposta la lingua di visualizzazione.

Voce Impostazione della voce secondaria Descrizione

Select Imposta la lingua di visualizzazione.
SET: Imposta la lingua.

Maintenance >Clock Set
Consente di specificare le impostazioni relative all’orologio interno.

Voce Impostazione della voce secondaria Descrizione

Time Zone Da UTC –12:00 a UTC +14:00 Imposta la differenza rispetto all’ora UTC 
in passi di 30 minuti.

Date Mode YYMMDD / MMDDYY / DDMMYY Seleziona il formato di visualizzazione 
della data.
YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno

12H/24H 12H / 24H Seleziona il formato di visualizzazione 
dell’ora.
12H: Orologio a 12 ore
24H: Orologio a 24 ore

Date Imposta la data corrente.
SET: Imposta il valore.

Time Imposta l’ora corrente.
SET: Imposta il valore.

Maintenance >All Reset
Ripristina i valori predefiniti di fabbrica di tutte le impostazioni.

Voce Impostazione della voce secondaria Descrizione

Reset Execute / Cancel Ripristina i valori predefiniti di fabbrica di 
tutte le impostazioni.
Execute: Esegue la funzione.

[Nota]
Il file 3D LUT importato utilizzando Base Look 
>Import (pagina 84) nel menu Paint/Look 
è eliminato. Per eliminare tutti i file 3D LUT, 
selezionare Base Look >Delete All nel menu 
Paint/Look (pagina 84).

Reset without 
Network

Execute / Cancel Ripristina le impostazioni predefinite di 
fabbrica dei menu, eccetto le 
impostazioni del menu Network.

Maintenance >Hours Meter
Visualizza il tempo cumulativo di funzionamento.

Voce Impostazione della voce secondaria Descrizione

Hours 
(System)

Visualizza le ore d’uso totali (non può 
essere azzerato).

Hours (Reset) Visualizza le ore d’uso totali (può essere 
azzerato).

Reset Execute / Cancel Azzera l’indicazione Hours (Reset).
Execute: Esegue la funzione.

Maintenance >Version
Visualizza informazioni sulla versione.

Voce Impostazione della voce secondaria Descrizione

Version 
Number

Vx.xx Visualizza la versione del software del 
camcorder.

Version Up Execute / Cancel Aggiorna il camcorder.*

Execute: Esegue la funzione.
*	 Questa funzione aggiorna il software del 

camcorder.

Lens Version 
Number

Vxx Visualizza la versione del software 
dell’obiettivo E-mount.

Menu Maintenance
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Impostazioni e valori predefiniti del menu Shooting

Impostazioni e valori predefiniti di ISO/Gain

Il campo di valori configurabili e i valori predefiniti di ISO/Gain (pagina 73) variano in base alle impostazioni di Mode, Target Display, Base Look >Select e Base Sensitivity. Le opzioni disponibili 
sono evidenziate in grigio.

Quando Mode è impostato su ISO

Target Display SDR(BT.709) HDR(HLG) Comuni a SDR(BT.709) e HDR(HLG)

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural Da User1 a User16

Base Sensitivity Low High Low High Low High

ISO 320 Impostaz. predef. ISO/Gain<L>

ISO 400

ISO 500

ISO 640 Impostaz. predef. ISO/Gain<M>

ISO 800 Impostaz. predef. ISO/Gain<L> Impostaz. predef. ISO/Gain<L>

ISO 1000

ISO 1250 Impostaz. predef. ISO/Gain<H>

ISO 1600 Impostaz. predef. ISO/Gain<M> Impostaz. predef. ISO/Gain<M>

ISO 2000

ISO 2500

ISO 3200 Impostaz. predef. ISO/Gain<H> Impostaz. predef. ISO/Gain<H>

ISO 4000

ISO 5000 Impostaz. predef. ISO/Gain<L>

ISO 6400

ISO 8000

ISO 10000 Impostaz. predef. ISO/Gain<M>

ISO 12800 Impostaz. predef. ISO/Gain<L> Impostaz. predef. ISO/Gain<L>

ISO 16000

ISO 20000 Impostaz. predef. ISO/Gain<H>

ISO 25600 Impostaz. predef. ISO/Gain<M> Impostaz. predef. ISO/Gain<M>

ISO 32000

ISO 40000

ISO 51200 Impostaz. predef. ISO/Gain<H> Impostaz. predef. ISO/Gain<H>

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Quando Mode è impostato su dB

Impostazioni disponibili

–3dB

–2dB

–1dB

0dB Impostaz. predef. ISO/Gain<L>

1dB

2dB

3dB

4dB

5dB

6dB Impostaz. predef. ISO/Gain<M>

7dB

8dB

9dB

10dB

11dB

12dB Impostaz. predef. ISO/Gain<H>

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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Impostazioni e valori predefiniti di AGC Limit

Il campo di valori configurabili e i valori predefiniti di AGC Limit (pagina 74) variano in base alle impostazioni di Mode, Target Display, Base Look >Select e Base Sensitivity. Le opzioni disponibili 
sono evidenziate in grigio.

Quando Mode è impostato su ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) Comuni a SDR(BT.709) e HDR(HLG)

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural Da User1 a User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 Impostazione predefinita

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Impostazione predefinita Impostazione predefinita Impostazione predefinita

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 Impostazione predefinita

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Impostazione predefinita Impostazione predefinita Impostazione predefinita

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Quando Mode è impostato su dB

Impostazioni disponibili

3dB

6dB

9dB

12dB

15dB Impostazione predefinita

18dB

21dB

24dB

27dB

30dB
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Impostazioni di qualità dell’immagine salvate per ciascuna modalità di ripresa
In questa sezione si indica in che modo viene salvato lo stato corrente delle voci di configurazione relative alla qualità dell’immagine nelle modalità di ripresa elencate di seguito (pagina 24). Al 
cambiamento della modalità di ripresa, le impostazioni salvate corrispondenti vengono applicate alla nuova modalità di ripresa.
ˎˎ Modalità personalizzata SDR(BT.709)
ˎˎ Modalità personalizzata HDR(HLG)
ˎˎ Modalità Cine EI

Di seguito si indicano quali voci di configurazione relative alla qualità dell’immagine sono salvate per le varie modalità di ripresa.
Si: impostazione salvata.
No: impostazione non salvata.

Voce di configurazione Modalità di ripresa

Modalità Custom Modalità Cine EI

SDR(BT.709) HDR(HLG)

Menu Shooting ISO/Gain/EI ISO/Gain Sì1) No

Exposure Index No Sì

Base Sensitivity Sì No

Base ISO No Sì

White Preset White Sì Sì

Tutte le altre voci Sì

White Setting Sì

Offset White Sì No

LUT On/Off No Sì

Noise Suppression Setting(Custom) Sì Sì No

Level(Custom) Sì Sì No

Setting(Cine EI) No Sì

Level(Cine EI) No Sì

Menu Paint/Look Base Look Select Sì Sì Sì

Input2) Sì

Output2) Sì

AE Level Offset2) Sì

Black Sì Sì No

Knee Auto Knee Sì No No

Tutte le altre voci Sì Sì No

Detail Sì Sì No

Matrix Sì Sì No

Multi Matrix Sì Sì No

1)	 Per le due modalità Custom SDR(BT.709) e HDR(HLG) vengono salvati valori di sensibilità ISO separati.
2)	Le impostazioni vengono salvate per ciascun Base Look e non dipendono dalla modalità di ripresa.
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Dati di configurazione

Le impostazioni del menu completo possono 
essere salvate su una scheda di memoria 
inserita nello slot per schede CFexpress Type 
A/SD (B). Questo consente di richiamare 
rapidamente un set di impostazioni 
precedentemente ottimizzato per la situazione 
attuale.
I dati di configurazione sono salvati nelle 
categorie indicate di seguito.

File utente
I file utente consentono di salvare le 
impostazioni e i dati del menu User 
personalizzabile.
Su ciascuna scheda di memoria possono 
essere salvati fino a 64 file.
Caricando questo file nella memoria del 
camcorder, è possibile personalizzare la 
configurazione del menu User.

File ALL (tutte le impostazioni)
I file ALL salvano i dati di configurazione di 
tutti i menu. Su ciascuna scheda di memoria 
possono essere salvati fino a 64 file.

[Nota]
I dati specifici di dispositivo (shading, livelli di uscita ed 
altri dati che richiedono una regolazione specifica per 
ogni dispositivo) non vengono salvati.

Salvataggio di file utente o file 
ALL

1	 Inserire una scheda di memoria nello slot 
per schede CFexpress Type A/SD (B) 
(pagina 6).
ˎˎ Per le schede CFexpress, l’etichetta è 
rivolta a sinistra.
ˎˎ Per le schede SD, l’etichetta è rivolta a 
destra con l’angolo tagliato in basso.

2	 Per un file utente, selezionare User File 
>Save Media(B) (pagina 83) >Execute 
nel menu Project del menu completo.
Per un file ALL, selezionare All File >Save 
Media(B) (pagina 83) >Execute nel 
menu Project del menu completo.
Viene visualizzata la schermata di 
destinazione per il salvataggio del file.

3	 Selezionare una riga con l’indicazione “No 
File” nella schermata della destinazione 
del salvataggio.
Se la riga selezionata contiene già un File 
ID, il file selezionato viene sovrascritto.
Il File ID viene generato automaticamente, 
ma è possibile modificarlo.

4	 Selezionare Execute nella schermata di 
conferma.

Caricamento di file utente o file 
ALL

1	 Inserire la scheda di memoria su cui è 
salvato il file nello slot per schede 
CFexpress Type A/SD (B) (pagina 6).
ˎˎ Per le schede CFexpress, l’etichetta è 
rivolta a sinistra.
ˎˎ Per le schede SD, l’etichetta è rivolta a 
destra con l’angolo tagliato in basso.

2	 Per un file utente, selezionare User File 
>Load Media(B) (pagina 83) >Execute 
nel menu Project del menu completo.
Per un file ALL, selezionare All File >Load 
Media(B) (pagina 83) >Execute nel 
menu Project del menu completo.
Viene visualizzato un elenco dei file.

3	 Selezionare un file da caricare.
Viene visualizzata una schermata di 
conferma.

4	 Selezionare Execute.

[Note]
ˎˎ Al termine del caricamento dei dati di configurazione 

l’unità si riavvia automaticamente.
ˎˎ Quando All File >Load Network Data nel menu Project 

del menu completo è impostato su Off, saranno 
caricate tutte le impostazioni contenute nel file ALL, 
eccetto le impostazioni del menu Network.

Modifica del File ID

1	 Per un file utente, selezionare User File 
>File ID (pagina 83) nel menu Project 
del menu completo.
Per un file ALL, selezionare All File >File ID 
(pagina 83) nel menu Project del menu 
completo.
Viene visualizzata una schermata per la 
modifica del File ID.

2	 Utilizzare il selettore multiplo 
(pagina 7) o la manopola 
multifunzione (pagina 5) per 
selezionare il carattere desiderato, quindi 
premere il pulsante di conferma del 
selettore multiplo o la manopola 
multifunzione.

3	 Ripetere il passo 2 tutte le volte 
necessarie.

4	 Al termine dell'immissione dei caratteri, 
selezionare Done.

Salvataggio e caricamento dei dati di configurazione
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Connessione di monitor e dispositivi di registrazione esterni
Per visualizzare le immagini di registrazione 
e riproduzione del camcorder su un monitor 
esterno, selezionare il segnale di uscita del 
camcorder e utilizzare il cavo appropriato per il 
monitor esterno da collegare.
È possibile anche collegare dispositivi di 
registrazione, ad esempio un VTR, e registrare 
il segnale in uscita dal camcorder.
È possibile visualizzare sul monitor esterno 
le stesse informazioni che sono visibili nel 
mirino, ad esempio informazioni di stato e 
menu. Impostare su On la voce Info. Disp. 
(pagina 14) nella schermata Monitoring 
Status oppure le opzioni della voce Output 
Display (pagina 88) nel menu Monitoring 
del menu completo in base al segnale da 
emettere in uscita sul monitor.

Connettore SDI OUT (tipo BNC)

Attivare o disattivare l’uscita e configurare 
il formato di uscita nel menu Monitoring 
(pagina 88).
Per il collegamento, utilizzare un cavo 
coassiale da 75 Ω disponibile in commercio.

[Nota]
Controllare la messa a terra della connessione fra il 
camcorder e il dispositivo esterno prima di accendere i 
dispositivi.

(Si consiglia di accendere il camcorder e il 
dispositivo esterno solo dopo la connessione 
del cavo coassiale da 75 Ω).
Se il dispositivo esterno deve essere collegato 
al camcorder mentre il camcorder è acceso, 
collegare il cavo coassiale da 75 Ω prima al 
dispositivo esterno e solo successivamente al 
camcorder.

Per avviare la registrazione 
simultaneamente sul camcorder e sul 
dispositivo esterno

Con l’uscita segnale SDI abilitata, impostare 
SDI/HDMI Rec Control (pagina 80) >Setting 
nel menu Project del menu completo su SDI/
HDMI Remote I/F o Parallel Rec per abilitare 
l’emissione di un segnale di trigger REC diretto 
al dispositivo esterno connesso al connettore 
SDI OUT. Questo sincronizzerà la registrazione 
sul dispositivo esterno con il camcorder.

[Note]
ˎˎ Se il dispositivo esterno connesso non è compatibile 

con il segnale di trigger REC, il dispositivo non può 
essere comandato.
ˎˎ Se non è inserito un supporto, viene solamente 

emesso il segnale di trigger REC.

Connettore HDMI OUT (tipo A)

Attivare o disattivare l’uscita e configurare 
il formato di uscita nel menu Monitoring 
(pagina 88) del menu completo.

Per avviare la registrazione 
simultaneamente sul camcorder e sul 
dispositivo esterno

Con l’uscita segnale HDMI abilitata, impostare 
HDMI TC Out >Setting (pagina 86) nel menu 
TC/Media del menu completo su On, quindi 
impostare SDI/HDMI Rec Control >Setting 
(pagina 80) nel menu Project su SDI/
HDMI Remote I/F o Parallel Rec per abilitare 
l’emissione in uscita di un segnale di trigger 
REC diretto al dispositivo esterno connesso al 
connettore HDMI OUT. Questo sincronizzerà 
la registrazione sul dispositivo esterno con il 
camcorder.
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Sincronizzazione dei codici temporali
Il codice temporale dell’unità può essere 
sincronizzato con quello di altri dispositivi.

Sincronizzazione del codice 
temporale con altri dispositivi

Impostare l’unità che fornisce il codice 
temporale su una modalità in cui il codice 
temporale continui ad avanzare (es. Free Run 
o Clock).

1	 Impostare l’opzione Timecode 
(pagina 86) del menu TC/Media del 
menu completo come indicato di seguito.
Mode: Preset
Run: Free Run

2	 Premere il pulsante programmabile 
(pagina 49) a cui è assegnata la 
funzione DURATION/TC/U-BIT per 
visualizzare il codice temporale sullo 
schermo.

3	 Controllare che il selettore TC IN/OUT 
(pagina 4) si trovi sulla posizione IN, 
quindi fornire un codice temporale di 
riferimento per la sincronizzazione della 
frequenza di sistema del camcorder con il 
connettore TC IN/TC OUT.

Il generatore del codice temporale del 
camcorder si sincronizza con il codice 
temporale di riferimento e sullo schermo 
appare l’indicazione “EXT-LK”.
Una volta trascorsi dieci secondi circa 
dall’acquisizione della sincronizzazione, 
lo stato di sincronizzazione esterno viene 
mantenuto anche se la sorgente di riferimento 
esterna del codice temporale viene scollegata.

[Note]
ˎˎ Durante il funzionamento in modalità di 

sincronizzazione esterna, il codice temporale 
acquisisce istantaneamente la sincronizzazione 
con il codice temporale esterno e nella sezione di 
visualizzazione dei dati viene visualizzato il valore 
del codice temporale esterno. Tuttavia, non avviare 
immediatamente la registrazione. Prima di avviare la 
registrazione è necessario attendere alcuni secondi la 
stabilizzazione del generatore del codice temporale.
ˎˎ Se la frequenza del codice temporale di riferimento 

e la frequenza fotogrammi del camcorder non 
sono identiche, non sarà possibile ottenere la 
sincronizzazione e il camcorder non potrà funzionare 
correttamente. In questo caso, il codice temporale 
non potrà sincronizzarsi correttamente con il codice 
temporale esterno.
ˎˎ È possibile che il codice temporale si scosti di un 

fotogramma all’ora rispetto al codice temporale di 
riferimento.

Per rilasciare la sincronizzazione esterna

Cambiare l’impostazione di Timecode nel 
menu TC/Media del menu completo oppure 
spegnere il camcorder.
La sincronizzazione esterna viene annullata 
anche quando si cambia frequenza di sistema 
o quando si avvia la registrazione in una 
modalità di registrazione speciale (Slow & 
Quick Motion o Interval Rec).

Sincronizzazione del codice 
temporale di un altro dispositivo 
con il codice temporale del 
camcorder

Impostare l’unità che fornisce il codice 
temporale su una modalità in cui il codice 
temporale continui ad avanzare (es. Free Run 
o Clock).

1	 Impostare il codice temporale del 
camcorder con la voce Timecode 
(pagina 86) del menu TC/Media del 
menu completo.

2	 Controllare che il selettore TC IN/OUT 
(pagina 4) si trovi sulla posizione OUT, 
quindi collegare il connettore TC IN/TC 
OUT al connettore di ingresso del codice 
temporale del dispositivo che si desidera 
sincronizzare.
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Gestione ed editing di clip con un computer

Connessione con cavo USB

Utilizzo di un lettore di schede (opzione)

Collegare un lettore di schede CFexpress o 
SD a un computer mediante un cavo USB ed 
inserire una scheda di memoria nello slot del 
lettore di schede. La scheda di memoria viene 
riconosciuta come un’unità di estensione del 
computer. Sui computer supportati, è possibile 
importare clip ad alta velocità utilizzando la 
modalità di memorizzazione di massa del 
camcorder.

Utilizzo della modalità di 
memorizzazione di massa

[Nota]
La modalità di archiviazione di massa non può essere 
utilizzata quando è impostata su On la voce Modem 
>Setting nel menu Network del menu completo, oppure 
quando è impostata su On la voce Wired LAN >Setting 
nel menu Network del menu completo. Impostare le due 
voci su Off.

Collegare il camcorder mediante un cavo 
USB, quindi inserire una scheda di memoria 
nello slot A o nello slot B. La scheda di 
memoria viene riconosciuta come un’unità di 
estensione del computer.

1	 Servendosi di un cavo USB, collegare il 
connettore USB-C (pagina 7) 
connettore USB/multi (pagina 7) al 
computer.

2	 Spostare il selettore POWER del 
camcorder su ON.
Sullo schermo del mirino viene 
visualizzato un messaggio di conferma 
della connessione USB.

	 [Nota]
Il messaggio di conferma della connessione 
USB non viene visualizzato se è già visualizzato 
un altro messaggio di conferma o un indicatore 
di avanzamento, ad esempio durante la 
formattazione o il recupero di una scheda di 
memoria.
Il messaggio di conferma verrà visualizzato al 
termine della formattazione o del recupero. Il 
messaggio di conferma USB non è visualizzato 
neanche quando è visualizzata la schermata delle 
proprietà del clip. Il messaggio verrà visualizzato 
al termine dell’operazione o quando si ritorna alla 
schermata delle miniature.

3	 Ruotare la manopola multifunzione e 
selezionare Execute.

4	 Su Windows, controllare che la scheda sia 
aggiunta come disco rimovibile nella 
finestra “My Computer”.
Su Mac, controllare che sia stata creata sul 
Desktop una cartella con il nome “NO 
NAME” o “Untitled” (modificabile).

[Note]
ˎˎ Non eseguire le seguenti operazioni se l’indicatore di 

accesso è illuminato in rosso.
–– Spegnere l’apparecchio o scollegare il cavo di 

alimentazione
–– Rimuovere una scheda di memoria
–– Scollegare il cavo USB

ˎˎ Il funzionamento non è garantito con tutti i computer.

Utilizzo di un sistema di editing 
non lineare

In un sistema di editing non lineare, è 
necessario utilizzare un software di editing 
(opzione) che supporti i formati registrati dal 
camcorder.
Utilizzare un software applicativo dedicato 
per salvare in anticipo sul disco rigido del 
computer i clip di cui eseguire l’editing.
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Precauzioni per l’uso
Condensazione

Qualora l’unità venga spostata rapidamente 
da un ambiente freddo a uno caldo, oppure se 
la temperatura ambiente dovesse aumentare 
improvvisamente, è possibile che si formi umidità 
sulle superfici esterne dell’unità e/o al suo interno. 
Questo fenomeno è denominato condensazione. 
In tal caso, spegnere l’unità ed attendere la 
scomparsa della condensazione prima di 
riavviarla. L’utilizzo dell’unità mentre è presente 
condensazione può causare danni all’unità stessa.

Pannelli LCD

Il pannello LCD di cui è dotato l’apparecchio è 
prodotto con tecnologia ad alta precisione che 
consente di ottenere una percentuale di pixel 
funzionanti minima di ben 99,99%. È quindi possibile 
che una piccolissima percentuale dei pixel possa 
rimanere “bloccata”, sempre disattivata (nera), sempre 
attivata (rossa, verde o blu) oppure lampeggiante. È 
inoltre possibile che, dopo un lungo periodo d’uso, 
alcuni pixel si “blocchino” spontaneamente a causa 
delle caratteristiche fisiche del display a cristalli 
liquidi. Tali fenomeni non sono il risultato di guasti e 
non hanno alcun effetto sui dati registrati.

Fenomeni intrinsechi al sensore 
immagini CMOS della telecamera

[Nota]
Di seguito si descrivono alcuni fenomeni che potrebbero 
apparire nelle immagini. Tali fenomeni sono intrinsechi 
dei sensori di immagine. Non possono esser considerati 
malfunzionamenti.

Macchiette bianche
I sensori di immagine sono prodotti con 
tecnologie di elevatissima precisione. 
Ciononostante possono presentarsi sullo 
schermo in alcuni rari casi piccole macchiette 
bianche, causate da raggi cosmici ecc.

Questo fenomeno è intrinseco al principio di 
funzionamento dei sensori immagine e non 
indica la presenza di guasti.
Le macchiette bianche tendono ad apparire 
principalmente nei seguenti casi:
ˎˎ Durante l’utilizzo a temperature ambiente elevate
ˎˎ Se è stato aumentato il guadagno (sensibilità)

Sfarfallio
Nelle riprese effettuate con illuminazione 
prodotta da lampade fluorescenti o LED o 
ai vapori di sodio o di mercurio, lo schermo 
potrebbe presentare fenomeni di sfarfallio e i 
colori potrebbero apparire alterati.

Componenti di consumo

ˎˎ La ventola e la batteria sono considerate 
componenti di consumo che dovranno 
essere sostituite periodicamente.  
Se l’apparecchio viene utilizzato a 
temperatura ambiente, il ciclo normale 
di sostituzione è di circa 5 anni. Tuttavia, 
ciò ha un valore puramente indicativo e 
non implica alcuna garanzia sulla durata 
di vita prevista di questi componenti. Per 
ulteriori informazioni sulla sostituzione dei 
componenti, rivolgersi al proprio rivenditore.
ˎˎ La vita utile prevista dell’adattatore CA e 
del condensatore elettrolitico è di circa 5 
anni a temperature normali e in condizioni 
di utilizzo normale (8 ore al giorno per 25 
giorni al mese). Se le condizioni di utilizzo 
eccedono i valori normali sopra indicati, la 
vita prevista si ridurrà proporzionalmente.
ˎˎ Il morsetto della batteria dell’apparecchio (il 
connettore per pacchi batteria e adattatori 
CA) è un prodotto di consumo.  
Se i piedini del morsetto sono piegati 
e deformati a causa di urti o vibrazioni, 
o se vengono corrosi a causa di un uso 
prolungato all’aria aperta, l’alimentazione 
potrebbe non essere fornita correttamente.  
Si consiglia di eseguire dei controlli 

periodici per assicurare il funzionamento 
corretto dell’apparecchio e prolungarne 
la vita utile. Per ulteriori informazioni sui 
controlli, contattare il servizio tecnico o un 
rappresentante Sony.

Batteria ricaricabile incorporata

Il camcorder è dotato di una batteria 
ricaricabile interna che consente la 
memorizzazione di data, ora e altre 
impostazioni anche quando è spento. 
La batteria interna si ricarica mentre il 
camcorder rimane collegato a una presa di 
corrente di rete tramite l’adattatore CA o a 
un pacco batteria completamente carico. La 
ricarica richiede 24 ore indipendentemente 
dal fatto che il camcorder sia acceso o 
spento. Se non è connesso un adattatore 
CA o il camcorder viene utilizzato senza 
pacco batteria, la batteria ricaricabile si 
scaricherà completamente dopo circa 2 mesi. 
Utilizzare il camcorder dopo aver ricaricato la 
batteria. In ogni caso, il camcorder funziona 
correttamente anche se la batteria è scarica, 
con l’eccezione della registrazione della data.

Ambienti d’impiego e conservazione

Conservare su una superficie piana in un 
ambiente ben ventilato.
Evitare di usare o conservare l’apparecchio 
negli ambienti indicati di seguito.
ˎˎ In presenza di temperature eccessivamente 
alte o basse (temperatura di funzionamento 
permessa compresa fra 0 °C e 40 °C)  
Ricordare che in estate, in climi caldi, la 
temperatura all’interno di un’auto con i 
finestrini chiusi può facilmente superare i 50 °C.
ˎˎ In ambienti umidi o polverosi. In ambienti in 
cui l’apparecchio potrebbe essere esposto 
alla pioggia.
ˎˎ In ambienti soggetti a forti vibrazioni.
ˎˎ In prossimità di intensi campi magnetici.

ˎˎ In prossimità di impianti di trasmissione 
radio o TV che producono forti campi 
elettromagnetici.
ˎˎ In esposizione alla luce solare diretta o in 
prossimità di fonti di riscaldamento per 
periodi prolungati.

Nota sui raggi laser

I raggi laser possono danneggiare il sensore 
immagine CMOS. Qualora vengano riprese 
scene in cui sono presenti raggi laser, evitare 
che tali raggi colpiscano l’obiettivo dell’unità.  
I particolare, i fasci laser ad alta potenza 
generati da dispositivi medicali o di altro tipo 
possono causare danni anche se riflessi o diffusi.

Prevenzione delle interferenze 
elettromagnetiche causate da dispositivi 
di comunicazione portatili

L’uso di telefoni portatili e di altri 
dispositivi di comunicazione in prossimità 
di questa telecamera potrebbe causare 
malfunzionamenti ed interferenze con i 
segnali audio e video. Si consiglia di spegnere 
eventuali dispositivi di comunicazione portatili 
nelle vicinanze di questa telecamera.

Precauzioni per la sicurezza

ˎˎ SONY NON SARÀ RESPONSABILE DI DANNI 
DI QUALSIASI TIPO RISULTANTI DALLA 
MANCATA IMPLEMENTAZIONE DI MISURE DI 
PROTEZIONE ADEGUATE SUI DISPOSITIVI DI 
TRASMISSIONE, DA INEVITABILI DIFFUSIONI 
DI DATI RISULTANTI DALLE SPECIFICHE 
TECNICHE DELLA TRASMISSIONE O DA 
PROBLEMATICHE RELATIVE ALLA SICUREZZA 
DI QUALSIASI TIPO.
ˎˎ In base all’ambiente operativo, terze parti 
non autorizzate alla rete potrebbero essere in 
grado di accedere all’unità. Quando si collega 
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l’unità alla rete, accertarsi di confermare che 
la rete è efficacemente protetta.
ˎˎ Il contenuto trasmesso può essere 
intercettato inconsapevolmente da terze 
parti non autorizzate che si trovano in 
prossimità dei segnali. Quando si utilizza la 
comunicazione LAN wireless, implementare 
misure di protezione per proteggere il 
contenuto della comunicazione.
ˎˎ Il collegamento del prodotto a una rete 
deve essere realizzato mediante un sistema 
in grado di fornire funzioni di protezione, 
ad esempio un router o un firewall. In caso 
di collegamento senza tale protezione si 
potrebbero verificare problemi di sicurezza.
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Le impostazioni predefinite sono indicate in grassetto (ad esempio, 1920×1080P (Level A)).

[Note]
ˎˎ La risoluzione del formato di uscita è limitata dalle impostazioni delle voci Rec Format >Frequency, Video Format, 

Codec ed altre impostazioni nel menu Project del menu completo (pagina 78).
ˎˎ La risoluzione del formato di uscita è limitata dalla combinazione con la frequenza fotogrammi S&Q. L’uscita HDMI 

diventa Full HD se vengono soddisfatte tutte le seguenti condizioni nel menu completo.
–– Rec Format >Video Format è impostato su 4096×2160 o 3840×2160 nel menu Project.
–– S&Q Motion >Setting nel menu Shooting è impostato su On.
–– S&Q Motion >Frame Rate nel menu Shooting è superiore a 60fps.
–– Rec Format >Codec nel menu Project è impostato su RAW o RAW & XAVC-I, oppure Output On/Off >SDI nel 

menu Monitoring è impostato su On.
ˎˎ Nelle condizioni sopra descritte, se l’uscita HDMI era impostata su 4096×2160P o 3840×2160P, verrà 

automaticamente impostata su 1920×1080P. In questo caso, le opzioni di uscita HDMI 4096×2160P e 3840×2160P di 
Output Format >SDI/HDMI (pagina 88) nel menu Monitoring del menu completo sono disattivate e non possono 
essere selezionate.
ˎˎ Se la risoluzione dell’uscita video è superiore a quella dell’immagine, non viene emessa nessuna immagine 

riprodotta.

Formati di uscita per il connettore SDI OUT/HDMI OUT

Frequenza di 
sistema (Rec 
Format >Frequency 
nel menu Project)

Formato video 
(Rec Format 
>Video Format nel 
menu Project)

Stato di uscita 
RAW
(Rec Format 
>Codec nel menu 
Project)

Formato di uscita (Output Format nel 
menu Monitoring)

SDI HDMI

59.94/50 4096×2160 Con uscita RAW – 4096×2160P

1920×1080P

1920×1080i

3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Frequenza di 
sistema (Rec 
Format >Frequency 
nel menu Project)

Formato video 
(Rec Format 
>Video Format nel 
menu Project)

Stato di uscita 
RAW
(Rec Format 
>Codec nel menu 
Project)

Formato di uscita (Output Format nel 
menu Monitoring)

SDI HDMI

Senza uscita RAW 4096×2160P 4096×2160P

1920×1080P

1920×1080i

3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P (Level 
B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

3840×2160 Con uscita RAW – 3840×2160P

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i

Senza uscita RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P (Level 
B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

Formati di uscita e limitazioni
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Frequenza di 
sistema (Rec 
Format >Frequency 
nel menu Project)

Formato video 
(Rec Format 
>Video Format nel 
menu Project)

Stato di uscita 
RAW
(Rec Format 
>Codec nel menu 
Project)

Formato di uscita (Output Format nel 
menu Monitoring)

SDI HDMI

1920×1080 Senza uscita RAW 1920×1080P 
(Level A)

1920×1080P

1920×1080i

1920×1080P (Level 
B)

1920×1080P

1920×1080i

1920×1080i 1920×1080i

– 59.94: 720×480P
50: 720×576P

29.97/25 4096×2160 Con uscita RAW – 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

1920×1080i

Senza uscita RAW 4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

3840×2160 Con uscita RAW – 3840×2160P

1920×1080P

1920×1080P

1920×1080i

Senza uscita RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

1920×1080 Senza uscita RAW 1920×1080P 1920×1080P

1920×1080I (PsF) 1920×1080i

Frequenza di 
sistema (Rec 
Format >Frequency 
nel menu Project)

Formato video 
(Rec Format 
>Video Format nel 
menu Project)

Stato di uscita 
RAW
(Rec Format 
>Codec nel menu 
Project)

Formato di uscita (Output Format nel 
menu Monitoring)

SDI HDMI

24 4096×2160 Con uscita RAW – 4096×2160P

1920×1080P

Senza uscita RAW 4096×2160P 4096×2160P

1920×1080P 1920×1080P

23.98 4096×2160 Con uscita RAW – 4096×2160P

1920×1080P

3840×2160P

1920×1080P

1920×1080P

Senza uscita RAW 4096×2160P 4096×2160P

1920×1080P

3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

3840×2160 Con uscita RAW – 3840×2160P

1920×1080P

1920×1080P

Senza uscita RAW 3840×2160P 3840×2160P

1920×1080P

1920×1080P 1920×1080P

1920×1080 Senza uscita RAW 1920×1080P 1920×1080P
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Alimentazione

Problema Causa Soluzione

Il camcorder non si accende. Non è montata una batteria 
e non viene fornita 
alimentazione al connettore 
DC IN.

Montare una batteria (pagina 17) o 
collegare alla rete elettrica mediante un 
adattatore CA (pagina 18).

La batteria è completamente 
scarica.

Sostituire la batteria con una 
completamente carica (pagina 17).

L’alimentazione si 
interrompe durante il 
funzionamento.

La batteria si è scaricata 
completamente.

Sostituire la batteria con una 
completamente carica (pagina 17).

La batteria si scarica 
velocemente.

La temperatura ambiente è 
molto bassa.

Tale condizione è dovuta alle 
caratteristiche della batteria e non è un 
difetto.

La batteria non è caricata 
correttamente.

Ricaricare la batteria (pagina 17).
Se la batteria si scarica rapidamente 
anche dopo esser stata caricata 
completamente, potrebbe aver 
raggiunto la fine della sua vita utile. 
Sostituirla con una nuova.

Registrazione/riproduzione

Problema Causa Soluzione

La registrazione non si avvia 
quando si preme il pulsante 
di registrazione START/STOP.

La scheda di memoria è 
piena.

Sostituire la scheda di memoria con 
un’altra che disponga di spazio 
sufficiente.

La scheda di memoria deve 
essere ripristinata.

Ripristinare la scheda di memoria 
(pagina 33).

La registrazione audio non è 
possibile.

Le manopole di regolazione 
AUDIO LEVEL (CH1/CH2) sono 
impostate sul livello minimo.

Regolare i livelli di registrazione audio 
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 47).

Il suono registrato è distorto. Il livello audio è troppo 
elevato.

Regolare i livelli di registrazione audio 
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 47).

Problema Causa Soluzione

Nell’audio registrato è 
presente un alto livello di 
rumore.

Il livello audio è troppo 
basso.

Regolare i livelli di registrazione audio 
con le manopole AUDIO LEVEL (CH1/
CH2) (pagina 47).
Quando è selezionato un microfono 
esterno, regolare anche l’impostazione 
INPUT MIC Reference sotto Audio Input 
nel menu Audio (pagina 91).

Non è possibile riprodurre 
clip.

È in corso l’editing di un clip. Non è possibile riprodurre clip se sono 
stati modificati i nomi di file o delle 
cartelle oppure se il clip è in uso su un 
computer. Questo non indica la 
presenza di guasti.

È in corso la registrazione del 
clip su un altro dispositivo.

Potrebbe non essere possibile 
riprodurre clip registrati con altri 
dispositivi, oppure potrebbero essere 
visualizzati con dimensioni errate. 
Questo non indica la presenza di guasti.

Dispositivi esterni

Problema Soluzione

Il computer non riconosce il 
camcorder.

Scollegare il cavo USB dal computer, quindi collegarlo di nuovo 
saldamente.

Scollegare il cavo USB dal computer, riavviare il computer e 
ripetere nuovamente la procedura nell’ordine corretto.

Collegare il computer e il camcorder inserendo un cavo USB nel 
connettore USB-C o nel connettore USB/multi.

Non è possibile caricare clip sul 
computer.

Scollegare il cavo USB dal computer, riavviare il camcorder e quindi 
ricollegarlo.

Un apposito software applicativo deve essere installato per poter 
caricare clip sul computer (pagina 110).

Ricerca e risoluzione dei problemi
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Connessione LAN wireless

[Nota]
La presenza di ostruzioni o interferenze elettromagnetiche fra il camcorder e il punto di accesso LAN wireless oppure 
la configurazione dell’ambiente (ad esempio il materiale delle pareti), potrebbe ridurre il campo di comunicazione 
possibile o addirittura impedire completamente la connessione. Qualora si rilevino tali problemi, controllare lo stato 
della connessione o della comunicazione spostando il camcorder in un altro luogo oppure avvicinando il camcorder al 
punto di accesso o dispositivo terminale utilizzato.

Problema Soluzione

Un dispositivo terminale non 
può accedere al camcorder.

ˎˎ Controllare la connessione LAN wireless (indirizzo IP, ecc.).
ˎˎ Le impostazioni di comunicazione tra il punto di accesso e il 
client potrebbero non essere valide. Per informazioni dettagliate, 
fare riferimento alle istruzioni per l’uso del punto di accesso.

Non è possibile eseguire il login 
sul camcorder.

Verificare il nome utente e la password impostati.

Connessione Internet

Problema Soluzione

L’upload del file non avviene 
correttamente.

Il nome utente e la password del server potrebbero non essere 
corretti.
Immettere nome utente e password corretti.

La funzione di upload di file 
potrebbe non essere disponibile.

Le condizioni del segnale potrebbero essere insufficienti.
Spostare il camcorder in un luogo diverso e riprovare.

Durante l’utilizzo del filtro ND

Problema Soluzione

Il filtro ND non si muove. Spostare manualmente il filtro sulla posizione Clear utilizzando la 
procedura descritta di seguito.

1	 Spostare il selettore POWER del camcorder su Off.

2	 Rimuovere il coperchietto rotondo sul lato inferiore.

3	 Inserire un piccolo cacciavite nel foro e ruotarlo in senso antiorario.
ˎˎ Il filtro ND si sposta sulla posizione Clear ruotando in senso antiorario. Continuare a ruotare 
il cacciavite fino a raggiungere la posizione Clear.
ˎˎ Utilizzare un cacciavite con diametro massimo di 2,4 mm. La profondità di inserimento del 
cacciavite è di circa 3,0 cm.

Foro per cacciavite
(con coperchietto rimosso)

4	 Spostare il selettore ND PRESET/VARIABLE (pagina 5) sulla posizione PRESET, quindi 
spostare i pulsanti su/giù ND FILTER POSITION (pagina 5) sulla posizione CLEAR.

[Note]
ˎˎ Non utilizzare questa procedura durante il normale funzionamento dell’apparecchio. Utilizzare questa procedura 

solo se il filtro ND non si muove. Il filtro ND potrebbe danneggiarsi se questa procedura viene utilizzata durante il 
normale funzionamento.
ˎˎ Dopo aver utilizzato questa procedura, rivolgersi a un centro di assistenza Sony per la riparazione del camcorder.
ˎˎ Dopo l’esecuzione di questa procedura, sarà possibile eseguire riprese anche se viene visualizzato un messaggio di 

errore.
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Qualora si verifichino avvisi, avvertenze o condizioni che richiedono una conferma, il mirino del 
camcorder visualizza un messaggio, la spia di registrazione/tally inizia a lampeggiare e viene 
emesso un segnale acustico.
Il segnale acustico di avvertimento viene emesso sulle cuffie connesse al connettore cuffie.

Messaggi di errore

Il camcorder si arresterà nel caso abbia luogo una condizione che causa la visualizzazione di un 
messaggio del tipo seguente.

Messaggio sul mirino Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

E + codice d’errore Continuo Lampeggia 
rapidamente

Indica un’anomalia del camcorder. La 
registrazione si arresta, anche se il mirino 
continua a visualizzare REC.
Spegnere il camcorder e verificare eventuali 
problemi nei dispositivi collegati, cavi o supporti di 
memorizzazione. Se il messaggio d’errore persiste 
dopo aver riacceso il camcorder, rivolgersi al 
proprio rappresentante di assistenza tecnica Sony.
(Se il camcorder non si spegne spostando su OFF 
il selettore di alimentazione POWER, rimuovere la 
batteria o scollegare l’alimentazione dal 
connettore DC IN).
In base allo stato, il camcorder potrebbe emettere 
un avvertimento acustico o visualizzare un 
messaggio di errore.

Messaggi di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Messaggio sul mirino Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

Battery Near End Intermittente Lampeggiante La carica rimanente del pacco batteria si sta 
esaurendo.
Ricaricare non appena possibile.

Messaggio sul mirino Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

Battery End Continuo Lampeggia 
rapidamente

Il pacco batteria è scarico. La registrazione è 
disabilitata.
Arrestare le operazioni e sostituire il pacco 
batteria.

Temperature High Intermittente Lampeggiante La temperatura interna è elevata.
Spegnere il camcorder e lasciarlo raffreddare 
prima di utilizzarlo nuovamente.

Media Temperature 
High

Intermittente Lampeggiante La temperatura della scheda CFexpress risulta 
elevata.
Sostituire la scheda o lasciarla raffreddare prima 
di utilizzarla nuovamente.

Voltage Low Intermittente Lampeggiante La tensione sul connettore DC IN è bassa (livello 1). 
Controllare la sorgente di alimentazione.

Insufficient Voltage Continuo Lampeggia 
rapidamente

La tensione sul connettore DC IN è insufficiente 
(livello 2). La registrazione è disabilitata.
Collegare un’altra sorgente di alimentazione.

Media Near Full Intermittente Lampeggiante La capacità rimanente sulla scheda di memoria si 
sta esaurendo.
Sostituire non appena possibile.

Media Full Continuo Lampeggia 
rapidamente

Non è possibile registrare o copiare clip perché la 
capacità rimanente sulla scheda di memoria è 
insufficiente.
Sostituire immediatamente.

Clips Near Full Intermittente Lampeggiante Ci si sta avvicinando al numero massimo di clip 
che possono essere registrati sulla scheda di 
memoria.
Sostituire non appena possibile.

Clips Full Continuo Lampeggia 
rapidamente

È stato raggiunto il numero massimo di clip che 
possono essere registrati sulla scheda di memoria.
Non è possibile registrare o copiare altri clip. 
Sostituire immediatamente.

Last Clip Recording Intermittente Lampeggiante Il clip in corso di registrazione è l’ultimo clip che 
può essere registrato in quanto è stato raggiunto 
il numero massimo di clip consentito.
Preparare una nuova scheda di memoria.

Media(A)1) Life Near 
End

Intermittente Lampeggiante La scheda di memoria si sta avvicinando alla fine 
della sua vita utile. Sostituire non appena possibile.

Media(A)1) Life End Continuo Lampeggia 
rapidamente

La scheda di memoria ha raggiunto la fine della 
sua vita utile. Sostituire immediatamente.

Media(A)1) Near Full Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Messaggi di errore e avvisi
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Messaggio sul mirino Segnale 
acustico di 
avvertimento

Spia di 
registrazione/
tally

Causa e soluzione

Media(A)1) Full Continuo Lampeggia 
rapidamente

Quando si utilizza la funzione Simul Rec

Media(A)1) Clips Near Full Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A)1) Clips Full Continuo Lampeggia 
rapidamente

Quando si utilizza la funzione Simul Rec

Media(A)1) Last Clip Rec Intermittente Lampeggiante Quando si utilizza la funzione Simul Rec

1)	 Per la scheda dello slot B è visualizzato “(B)”.

Messaggi di avviso e operativi

Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e 
operativi. Seguire le istruzioni fornite per risolvere il problema.

Messaggio sul display Causa e soluzione

Battery Error
Please Change Battery

È stata rilevata un’anomalia nel pacco batteria.
Sostituire con un pacco batteria normale.

Backup Battery End
Please Change

La carica della batteria di backup è insufficiente.
Caricare la batteria di backup.

Unknown Media (A) 1)

Please Change
È stata inserita una scheda di memoria che è stata 
partizionata oppure che contiene un numero di clip superiore 
al massimo gestibile da questo camcorder.
La scheda non può essere utilizzata nel camcorder e deve 
essere sostituita.

Cannot Use Media (A) 1)

Unsupported File System
È stata inserita una scheda con un file system diverso oppure 
non formattata.
La scheda non può essere utilizzata nel camcorder e deve 
essere sostituita oppure formattata con il camcorder.

Media Error
Media (A) 1) Needs to be Restored

Si è verificato un errore sulla scheda di memoria e la scheda 
deve essere ripristinata.
Ripristinare la scheda di memoria.

Media Error
Cannot Record to Media (A) 1)

La scheda di memoria potrebbe essere danneggiata e non 
può essere utilizzata per la registrazione.
La riproduzione è possibile, è consigliabile quindi eseguire 
una copia e sostituire la scheda di memoria.

Messaggio sul display Causa e soluzione

Media Error
Cannot Use Media (A) 1)

La scheda di memoria potrebbe essere danneggiata e non 
può essere utilizzata per la registrazione o la riproduzione.
La scheda non può essere utilizzata nel camcorder e deve 
essere sostituita.

Media (A) 1) Error
Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa 
di un errore durante l’utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit
Change Media (A) 1)

La scheda di memoria ha raggiunto la fine della sua vita utile.
Eseguire un backup e sostituire la scheda immediatamente. 
Se si continua a utilizzare la scheda è possibile che la scheda 
non consenta più l’esecuzione di registrazioni o riproduzioni.
Per ulteriori informazioni, consultare le istruzioni per l’uso 
della scheda di memoria.

The specified address is invalid. L’indirizzo specificato non è valido.
Controllare che l’impostazione sia corretta.

Cannot Use Specified Port Number Il numero di porta specificato non è valido.
Controllare che l’impostazione sia corretta.

Fan Stopped La ventola di raffreddamento si è arrestata.
Evitare l’utilizzo a temperature elevate. Scollegare 
l’alimentazione e contattare il rappresentante di assistenza 
tecnica Sony.

Lens I/F Error(xx:xx) È stato rilevato un errore dell’obiettivo durante la 
comunicazione I/F dell’obiettivo E-mount montato.
Controllare lo stato della connessione con l’obiettivo E-mount.
Se il problema persiste, rivolgersi al servizio di assistenza Sony 
riferendo il codice d’errore visualizzato (cinque caratteri fra 
parentesi).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

È stato rilevato un accessorio incompatibile.
L’unico accessorio Multi Terminal supportato dall’unità è 
l’impugnatura di telecomando fornita in dotazione.

Failed Questo errore potrebbe apparire se non è possibile ottenere 
un indirizzo con DHCP impostato su On.
Controllare le impostazioni del server DHCP.

Cannot add auto upload job of Proxy 
file because maximum number of 
upload jobs was reached.

È stato raggiunto il numero massimo di trasferimenti 
consentito.
Eliminare i trasferimenti non più necessari. Anche le 
impostazioni della destinazione del caricamento automatico 
per i file proxy potrebbero essere incorrette. Controllare che 
l’impostazione sia corretta.

<SSID>Not found. Non è stato possibile trovare una rete (punto di accesso) con il 
<SSID> specificato.
Controllare che l’impostazione sia corretta.
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Messaggio sul display Causa e soluzione

<SSID>Authentication Failed L’autenticazione della connessione sulla rete (punto di 
accesso) con il <SSID> specificato non è riuscita.
Controllare che la password e le altre impostazioni siano 
corrette.

An IP address conflict has occurred. 
Please check the network settings.

È presente un conflitto tra gli indirizzi di rete della LAN 
wireless, della rete LAN cablata o del tethering USB.
Modificare l’indirizzo manualmente o modificare le 
impostazioni del router di rete.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

L’indirizzo IP della modalità punto di accesso LAN wireless è 
stato cambiato a causa di un conflitto fra gli indirizzi di rete 
della modalità punto di accesso LAN wireless, LAN cablata o 
tethering USB.
Verificare l’impostazione dell’indirizzo IP.

1)	 Per la scheda dello slot B è visualizzato “(B)”.
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Voci impostate nel menu completo

Si: Impostazione salvata.
No: Impostazione non salvata.
–: Non salvata (impostazione temporanea)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Sì No

ISO/Gain<H> Sì No

ISO/Gain<M> Sì No

ISO/Gain<L> Sì No

Exposure Index<H> Sì No

Exposure Index<M> Sì No

Exposure Index<L> Sì No

Shockless Gain Sì No

Base Sensitivity Sì No

Base ISO Sì No

ND Filter Preset1 Sì No

Preset2 Sì No

Preset3 Sì No

Shutter Mode Sì No

Shutter Speed On/Off Sì No

Shutter Speed Sì No

Shutter Angle Sì No

ECS On/Off Sì No

ECS Frequency Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Sì No

Mode Sì No

Speed Sì No

AGC Sì No

AGC Limit Sì No

AGC Point Sì No

Auto Shutter Sì No

A.SHT Limit Sì No

A.SHT Point Sì No

Clip High light Sì No

Detect Window Sì No

Detect Window Indication Sì No

Custom Width Sì No

Custom Height Sì No

Custom H Position Sì No

Custom V Position Sì No

White Preset White Sì No

Color Temp <A> Sì No

Tint<A> Sì No

R Gain <A> Sì No

B Gain <A> Sì No

Color Temp <B> Sì No

Tint<B> Sì No

R Gain <B> Sì No

B Gain <B> Sì No

White Setting Shockless White Sì No

ATW Speed Sì No

White Switch<B> Sì No

Filter White Memory Sì No

Impostazioni salvate in file
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Sì No

Offset Color Temp<A> Sì No

Offset Tint<A> Sì No

Offset White <B> Sì No

Offset Color Temp<B> Sì No

Offset Tint<B> Sì No

Offset White<ATW> Sì No

Offset Color Temp<ATW> Sì No

Offset Tint<ATW> Sì No

Focus AF Transition Speed Sì No

AF Subj. Shift Sens. Sì No

Focus Area Sì No

Focus Area (AF-S) Sì No

Face/Eye Detection AF Sì No

Push AF Mode Sì No

AF Assist Sì No

S&Q Motion Setting Sì No

Frame Rate Sì No

LUT On/Off SDI/HDMI Sì No

VF/Proxy/Stream Sì No

Internal Rec Sì No

Noise Suppression Setting(Custom) Sì No

Level(Custom) Sì No

Setting(Cine EI) Sì –

Level(Cine EI) Sì –

Flicker Reduce Mode Sì No

Frequency Sì No

SteadyShot Setting Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Sì –

Target Display Sì –

Rec Format Frequency Sì No

Imager Scan Mode Sì No

Codec Sì No

RAW Output Format Sì No

Video Format Sì No

Cine EI Setting Color Gamut Sì –

Simul Rec Setting Sì No

Proxy Rec Setting Sì No

Audio Channel Sì No

Interval Rec Setting No No

Interval Time Sì No

Number of Frames Sì No

Pre-Lighting Sì No

SDI/HDMI Rec Control Setting Sì No

Assignable Button <1> Sì No

<2> Sì No

<3> Sì No

<4> Sì No

<5> Sì No

<6> Sì No

<7> Sì No

<8> Sì No

<9> Sì No

Focus Hold Button Sì No

Assignable Dial Grip/Remote Dial Sì No

Grip Dial Direction Sì No

Handle Dial Sì No

Handle Dial Direction Sì No

Multi Function Dial Default Function Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load Media(B) – –

Save Media(B) – –

File ID No No

Load Customize Data Sì No

Load White Data Sì No

All File Load Media(B) – –

Save Media(B) – –

File ID Sì No

Load Network Data No No

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Sì Sì

Delete – –

Delete All – –

Import – –

Input Sì Sì

Output Sì Sì

AE Level Offset Sì Sì

Reset Paint Settings Reset without Base Look – –

Black Master Black Sì Sì

R Black Sì Sì

B Black Sì Sì

Knee Setting Sì Sì

Auto Knee Sì Sì

Point Sì Sì

Slope Sì Sì

Detail Setting Sì Sì

Level Sì Sì

Manual Setting Sì Sì

V/H Balance Sì Sì

B/W Balance Sì Sì

Limit Sì Sì

Crispening Sì Sì

High Light Detail Sì Sì

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Matrix User Matrix Sì Sì

User Matrix Level Sì Sì

User Matrix Phase Sì Sì

User Matrix R-G Sì Sì

User Matrix R-B Sì Sì

User Matrix G-R Sì Sì

User Matrix G-B Sì Sì

User Matrix B-R Sì Sì

User Matrix B-G Sì Sì

Multi Matrix Setting Sì Sì

Reset – –

Axis No Sì

Hue Sì Sì

Saturation Sì Sì

TC/Media Timecode Mode Sì No

Run Sì No

Setting No No

Reset – –

TC Format Sì No

TC Display Display Select Sì No

User Bits Mode Sì No

Setting No No

HDMI TC Out Setting Sì No

Clip Name Format Title Prefix Sì No

Number Set No No

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Sì No

HDMI Sì No

Output Format SDI Sì No

HDMI Sì No

Output Display SDI Sì No

HDMI Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Network Status Sì No

File Transfer Status Sì No

Rec/Play Status Sì No

RAW Output Control Status Sì No

Tally Sì No

Battery Remain Sì No

Focus Mode Sì No

Focus Position Sì No

Focus Area Indicator Sì No

Focus Area Ind.(AF-S) Sì No

Face/Eye Detection Frame Sì No

Lens Info Sì No

Imager Scan Mode Sì No

Rec Format Sì No

Frame Rate Sì No

Zoom Position Sì No

UWP RF Level Sì No

SteadyShot Sì No

Base Look/LUT Sì No

SDI/HDMI Rec Control Sì No

Gamma Display Assist Sì No

Proxy Status Sì No

Base ISO/Sensitivity Sì No

Media Status Sì No

Video Signal Monitor Sì No

Clip Name Sì No

White Balance Sì No

Scene File Sì No

Focus Indicator Sì No

Auto Exposure Mode Sì No

Auto Exposure Level Sì No

Timecode Sì No

ND Filter Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Iris Sì No

ISO/Gain/EI Sì No

Shutter Sì No

Level Gauge Sì No

Audio Level Meter Sì No

Video Level Warning Sì No

Clip Number Sì No

Notice Message Sì No

Marker Setting Sì No

Color Sì No

Center Maker Sì No

Safety Zone Sì No

Safety Area Sì No

Aspect Marker Sì No

Aspect Mask Sì No

Aspect Safety Zone Sì No

Aspect Safety Area Sì No

Aspect Select Sì No

Custom Aspect Ratio Sì No

Guide Frame Sì No

100% Marker Sì No

User Box Sì No

User Box Width Sì No

User Box Height Sì No

User Box H Position Sì No

User Box V Position Sì No

VF Setting Brightness Sì No

Color Mode Sì No

Gamma Display Assist Setting Sì No

Peaking Setting Sì No

Peaking Level Sì No

Color Sì No

Zebra Setting Sì No

Zebra1 Level Sì No

Zebra1 Aperture Level Sì No

Zebra2 Level Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Sì No

CH2 Input Select Sì No

CH3 Input Select Sì No

CH4 Input Select Sì No

INPUT1 MIC Reference Sì No

INPUT2 MIC Reference Sì No

Line Input Reference Sì No

Reference Level Sì No

CH1 Wind Filter Sì No

CH2 Wind Filter Sì No

CH3 Wind Filter Sì No

CH4 Wind Filter Sì No

CH3 Level Control Sì No

CH4 Level Control Sì No

CH3 Input Level Sì No

CH4 Input Level Sì No

Audio Input Level Sì No

Limiter Mode Sì No

CH1&2 AGC Mode Sì No

CH3&4 AGC Mode Sì No

AGC Spec Sì No

1kHz Tone on Color Bars Sì No

CH1 Level Sì No

CH2 Level Sì No

CH3 Level Sì No

CH4 Level Sì No

Audio Output Monitor CH Sì No

Volume No No

Headphone Out Sì No

Alarm Level Sì No

HDMI Output CH Sì No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Sì –

Technical Color Bars Setting No No

Type Sì No

ND Dial CLEAR with Dial Sì No

Tally Front Sì No

Rear Sì No

HOLD Switch Setting with Rec Button Sì No

with Hand Grip Remote Sì No

Touch Operation Setting Sì No

Rec Review Setting Sì No

Zoom Zoom Type Sì No

Handle Zoom Setting Sì No

High Sì No

Low Sì No

Menu Settings User Menu Only Sì No

User Menu with Lock No No

Fan Control Setting Sì No



8. Appendice: Impostazioni salvate in file125

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Lens Zoom Ring Direction Sì No

Shading Compensation Sì No

Chroma Aberration Comp. Sì No

Distortion Comp. Sì No

Distance Display Sì No

Zoom Position Display Sì No

Video Light Set Video Light Set Sì No

APR APR – –

Camera Battery Alarm Low Battery Sì No

Battery Empty Sì No

Camera DC IN Alarm DC Low Voltage1 Sì No

DC Low Voltage2 Sì No

Network Access Authentication User Name No No

Password No No

Wireless LAN Setting Sì No

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Sì No

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Sì No

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password No No

DHCP Sì No

IP Address Sì No

Subnet Mask Sì No

Gateway Sì No

DNS Auto Sì No

Primary DNS Server Sì No

Secondary DNS Server Sì No

Manual Register

SSID Sì No

Security Sì No

Password No No

DHCP Sì No

IP Address Sì No

Subnet Mask Sì No

Gateway Sì No

DNS Auto Sì No

Primary DNS Server Sì No

Secondary DNS Server Sì No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Sì No

Camera Remote Control Sì No

Detail Settings

DHCP Sì No

IP Address Sì No

Subnet Mask Sì No

Gateway Sì No

DNS Auto Sì No

Primary DNS Server Sì No

Secondary DNS Server Sì No

Modem Setting Sì No

Camera Remote Control Sì No

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload (Proxy) Sì No

Default Upload Server Sì No

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Sì No

Service Sì No

Host Name Sì No

Port Sì No

User Name No No

Password No No

Passive Mode Sì No

Destination Directory Sì No

Using Secure Protocol Sì No

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Sì No

Clock Set Time Zone Sì No

Date Mode Sì No

12H/24H Sì No

Date No No

Time No No

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Voci configurate con pulsanti programmabili

Si: Impostazione salvata.
No: Impostazione non salvata.
–: Non salvata (impostazione temporanea)

Selezione per pulsanti programmabili All File Scene File

ND Filter Position Sì No

Auto Iris Sì No

ATW Sì No

Focus Setting Sì No

Display Sì –

VF Adjust Sì –

Voci configurate con la manopola programmabile

Si: Impostazione salvata.
No: Impostazione non salvata.
–: Non salvata (impostazione temporanea)

Selezione della manopola 
programmabile

All File Scene File

IRIS Sì No

ND Filter Sì No

Audio Input Level Sì No



8. Appendice128

Fare riferimento alle voci relative in “Impostazione dell’audio da registrare” (pagina 47) e “Menu User” (pagina 71).

Audio Input (CH1&CH2)

Di seguito è riportato il diagramma a blocchi con la maniglia montata.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Impostare su Manual con ingresso audio da adattatore XLR.

Diagrammi a blocchi
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Audio Input (CH3&CH4)

Di seguito è riportato il diagramma a blocchi con la maniglia montata.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Impostare su Manual con ingresso audio da adattatore XLR.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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Il camcorder consente di aggiornare il 
software di obiettivi con innesto E-mount.
Fare riferimento al sito Web dell’obiettivo 
per informazioni sugli obiettivi che possono 
essere aggiornati e per ottenere il necessario 
software.

Verifica della versione

1	 Montare un obiettivo con innesto 
E-mount sul camcorder (pagina 22).

2	 Selezionare Version nel menu 
Maintenance del menu completo per 
visualizzare Lens Version Number 
(pagina 101).
Il numero della versione software 
dell’obiettivo E-mount viene visualizzato 
sul lato.

Aggiornamento del software

Impostare il camcorder sulla modalità 
memorizzazione di massa (pagina 110).
Aggiornare il software seguendo la procedura 
fornita con il software dell’obiettivo.

Aggiornamento del software di un obiettivo con innesto E-mount
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Licenza MPEG-4 Visual Patent 
Portfolio

QUESTO PRODOTTO È CONCESSO IN LICENZA 
SECONDO LA LICENZA AVC PATENT PORTFOLIO 
PER USO PERSONALE DEL CLIENTE O ALTRI 
USI PER I QUALI NON È PREVISTA ALCUNA 
REMUNERAZIONE FINALIZZATI A
(i)	 LA CODIFICA DI VIDEO IN CONFORMITÀ 

CON MPEG-4 VISUAL STANDARD (“MPEG-4 
VIDEO”) E/O

(ii)	LA DECODIFICA DI VIDEO MPEG-4 
CODIFICATO DA UN CONSUMATORE NEL 
CORSO DI ATTIVITÀ PERSONALI E NON 
COMMERCIALI E/O OTTENUTI DA UN 
FORNITORE DI VIDEO AUTORIZZATO DA 
MPEG LA ALLA FORNITURA DI VIDEO MPEG-
4.

NESSUNA LICENZA È CONCESSA O È DA 
RITENERSI IMPLICITA PER ALTRO USO. 
ULTERIORI INFORMAZIONI, COMPRESE QUELLE 
CHE SI RIFERISCONO A PROMOZIONI, USI 
INTERNI E COMMERCIALI, E LICENZE, POSSONO 
ESSERE OTTENUTE DA MPEG LA, LLC. VISITARE 
IL SITO HTTP://WWW.MPEGLA.COM

Ottenere software sotto licenza 
GPL/LGPL

Questo prodotto utilizza software a cui si 
applicano le licenze GPL/LGPL. Questa nota ha 
lo scopo di informare l’utente del suo diritto di 
accesso, modifica e ridistribuzione del codice 
sorgente per tali programmi software secondo 
le condizioni stabilite dalle licenze GPL/LGPL.
Il codice sorgente è fornito su Internet. Per il 
download, utilizzare il seguente URL e seguire 
le istruzioni.

http://www.sony.net/Products/Linux/
common/search.html

Preferiremmo non essere contattati 
relativamente al contenuto del codice 
sorgente.

Le licenze (in inglese) sono registrate nella 
memoria interna del prodotto.
Stabilire una connessione di tipo dispositivo di 
memorizzazione fra il prodotto e un computer 
per leggere le licenze contenute nella cartella 
“PMHOME” - “LICENSE”.

Se si utilizza un Mac, la cartella “PMHOME” - 
“LICENSE” potrebbe non essere accessibile.
Per visualizzare i file, utilizzare un computer 
diverso da un Mac o visitare il seguente URL:
https://oss.sony.net/License/ILME-FX6/

CONTRATTO DI LICENZA PER 
L’UTENTE FINALE

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 

distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 

Licenze

http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
https://oss.sony.net/License/ILME-FX6/
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you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 

in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 

(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 

devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 
of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 
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Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 

that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 

NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licenze software Open Source

Sulla base degli accordi di licenza fra Sony e i 
detentori dei diritti di copyright del software, 
questo prodotto utilizza software aperto.
Per soddisfare i requisiti stabiliti dai detentori 
dei diritti di copyright sul software, Sony è 
tenuta a informare gli utenti del contenuto di 
dette licenze.
Le licenze (in inglese) sono registrate nella 
memoria interna del prodotto.
Stabilire una connessione di tipo dispositivo di 
memorizzazione fra il prodotto e un computer 
per leggere le licenze contenute nella cartella 
“PMHOME” - “LICENSE”.

Se si utilizza un Mac, la cartella “PMHOME” - 
“LICENSE” potrebbe non essere accessibile.
Per visualizzare i file, utilizzare un computer 
diverso da un Mac o visitare il seguente URL:
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Generale

Peso

	 Circa 890 g (solo corpo principale)

	 Circa 2,59 kg (compreso obiettivo SEL24105G, 

paraluce, batteria (BP-U35), 

mirino, maniglia, impugnatura)

Dimensioni

	 Vedere pagina 137.

Alimentazione

	 19,5 Vcc (da 18,0 V a 20,5 V)

Potenza assorbita

	 Circa 18,0 W (corpo, obiettivo, registrazione 

XAVC-I QFHD 59.94P, mirino 

acceso, nessun dispositivo 

esterno connesso)

	 Circa 36,0 W (corpo, obiettivo, registrazione 

XAVC-I QFHD 59.94P (S&Q 

120 fps), mirino acceso, HDMI, SDI, 

dispositivo esterno connesso)

Temperatura di funzionamento

	 Da 0 °C a 40 °C

Temperatura di conservazione

	 Da –20 °C a +60 °C

Tempo di funzionamento continuato

	 Circa 105 minuti (con pacco batteria BP-U35) 

(corpo, obiettivo, registrazione 

XAVC-I QFHD 59.94P, mirino 

acceso, nessun dispositivo 

esterno connesso)

Formato di registrazione video

	 XAVC Intra

		  Modalità XAVC-I 4K/QFHD: 

CBG, vel. fotog. 600 Mbps (max), 

MPEG-4 AVC/H.264

		  Modalità XAVC-I HD:  

CBG, vel. fotog. 223 Mbps (max), 

MPEG-4 AVC/H.264

	 XAVC Long

		  Modalità XAVC-L QFHD:  

VBR, vel. fotog. 150 Mbps (max), 

MPEG-4 H.264/AVC

		  Modalità XAVC-L HD 50:  

VBR, vel. fotog. 50 Mbps (max), 

MPEG-4 H.264/AVC

		  Modalità XAVC-L HD 35:  

VBR, vel. fotog. 35 Mbps (max), 

MPEG-4 H.264/AVC

Formato di registrazione audio

	 LPCM 24 bit, 48 kHz, 4 canali

Frequenza di fotogrammi di registrazione

	 XAVC Intra

		  Modalità XAVC-I 4K: 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

		  Modalità XAVC-I QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Modalità XAVC-I HD : 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

	 XAVC Long

		  Modalità XAVC-L QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Modalità XAVC-L HD 50: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

		  Modalità XAVC-L HD 35: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Tempo di registrazione e/o riproduzione

	 XAVC Intra

		  Modalità XAVC-I QFHD:

			   59.94P

			   Circa 30 minuti  

(con CEA-G160T)

		  Modalità XAVC-I HD:

			   59.94P

			   Circa 78 minuti  

(con CEA-G160T)

	 XAVC Long

		  Modalità XAVC-L QFHD:

			   59.94P

			   Circa 115 minuti  

(con CEA-G160T)

		  Modalità XAVC-L HD 50:

			   59.94P

			   Circa 155 minuti  

(con CEA-G80T)

		  Modalità XAVC-L HD 35:

			   59.94P

			   Circa 210 minuti  

(con CEA-G80T)

[Nota]
I tempi di registrazione e riproduzione potrebbero 
variare a seconda delle condizioni di utilizzo e delle 
caratteristiche della memoria. I tempi di registrazione e 
di riproduzione si riferiscono alla registrazione continua 
di un unico clip. I tempi effettivi potrebbero essere 
inferiori a seconda del numero di clip registrati.

Sezione videocamera

Dispositivo di generazione immagine (tipo)

	 Sensore di immagine CMOS a singolo chip, 

equivalente 35 mm full frame

Numero di pixel

	 12,9M (totali)

	 10,2M (effettivi)

Auto Focus

	 Metodo di rilevamento: Rilevamento di fase/

rilevamento del contrasto

Filtri ND interni

	 CLEAR: OFF

	 1: 1/4ND

	 2: 1/16ND

	 3: 1/64ND

	 ND a variazione lineare: Da 1/4ND a 1/128ND

Sensibilità ISO

	 ISO 800/12800 (modalità Cine EI, sorgente di 

illuminazione D55)

Innesto obiettivo

	 E-mount

Latitudine

	 15+ stop

Velocità otturatore

	 Da 64F a 1/8000 sec. (23.98P)

Angolo otturatore

	 Da 5,6° a 360°, da 2 a 64 fotogrammi

Slow & Quick Motion

	 XAVC QFHD: Da 1 fps a 120 fps

	 XAVC HD: Da 1 fps a 240 fps

	 XAVC 4K: Da 1 fps a 60 fps

	 XAVC HD (S35): Da 1 fps a 120 fps

Bilanciamento del bianco

	 Da 2000 K a 15000 K

Guadagno

	 Da –3 dB a +30 dB (in incrementi di 1 dB)

Base look

	 S-Cinetone, Standard, Still, ITU709, s709, 

709(800%), S-Log3, HLG Live, 

HLG Natural

Sezione audio

Frequenza di campionamento

	 48 kHz

Quantizzazione

	 24 bit

Risposta di frequenza

	 Modalità MIC ingresso XLR: Da 20 Hz a 20 kHz  

(±3 dB o inferiore)

	 Modalità LINE ingresso XLR: Da 20 Hz a 

20 kHz (±3 dB o inferiore)

Gamma dinamica

	 Modalità MIC ingresso XLR: 80 dB (tipico)

Specifiche tecniche
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	 Modalità LINE ingresso XLR: 90 dB (tipico)

Distorsione

	 Modalità MIC ingresso XLR: 0,08% o inferiore 

(livello di ingresso –40 dBu)

	 Modalità LINE ingresso XLR: 0,08% o inferiore 

(livello di ingresso +14 dBu)

Altoparlante incorporato

	 Mono

Microfono interno 

	 Mono

Microfono interno della maniglia

	 Microfono a condensatore electret stereo 

omnidirezionale

[Nota]
Mentre è montata la maniglia, è attivo solo il microfono 
interno della maniglia.

Sezione ingressi/uscite

Ingressi
INPUT 1/2:

	 Tipo XLR, 3 pin, femmina

	 Selezionabile LINE / MIC / MIC+48V

	 MIC: Riferimento da –30 dBu a –80 dBu

TC IN:

	 Tipo BNC

Uscite
SDI OUT:

	 Tipo BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

Cuffie (mini jack stereo):

	 –16 dBu (livello di uscita di riferimento, 

volume di monitoraggio massimo, 

impedenza 16 Ω)

HDMI:

	 Tipo A, 19 pin

TC OUT:

	 Tipo BNC

Altro
DC IN:

	 Conforme a EIAJ, da 18 Vcc a 20,5 Vcc

Slitta Multi-interface:

	 Tipo proprietario (21 pin)

REMOTE:

	 Tipo sub mini, dia. 2,5 mm, 3 poli

Connettore impugnatura di telecomando:

	 Mini jack stereo a 4 poli da 3,5 mm 

(connettore in dotazione per 

l’impugnatura di telecomando)

USB-C:

	 USB 3.2 Gen 1

Connettore USB/Multi:

	 Compatibile con lo standard USB 2.0, tipo 

micro B per l’archiviazione di 

massa (1)

VF:

	 Tipo proprietario (40 pin)

Sezione display

Mirino (LCD)
Dimensione schermo

	 8,8 cm (3,5 pollici) in diagonale

Rapporto di aspetto

	 16:9

Numero di pixel

	 1280 (orizz.) × 720 (vert.)

Sezione slot supporti di memoria

Slot per schede CFexpress Type A/SD (2)

LAN wireless

Standard supportati

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Banda di frequenza

	 2,4 GHz

	 5 GHz (solo ILME-FX6V/VK)

Protocolli di sicurezza supportati

	 WEP/WPA-PSK/WPA2-PSK

Metodo di connessione

	 WPS (Wi-Fi Protected Setup™) / Manuale

Metodo di accesso

	 Modalità infrastruttura

Caricabatterie (BC-CU1)

Peso

	 Circa 60 g

Dimensioni

	 Circa 57 × 26 × 101 mm  

(larghezza / altezza / profondità)

Ingresso

	 19,5 Vcc, 26 W

Uscita

	 16,4 Vcc, 1,4 A

Temperatura di funzionamento

	 Da 0 °C a 40 °C

Temperatura di conservazione

	 Da –20 °C a +60 °C

Accessori forniti

Adattatore CA (1)

Cavo di alimentazione (1) 

Caricabatterie (1) 

Pacco batteria (1)

Maniglia (1)

Monitor LCD (1)

Cavo USB-C (1)

Impugnatura di telecomando (1)

Paraluce LCD (1)

Kit slitta fredda (1) 

(Slitta fredda (1), molla della slitta (1), viti (4))

Coperchietto di protezione innesto obiettivo (1)

Coperchietto di protezione del connettore della 

maniglia (1)

Prima di usare l’apparecchio (1)

Libretto di garanzia (1)

Design e caratteristiche tecniche sono soggetti 
a modifiche senza preavviso.
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Note
ˎˎ Eseguire sempre una registrazione di 
prova, e verificare che il contenuto sia stato 
registrato correttamente. SONY NON SARÀ 
RESPONSABILE DI DANNI DI QUALSIASI 
TIPO, COMPRESI, MA SENZA LIMITAZIONE 
A, RISARCIMENTI O RIMBORSI A CAUSA 
DI GUASTI DI QUESTO APPARECCHIO O 
DEI SUOI SUPPORTI DI REGISTRAZIONE O 
QUALSIASI ALTRO SUPPORTO O SISTEMA 
DI MEMORIZZAZIONE PER REGISTRARE 
CONTENUTI DI QUALSIASI TIPO.
ˎˎ Verificare sempre che l’apparecchio stia 
funzionando correttamente prima di 
usarlo. LA SONY NON SARÀ RESPONSABILE 
DI DANNI DI QUALSIASI TIPO, COMPRESI, 
MA SENZA LIMITAZIONE A, RISARCIMENTI 
O RIMBORSI A CAUSA DELLA PERDITA DI 
PROFITTI ATTUALI O PREVISTI DOVUTA 
A GUASTI DI QUESTO APPARECCHIO, SIA 
DURANTE IL PERIODO DI VALIDITÀ DELLA 
GARANZIA SIA DOPO LA SCADENZA DELLA 
GARANZIA, O PER QUALUNQUE ALTRA 
RAGIONE.
ˎˎ SONY NON SARÀ RESPONSABILE PER 
RICHIESTE O RICORSI DI NESSUN TIPO 
PRESENTATI DA UTENTI DI QUESTO 
APPARATO O DA TERZI.
ˎˎ SONY NON SARÀ RESPONSABILE PER LA 
PERDITA, RIPARAZIONE O RIPRODUZIONE 
DEI DATI REGISTRATI SUL SISTEMA DI 
MEMORIZZAZIONE INTERNO, SU SUPPORTI 
DI REGISTRAZIONE O SU QUALSIASI 
ALTRO TIPO DI SUPPORTO O SISTEMA DI 
MEMORIZZAZIONE.
ˎˎ SONY NON SARÀ RESPONSABILE PER 
LA CANCELLAZIONE O LA MANCATA 
CONTINUAZIONE PER QUALSIASI CAUSA 
O CIRCOSTANZA DI SERVIZI CORRELATI A 
QUESTO APPARATO.

Dimensioni esterne

Unità mm

UNC 1/4-20

UNC 3/8-16

228

2-UNC 1/4-20

UNC 1/4-20

143

UNC 1/4-20

116

8-UNC 1/4-20

11460

258

2-UNC 1/4-20

153

28

25

25
25

25

Le dimensioni indicate sono approssimative.
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Marchi di fabbrica

ˎˎ  è un marchio di fabbrica di Sony 
Corporation.
ˎˎ XAVC e  sono marchi registrati di Sony 
Corporation.
ˎˎ I termini HDMI e HDMI High-Definition 
Multimedia Interface e il logo HDMI sono 
marchi o marchi registrati di HDMI Licensing 
Administrator, Inc. negli Stati Uniti e in altri 
paesi.
ˎˎ Microsoft e Windows sono marchi di 
fabbrica o marchi registrati di Microsoft 
Corporation negli Stati Uniti e/o altri paesi.
ˎˎ Mac e macOS sono marchi registrati di 
Apple Inc. negli Stati Uniti e in altri paesi.
ˎˎ “Catalyst Browse”, “Content Browser 
Mobile” e il logo “Content Browser Mobile” 
sono marchi o marchi registrati di Sony 
Corporation.
ˎˎ iOS è un marchio o un marchio registrato 
Cisco Systems, Inc. e/o di sue società 
affiliate negli Stati Uniti e in certi altri paesi.
ˎˎ Android, Google Play sono marchi di Google 
Inc.
ˎˎ Wi-Fi, il logo Wi-Fi e Wi-Fi PROTECTED 
SETUP sono marchi o marchi registrati di 
Wi-Fi Alliance.
ˎˎ Il simbolo N Mark è un marchio o un 
marchio registrato di NFC Forum, Inc. negli 
Stati Uniti e in altri paesi.
ˎˎ Il logo SDXC è un marchio di SD-3C, LLC.
ˎˎ CFexpress e il logo CFexpress Type A 
sono marchi registrati di CompactFlash 
Association.

Altri nomi di società o prodotto sono marchi 
o marchi registrati dei rispettivi detentori. 
In questo documento i marchi non sono 
contrassegnati dai simboli ™ o ®.
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